User Guide

Mountbatten Learning System

Revision 2

© Harpo Sp. z 0. o.

ul. 27 Grudnia 7, 61-737 Poznan, Poland
www.mountbattenbrailler.com



Thank you for purchasing a Mountbatten Learning System. Since 1990, the
Mountbatten range of Braille Writers has been offering expanded Braille
writing opportunities to people all around the world. Mountbatten Braille
Writers are in use in countries all over the world, bringing and supporting

Braille literacy in many languages.

To get the most from your new MB-LS, please read the first section,
Welcome, carefully, and follow it with the second section, Exploring the MB-
LS. After that, you can skip to the sections you want to read first, because you
will have the most important basic information.

News, resources, regular updates to this User Guide and a range of support
material can be obtained from the Mountbatten website:

www.mountbattenbrailler.com

This device complies with Part 15 of the FCC Rules. Operation is subject to the following
two conditions: (1) this device may not cause harmful interference, and (2) this device
must accept any interference received, including interference that may cause undesired
operation.
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Welcome

We'd like to welcome you to the global society of Mountbatten users, and to introduce you to
your Mountbatten Braille Writer Learning System (MB-LS).

We have designed the MB-LS to be used by children learning Braille. We hope that you will
find it a fun and inclusive introduction to Braille literacy, providing a solid foundation for a
lifetime of learning, and that you will enjoy using the MB-LS for the very first stages of Braille
instruction, and then through to secondary school and beyond.

Reading your User Guide

Read this section to find about the MB-LS, the things it does,
and where to find information in this User Guide. When you are
more familiar with the features, the Contents or Index gives you \
an easy way to find the information you want; and we have  justration 1: The Mountbatten
added a Reference Section at the end for quick lookups. Learning System

The first section, Exploring the MB-LS, is to read while you open the box and look through
the contents, and while you explore the outside of the MB-LS and become familiar with the
keyboard, the connection ports and loading paper.

Very Important!

You MUST remove the shipping lock before switching your MB-LS on. If you don't, the MB-
LS could be damaged. The next section, Exploring the MB-LS, shows how to do that.

What can your Mountbatten Learning System do?

- MB-LS is a Braille Writer, with lots of added extras like erase and correct, formatting and
more. To find out all these things, check the section Writing Braille.

MB-LS has two Modes. Learn Mode is for the very new user, and gives you access to
only some of the features. Advanced Mode gives access to absolutely everything. To find
out the differences, read the section Learn and Advanced Mode.

The MB-LS speech output helps you to remember each new character learned, and it will
also let a new Braille user make discoveries about new characters. Try it!

To find out about the different kinds of speech available, and how to control speech
to get the output you want, see the section Speech.

You can use the MB-LS with other people, even if they don't know Braille; they can type
on a regular keyboard, and the MB-LS will convert their typing into Braille. And the Mimic
Display will show them the text version of the Braille you write on the Braille keyboard.

- To find out about using the Mimic Display or a regular keyboard with the MB-LS, see
the section Adding the Mimic and a Keyboard.

- To find out about using the MB-LS with Mimic and keyboard so that two students
can work together, see the section Braille Chat.

To find out about activating translation, so that the text typed on the regular
keyboard will make proper Braille, see the section Forward Translation.

If you're working your way through Grade 2 Braille in English, you can use the APH
Patterns Series; then the Mountbatten can print your worksheets and documents from the
computer with the right combination of Grade 1 and Grade 2, When other people type on
the PC keyboard, the Braille will come out in the right translation too.
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« See the section Braille Translation - APH Patterns for information on how to turn
the different Patterns levels on and off, and check the Reference Section for the
complete list of Patterns levels.

If you need to use a different series of steps to move from Grade 1 to Grade 2, for
instance in a language other than English, you can add to the MB-LS inbuilt Braille rules
using an Exception Table. See the section Adding Braille Rules for more information on
how to use this feature.

You can use the MB-LS to make patterns and pictures, and play Braille-learning games
that also help with computer skills.

For the MB-LS Graphics Mode, and to get started with pictures and patterns,
see the section Making Braille Graphics.

Contact us for more graphics, both for drawing and for embossing, by visiting
the MB-LS website, www.mountbattenbrailler.com.

You can use the MB-LS in different languages. For language students, this can be very
helpful! See the section Braille Codes and Languages for more.

The MB-LS has features for users who need adapted keyboard access; it can also act as
a communication device for people who have both hearing and vision impairments. See
the section Braille Chat as well as Modifying and Adapting the MB-LS Keyboard and
Connecting your MB-LS for more information.

You can also use the MB-LS as a Braille printer. A text file can be sent to the MB-LS from
the computer, and the MB-LS can translate it to Braille, format it and emboss it. You can
also use Duxbury Braille Translator with the MB-LS.

+ See the section The MB-LS as a Personal Embosser for more information.

In fact, you can do all sorts of things when the MB-LS is connected to a computer, or a
printer. See the section Connecting your MB-LS for ideas.

The MB-LS has an on-board clock and calendar, with an alarm function; there's also an
appointment diary, so the MB-LS can remind you about everything from tasks to
birthdays. See the section Clock, Calendar and Diary for how to use these features.

The MB-LS has a full-featured Editor for writing and editing files; see the section The
Editor for all the information about how to use your MB-LS as a word processor.

You can write into the Editor, and not emboss until later; you can come back and make
changes, and save them again, and still not emboss until you're ready. So you can use
the MB-LS in a classroom without the noise of Braille disturbing other people. See the
section Essential Extras for more information on controlling embossing on your MB-LS.

The MB-LS has two Calculators: a simple Calculator for arithmetic and a full Scientific
Calculator. They can both be used from inside the Editor, and you can copy and paste
calculations into your documents. See the Calculator section for more information.

The MB-LS is a great tool for early learners of Braille music. There are three modes, from
the very beginnings to producing a simple Braille music score.
See the section Braille Music on the MB-LS for the ways to use these features.

For quick lookups, there's a Reference Section, and both the User Guide and Reference
Section have an Index.

We Welcome Your Feedback!
Your feedback is very important to us! Please contact your distributor with any comments or

questions, and you can be sure they'll pass them on to us.
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Exploring the MB-LS

In this section we provide an overview of the physical aspects of the MB-LS, where
everything is located and what it does. We also provide an overview of the basic things you
will need to start using your new MB-LS.

What’s inside the box?

Inside the outer carton, you will find the MB-LS has been packed in a smaller carton, with
foam cutouts to support it inside the outer carton. Around the foam cutouts we have packed
all the other things you need to use the MB-LS. The MB-LS is wrapped in bubble-wrap inside
its small inner carton.

Please keep ALL the packaging - both cartons, the bubble-wrap and the foam cutouts. If you
have to return the MB-LS to us for service, or if you have to ship it somewhere, it MUST be
packed in this original packaging, so it doesn't suffer damage in transit.

When you receive your MB-LS and unpack it, please check that you have received the
following:
* The Mountbatten LS
* 1 X USB Peripheral cable
* MB-Comm software and USB drivers on CD
» This User Guide, inside which you will find:
o a warranty sheet
o Aset of keyboard stickers
» A starter pack of 80-gsm paper for Brailling
« an AC mains power supply
* Apower lead to connect the power supply to the wall socket.
If anything is missing, please contact us or your distributor immediately, so we can supply
you with the missing item.

Fill out the Warranty sheet and store it safely - this sheet only needs to be returned with the
MB-LS if you need service during the warranty period.

Removing the Shipping Lock

Don't switch the MB-LS on yet! First you MUST remove
the shipping lock, or you could damage your new MB-LS.

When you have the MB-LS out of its box, sit it on the table
in front of you, with the keys towards you. A \

Remove the top cover by reaching over to the rear of the jjustration 2: The MB-LS Shipping Lock
MB-LS, and lifting the tab that is in the middle of the cover.

Lift the cover over the MB-LS, towards you. Place the cover to one side. The cover should
come off very easily - it doesn't need any force.

You will now be able to examine the cardboard shipping lock. The two legs of the shipping
lock sit on either side of the Braille embossing head, and prevent it from moving while the
MB-LS is in transit. There is a short piece of the shipping lock which slides between the two
parts of the embossing head. The lock is held in place by the paper bail.

Before you can remove the shipping lock, you need to remove the paper bail.
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Removing the Paper Bail
The Paper Bail is only needed when the MB-LS is operating as a Braille embosser.

When using the MB-LS as a Braille writer, we recommend that you remove it, because with
the Paper Bail in place, it is difficult to read the Braille just written.

lllustration 3: The MB-LS with paper bail installed.

To remove the Paper Ball, first lift the Paper Grip Lever, which is on the right. Then slide the
right hand margin adjuster as far right as it will go. The adjuster will not move unless the
Paper Lever has been lifted.

On the left hand end of the Paper Bail is a small spring-loaded sleeve. Take this sleeve
between your fingers and push it to the right, releasing the left side of the Paper Bail from its
slot. You can then pull the Paper Bail towards the left to release it from the slot on the right.
Lift the paper bail out and put it to one side.

Now you can remove the shipping lock, by sliding it towards the read of your MB-LS.

We suggest that you store the Paper Bail and the shipping lock in the carton, so you can find
them easily when you need them.

Instructions for re-packing your MB-LS, in case you need to transport it, can be found in the
section Care and Troubleshooting.

Now let's begin finding out more about the MB-LS by taking a tour.

The Keyboard

The keyboard is located in the centre front of the MB-LS. For added contrast, it has a bright
yellow background.

In the descriptions below, key positions are described in terms of where your fingers rest,
when both hands are in the standard position resting on the 6 Braille dot keys.

backtab tab

S S
88 HRBR

| newline space |

backspace enter
lllustration 4: The MB-LS keyboard with labels.

Braille Keys

The standard keys for 6-dot Braille are the black keys situated on either side of the centre of
the keyboard, arranged in a slight curve so that your fingertips rest comfortably on them.
They are oval in shape, smooth in the centre, and the edges have a ridge.

The keys are known by their dot numbers. From the centre, the left-side Braille keys are dot
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1, dot 2 and dot 3, and the right-side Braille keys are dot 4, dot 5 and dot 6.

The backspace Key and the enter Key

At the far right and far left of the 6 dot keys, under your little fingers, are two additional blue
keys, shaped the same as the standard keys, but with a ridged top. When you are using the
MB-LS for 6 dot Braille, the left key is the backspace and the right key is enter. These
keys can also operate as the additional keys for 8 dot Braille.

You can press the enter key when at either the left or right margin if you want to move
temporarily beyond the margin setting; for example, to continue Brailling on the same line
after reaching the right margin.

Because of this function, enter is also known as margin release.

The enter key is also used to terminate commands.

command Key

At the centre of the keyboard, between the right and left hand keys is a round, blue button
with a smooth, recessed top. This is called command, and is used for giving the MB-LS
special commands.

newline Key

Under your left thumb is the newline key. This key advances the page one line and moves
the embossing head to the beginning of the new line.

newline and space both have flat tops, and are nearly rectangular in shape, with rounded
right and left ends.

space Key

Under your right thumb is space.

tab and backtab Keys

Above your little fingers, at the top left and top right of the keyboard, are programmable
function keys. Both keys are round and blue with smooth recessed tops.

When your MB-LS arrives these keys are programmed to be tab on the left and backtab
on the right.

They can also be programmed so that they activate other functions - see the Section
Modifying and Adapting the MB-LS Keyboard for more information.

The Embossing Area

Behind the keyboard you will find the part of the MB-LS where the paper is loaded and
where all the embossing is done.

Ruler

Just before the embossing area, between the keyboard and the Embossing Head, there is a
ruler line embossed into the case of the MB-LS. You can use this to follow where your Braille
is relative to the width of the paper.

Embossing Head

The Embossing Head moves across the paper just behind the ruler. After printing a
character, it stops at the next character position to the right.
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Paper Lever

At the far right you will find the Paper Lever. This is a flat yellow lever,; lift it from the front to
release the paper, or to allow you to load paper.

Slip your thumb into the recess from the front to lift the Paper Lever, so you can insert or
remove paper. To make this easier, you can raise the front end of the lever slightly by
pressing a finger back and down on the raised rear edge of the lever. Lowering the Lever will
make the MB-LS grip the new sheet of paper.

Each time you lower the Paper Lever, the MB-LS moves the Embossing Head over to the
Right Margin Adjuster to find out the paper width before moving back to the left. The MB-LS
also resets the line count to zero, and assumes that you are at the top of the page.

Reading Table

The Reading Table is the flat strip of metal behind the Embossing Head. It provides support
for the paper when you want to read it. A groove runs along the front of the reading table. If
you align the top of your paper with this groove when inserting a new sheet, it will be in the

Paper Paper
Advance Margin Adjusters

B Reading table

lllustration 5: The top of the MB-LS, cover off, with the Embossing Area labelled
right place for your Braille.

Paper Bail

The Paper Bail is the round bar that goes from left to right above the reading table. Two
rollers fixed to the Paper Bail press down the paper and guide it. These rollers can slide
along the bail to adjust for different paper widths.

The Paper Bail is not needed for daily use with single sheets of paper; it is provided to help
control continuous paper when you are using the MB-LS as an embosser. So you can put
the Paper Bail aside in a safe place until you need it.

Margin Adjusters

There are two Margin Adjusters fixed to the Reading Table, so you can adjust for different
sizes of paper.

The left Adjuster is fixed in place. When you insert paper into the MB-LS, you align the left
edge of the paper with the left Margin Adjuster, making sure the paper is under the Grip
Wheel, and then slide the right Margin Adjuster across so that it holds the right edge of the
paper.
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Raise the Paper Lever to lift the Reading Table and Margin Adjusters when you are inserting
or removing paper.

Paper Grip Wheels

The Paper Grip Wheels are small rollers, at the front of the Margin Adjusters. They grip the
paper while you are Brailling, so that the MB-LS can move the paper the right amount for
each new line. Your paper must pass underneath these Grip Wheels when you are loading it.

Paper Advance Knob

This is a yellow knob set in a recess on the left of the embossing area, on the opposite side
to the Paper Lever. You can use this knob to adjust the top paper edge when you have
inserted paper. You should avoid using this knob when the paper is already inserted and you
have moved down the page, as the paper position will change, and the MB-LS will not know
where the margins and line position are.

The Left Hand Side

Headphone
socket

lllustration 6: The left side of the MB-LS, showing the sockets and speaker grille

Headphone Socket

This is a standard 3.5mm headphone socket; when headphones are plugged in, the speech
output is directed to the headphones instead of the speaker, so that only the person wearing
the headphones can hear what the MB-LS is saying.

Speaker Grille
The speaker is located directly behind this grill. This is where speech output is normally
directed.

AC Power Socket

This is where you connect the mains power adaptor supplied with your MB-LS. You should
only use the power unit supplied.

The connector is a round DIN-type plug, which has a locator slot that has to be at the top of
the plug when you insert it. Do not use force when inserting the connector - if it is the right
way up it will go in easily.

DC Power Socket:

The MB-LS is not supplied with a DC power adaptor. If you would like to use a DC adaptor,
for instance to charge the MB-LS while in the car, please contact us or your distributor for
information about the proper adaptor.
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The Right Hand Side

USBport  “Mimic port
N 9% (serial port S1)

lllustration 7: The right side of the MB-LS, showing the ports

USB Port

This is used for connecting to a computer and for transferring information between the PC
and the MB-LS. Use this port with our software MB-Comm. The use of MB-Comm is
described in the section Connecting your MB-LS.

Mimic Port (S1 port)

The Mimic LCD display is connected here. For information on using the Mimic, see the
section Adding the Mimic and a Keyboard.

Note:
You can only use one port on the right hand side at any time. If the Mimic Port is being used,
you cannot use the USB at the same time (and vice versa).

The Back of the MB

lllustration 8: The rear of the MB-LS, showing the ports

PC Keyboard Port

A standard PC keyboard (PS2 type) can be used with the MB-LS. Your distributor will be able
to supply you with such a keyboard if you don't already have one.

For more information on using an external PC keyboard, see the section Adding the Mimic
and a Keyboard.

Parallel Output Port

This port, when supplied, can be used to connect a parallel printer to the MB-LS. Only
certain sorts of printers are suitable for use with the MB; see the section Selecting a Printer
in the Section Back Translation for information. You can also consult with your distributor to
find out more.
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It is also possible to have a parallel input (Centronics) port installed in your MB-LS to allow it
to accept parallel data from a PC. This port is an optional extra, and may be ordered from
your distributor.

Second Serial Port S2

This is the second serial port on the MB-LS. It is used for sending and receiving information
to and from a PC or Braille note taker via serial transfer. Use this port with our software MB-
Comm, which is included with your MB-LS.

Loading Paper

There are two methods for loading paper. Try each method to find the one that suits you
best.

Loading Paper: Method 1

Step 1 Step 2
lllustration 9: The three steps for loading paper into the MB-LS
The first method is very similar to loading paper into a typewriter.

Step 1 Lift the yellow Paper Lever, and slide the right hand margin to the position
that suits the paper size being used. Lay the paper flat on the Reading Table.
Make sure that the paper is positioned so that it goes underneath the small
rollers on the left and right margins and under the embossing head.

Step 2 Slide the paper into the unit. Some people grasp either side of the paper and
push it in. Others prefer to slide it in by pressing on the Reading Table and
sliding forward.

Step 3 When the paper is fully inserted, align the top of the page on the Reading
Table. Check that the paper is placed straight against the left hand margin.
Slide the right margin to the left until it rests against the right edge of the
paper. Flip the Paper Lever to the down position. The embossing head will
now move across to the right margin adjuster and back again, to check the
paper size.

Loading Paper: Method 2

The second method involves inserting the paper from
the rear of the MB-LS.

First lift the Paper Lever. Then locate the Paper Input
Slot at the rear of the MB-LS and insert the top of the
page into it. Simply push the paper in until it appears
on top of the Reading Table. Align the paper, adjust
the Right Margin Adjuster as needed, and move the
Paper Lever to the down position.

lllustration 10: Loading paper from the back of
the MB-LS
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Removing Paper
To remove paper, simply lift the Paper Lever and pull the paper back and out of the MB-LS.

For users who cannot reach to pull the paper out of the back of the MB-LS, it is possible to
eject the page from the keyboard. There are three ways to do this:

newline + enter Page eject. Press newline and enter together.

p-chord Page eject. Press p and space together, dots 1, 2,
3, 4 and space.

np Force a new page. This is a command, and can be used
by itself or in a file to be translated.

Your MB-LS will say "Page Eject" and the paper will be rolled out of the machine, ready to be
collected.
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Writing Braille

First, load a sheet of paper using the instructions in the previous section.

Then turn the MB-LS on using the switch, and use the six black Braille keys and space, in
exactly the same way as you would type on a mechanical Braille writer. Whatever you type
will be embossed on the paper.

The MB-LS keyboard works a little differently from a mechanical Braille writer. On a
mechanical Brailler, the keystroke makes dots when you get to the bottom; on the MB-LS the
keystroke makes dots when the keys come back up as you let go. This means that a learner
can add dots together to make up a Braille character.

End of line and Word Wrap

When you get close to the end of the line, you will hear a beep. This is the margin bell, and it
lets you know that you will soon be at the end of this line - the factory setting has the beep
sounding 5 characters before the end of the line. You can turn this bell off if you wish.

The important thing to remember is this: your MB-LS doesn't need you to do a carriage
return at the end of the line. Unless you wish to begin a new line, just keep Brailling; the MB-
LS, when it gets to the end of the line, will automatically go to the next line. This is called
Word Wrap.

In the default setting of Word Wrap, your MB-LS will take your Braille as close to the right
side of the page as it can. If the word you are Brailling isn't finished, the MB-LS will place a
hyphen, move to the next line and keep Brailling.

If you don't want hyphens, you need to use a command.

Enabling commands

When you first receive your MB-LS, it is in Learn Mode, and the command key is inactive.
command is the small round blue key in the very centre of the keyboard, between the Braille
keys. When it is active, it's easy for a beginner to activate all sorts of features and find
themselves lost. However, it's very easy to activate the command key and to deactivate it
again. These are the keys you use; they switch the
command key from inactive to active, and from active

to inactive: O OOGO OOO O

tab+backtab+newline+space

Whep you press th..e se .l.( eys together’ ,your MB._LS will lllustration 11: The command activation
say "command on" or "command off". You will know keystroke
immediately which state the command key is in.

Now that you have the command key active, you can change the Word Wrap behaviour if
you wish. The command to do this is ww.

wwW Turn Word Wrap on and off.

When Word Wrap is on, the word is not embossed until space is pressed. If the word cannot
fit on the line, it is moved to the beginning of the next line. The default for ww is off. This
command is a toggle; use the same command to turn it on and off.

Entering the command
All regular commands begin with the command key, and finish with the enter key.
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press type press

command H H enter

key command key

lllustration 12: The three steps to enter a regular command

For example to turn the Word Wrap command on, you first press command, then type ww and
then press enter. Your MB-LS will say “on” or “off” depending on the original setting.

Toggle Commands

Some commands, like Word Wrap, are "toggle" commands, meaning that they toggle
between an on and of £ state, each time they are invoked. Throughout this User Guide and
the Reference Section, each toggle command will have a note as part of its description,
telling you it is a toggle command.

Commands Needing Extra Information

If your command needs you to enter a number or another parameter as well as the
command, press the command key, type the letters of the command, press space and then
type the number or other parameter. Numbers can be entered using literary or Grade Zero
numbering; use the numeral sign, dots 3,4,5, 6 with the letters a to j, or use the Grade
Zero lower numbers. See the section Braille Codes and Languages for more information
on using dropped or lower numbers.

You will find more information about commands throughout this User Guide, and in the
Reference Section.

Erasing and Correction
Your MB-LS can erase or correct mistakes.

Make sure the Braille head is one space to the right of the cell you wish to change. When
you press the keys, the head will move back, make the change or erase the error, and then
return to its original position

backspace+space replaces a character with a space.
backspace+correct dots replaces a character with your desired character.

If you have typed a letter where you wanted a space, make sure you are one position to the
right of the letter you want to erase, and press backspace+space.

However, if you typed p when you wanted w, you could change the p to w. Make sure you
are one position to the right of the p, and press backspace+w (backspace+dots 2456).

How to Move Around the Page

newline+space Move down the page in same column
newline+backspace Move up the page in the same column
newline+enter Page Eject

tab Move right 5 spaces

backtab Move left 5 spaces

space Move one position right
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backspace Move one position left

Playing Shark Attack - practise moving and correcting

"Shark Attack" is a game devised by SET-BC in Canada, to use the erase and correct
feature and all the page movement commands.

Braille the letter g, dots 1,2,4,5, about 12 times in various areas of the Braille page, in
front of the student or person who will play. Explain that these are fish swimming in the
ocean.

Bring the embossing head to the centre of the page before starting, so that there are some
fish above the embossing head as well as some below, and some to either side.

Explain that the student or player is a very hungry great white shark and that they want fresh
fish for supper. Explain that once they know how to move around and swim they can start
eating the fish.

The player then navigates to the cell immediately to the right of each fish and uses
backspace + space to gobble up the fish.

There are other variations of Shark Attack:

The Star Catcher Game - players have to catch as many stars as possible; instead of g,
Braille the letter s, dots 2, 3,5 for each star.

The Hungry Wolf Game - the hungry wolf wants to eat some tasty sheep. In this variation,
the fat woolly sheep are represented by a full cell, dots 1,2,3,4,5,6.

You can vary the number of fish, stars or sheep to increase or decrease the difficulty; you
can add characters that aren't to be "eaten", and subtract points for characters eaten in error.
If you have more than one player, you can set an audible timer for 2 minutes and then count
the consumed stars, fish or sheep; the highest score wins.

Formatting Your Braille

For simple Brailling, your MB-LS will wrap the ends of lines and doesn't require you to do any
formatting. When you reach the bottom of the sheet of paper, the MB-LS will say "out of
paper", or you can remove or eject the page when finished.

If you would like to format your Braille pages, there are some commands you can use. They
fall into four different areas.

Positioning Braille on the page

With no positioning commands active, the MB-LS begins embossing from the left margin,
and doesn't align the right-hand end of each line. There are two other choices:

ce Centres your Braille on the line.

Press newline before entering this command, so that the Braille to be centred begins on a
new line, and begin typing the Braille after the command is entered.

As you type the MB-LS stores your Braille in a memory area called a buffer. It will begin
embossing the first line, centred on the page, when the buffer fills, after you press a space. If
you continue typing, the MB-LS will treat each line this way, centring it and embossing when
the buffer fills. Use this facility for centring a paragraph or a single line, or even a whole
document.

If you are Brailling a heading or a line of only a few words, press newline when you have
finished typing, and the MB-LS will centre and emboss the line.
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To turn Centring off, enter the ce command again; this command is a toggle. The default
state is off.

ra Aligns your Braille to the right-hand margin.

Like ce, the Right Align command stores your Braille in a buffer, and begins to emboss the
first line when the buffer has filled, after you press a space. Continuing to type will give you a
right-aligned paragraph. To right-align short lines, press newline at the end of each line,
when the line will emboss and be right-aligned.

Right Align will not work if Centring is active, even if you have it turned on first.

To turn Right Align off, enter the ra command again; this command is a toggle. The default
state is off.

Margins

When you load a new sheet of paper, the default margins are active. The MB assumes a
page length of 26 lines, with a top and bottom margin of zero; the left and right margins
depend on the width of the paper which the MB-LS discovers during the margin seek when
the paper lever is lowered, or when the MB-LS is switched on.

The left margin is hard left at a position equivalent to a little more than two characters (about
1.5 centimetres, or 9/16ths of an inch) in from the edge of the paper. The right margin is as
far right as it can be, the same distance from the right-hand edge of the paper. These are the
positions for a Left Margin of O (zero) and a Right Margin of O (zero).

To change the left and right margins, the following commands are available:

1mh Set the left margin to the embossing head position.

Use tab, space, backtab or backspace to get to the position you want before entering
this command.

1m number Set the left margin to the position given by "number", counting from the
leftmost position on the page. For instance, if you want the left margin to
be set 10 spaces more to the right than its usual place, enter the
command as 1m 10.

Im Use this command to reset the left margin to zero, which is the same as
returning it to its default state.
rmh Set the right margin to the embossing head position.

Use tab, space, backtab or backspace to get to the position you want before entering
this command.

rm number Set the right margin to position given by "number", counting from the
leftmost position on the page. For instance, if you want the right margin to
be set 10 spaces more to the right than its usual place, enter the
command as 1m 10.

rm Use to reset the right margin to zero, which is the same as returning it to
its default state.
When you load a new sheet, the top margin is decided by the position of the top of the sheet
of paper when you lower the paper grip lever. When you begin to Braille, the MB-LS begins
embossing immediately without inserting any lines. This is equivalent to a Top Margin of O
(zero). To change this top margin so that the MB-LS moves the paper up a certain number of
lines before beginning to emboss, use the tm command below:

tm number Set Top Margin of Braille page in number of lines. This will set the number
of lines to feed before beginning embossing.
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When you are Brailling all the way down the page, the MB-LS will continue to feed a new line
up at the end of each line, or when you press newline, until the bottom of the sheet is
reached. If you would like the Braille to finish on each page before the bottom of the sheet
arrives, you can use the bm command below to change this.

bm number Set the Bottom Margin of the Braille page in number of lines. This will tell
the MB how far down the page to go before ejecting the page and asking
for a new page. The number you enter as part of the bm command is the
number of lines up from the bottom of the sheet. So if you have kept the
default page length, a Bottom Margin of 10 will give 16 lines for Braille,
less any Top Margin.

Releasing a Margin

If you are almost at the end of the line, and your word has only one character more than you
have space for, you can use enter to release the margin so you can fit the word on the
current line.

Margin Release only works if you have Manual New Line on, and the Right Margin is greater
than zero. The command for setting Manual New Line, man, is explained further on in this
section.

Tab Settings

Each time you press tab, the Braille head moves to the right 5 cells; backtab moves the
head to the left 5 cells.

If you would like tab stops in different places, first you must remove the default tab settings:

tc Clear all the currently-set tab stops.
The embossing head will now not move when either tab or backtab is pressed, and the
MB-LS will say "No tab set".

Now that the default tabs are removed, you can set your own tabs by spacing to the place
you want to set a tab stop, and then using the tsh command:

tsh Set a tab stop at the position of the embossing head.
You can set up to 10 tab stops using tsh; if you try to set more, the MB-LS will say "error".
To restore all your default tabs, use the std command or, if you have saved your default

settings, use restore. See the section Saving and Restoring Settings for more
information on how and when to do this.

Line Spacing
The default spacing for lines of Braille on the MB-LS is single line spacing. This means that

each time there is a wrap at the end of a line, or each time you press linefeed, the paper
will advance by one line. You can change this using the 1s command:

1s x.y Use this command to set the line spacing.

In the command, x .y represents a decimal number; if you want a whole number of lines, it's
not necessary to enter the point or a following zero. For example, if you want a line spacing
of 1.5 lines, the command would be 1s 1.5If you would like line spacing of 2 lines (double
line spacing), use 1s 2.

When you are typing numbers into a command, it is often easiest to use the dropped or
lower numbers. For 1s 1.5, you would type this sequence:
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command 1 s space dot 2 dots 4,6 dots 2,6 enter
Where numbers are used in a command, they can be entered as either the number sign plus
a letter from a to j, or as a "dropped" or "lower" character. Some commands include ‘x’ and
‘y' to indicate numbers, where X’ indicates a number and .y’ indicates a number after a
decimal point.
Decimal points can be entered as dot 2, (as in literary Braille); or as dots 4,6, as in
ASCII Braille, also known as the North American Braille Computer Code (NABCC). See the

section Braille Codes and Languages for more information on using dropped or lower
numbers and for a listing of ASCII Braille.

Braille Writing Commands
There are several other commands which affect Braille writing:

cor This command turns Correction Mode on and off.

When Correction Mode is off, the MB-LS will no longer erase and correct. It is a toggle
command. Correction Mode is on by default; the first time you use cor it will turn Correction
Mode off, and the next time it will turn it on, and so on.

em This command turns embossing off and on.
Embossing is on by default; when it is off, and speech is on, it's possible to use the Editor
silently.

man Choose between Manual New Line & Auto New Line.

A Manual new line means you have to press the New Line key at the end of each lineAuto
New Line means the embossing head will automatically move to the beginning of a new line
as defined by the ww command. The default is off, meaning that the default setting is Auto
new line. This is another "toggle" command.

np Use this command to Force a new Braille page. The current page will be
ejected.

There are also two keystrokes you can use to eject the paper from the MB-LS; p-chord and
newline+enter. See the paragraphs headed Removing Paper, in the section
Introduction.
pn [number] Use this command to insert a page number in the top right hand corner of
the page.
Page numbering begins starting at the number you enter in the command. Each time a new

page is inserted, the page number will be embossed sequentially. This setting stays active
until the MB-LS is turned off.

pbell [number] Set the page bottom warning bell to sound a certain number
of lines before the end of the page.
The default number of lines is 2 lines.
rmbell Turn the right margin bell on or off.

When you are Brailling, the MB-LS will beep when you reach a position 5 characters before
the right margin. The bell rings 5 positions from the right hand margin. The default is for the
bell to be on; this is a "toggle" command.

show Each command is embossed as it is entered on the keyboard.

It can be helpful for working out why a command isn't successful. The default setting is off;
this is a "toggle" command.
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ww Word Wrap.

When Word Wrap is on, each word is not embossed till the Space Key is pressed. If the word
cannot fit on the line, it is moved to the beginning of the next line. The default setting is off;
this is a "toggle" command.

Embossing Speed

The MB-LS has two embossing speeds, Writing Speed and Embossing Speed. Your MB-LS
is set by default to Writing Speed, which is the slower of the two.

When you reach the chapter Essential Extras, you will find information about setting the
different speeds.

It's quite safe to use the MB-LS for Braille writing at Embossing Speed, although you might
find it a bit louder than Writing Speed.
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Using Commands

Turning the Command Key On and Off

The command key is used for entering all the commands that make the MB-LS such a
powerful tool for learning. You can turn it on or off as needed. Whatever is chosen remains
the default after you turn the unit off.

newline + space + tab + backtab

Turns command on or off.

® ®
Press all four keys together to turn on; press all O OOU O OOO 0
D

four keys together again to turn off.

Entering Commands

There are 2 types of command used in your MB-
LS, Regular Commands and Chorded Commands.

lllustration 13: The command activation keystroke

All regular commands begin with the command key, and finish with the enter key.

press type press
command H H enter
command
key key

lllustration 14: The three steps to entering a command
For example to turn the Word Wrap command on, you first press command, type ww and then

press enter. Your MB-LS will say “on” or “off’ depending on the original setting. Some
commands, like Word Wrap, are "toggle" commands, meaning that they toggle between an
on and off state, each time they are invoked.

If your command needs you to enter a number or another parameter as well as the
command, press the command key, type the letters of the command, press space and then
type the number or other parameter. Numbers can be entered using literary or Nemeth
numbering; use the numeral sign, dots 3,4,5, 6 with the letters a to j, or use the lower
numbers.

Throughout this User Guide, regular commands are laid out like this:
command Description of command

Using the command for Word Wrap as an example:
wWW Word Wrap.

When Word Wrap is on, the word is not embossed until space is pressed. If the word cannot
fit on the line, it is moved to the beginning of the next line. The default for ww is off. This
command is a toggle; use the same command to turn it on and off.

Conventions for Regular Commands Used In This Manual

If there is a space indicated in the command, you have to press the space key when you are
entering the command. For example to set a left hand margin 6 characters in from the left
hand side of the page, use the command:
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Im 6 Set left margin to position 6

Where numbers are used in a command like the example above they can be entered as
either the number sign plus a letter from a to j, or as a "dropped" or "lower" character. Some
commands include X’ and ‘y’ to indicate numbers, where X’ indicates a number and .y’
indicates a number after a decimal point.

Decimal points can be entered as dot 2, (as in literary Braille); or as dots 46, as in ASCII
Braille, also known as the North American Braille Computer Code (NABCC). See the section
Braille Codes and Languages for more information on using dropped or lower numbers
and for a listing of the ASCII Braille code.

You can also enter commands using the PC keyboard. For more information, see the section
Commands in Files or from the PC Keyboard at the end of this section.

Chorded commands

A chorded command is one that you enter by pressing space with the designated letter.
There are only a limited number of chorded commands and they can be used at any time.

b-chord backtab

c-chord linefeed

e-chord End - complete a calculation in the Calculator.

f-chord Paper feed. - feed the paper down one line without returning the head to
the initial position.

h-chord Help.

i-chord Indent. Move to the next tab stop. This command is the same as pressing
tab or using t-chord.

o-chord Options Menu - use this to access the Calculator, Clock, Calendar and

Diary, and two of the three Music functions. See their individual sections
for more information.

p-chord Page eject.

r-chord Reverse line. This command feeds the paper up one line without returning
the head to the initial position.

t-chord tab. Each press moves the head one tab stop to the right.

z-chord Stops the speech while speaking.

Conventions for Chorded Commands Used in this Manual
Some chorded commands are followed by a letter. For example:

o-chord u Turns on Music Fun Mode.

To enter this command, first press the letter o and space together, then u immediately
afterwards, with no space between.

Some Chorded commands are followed by a number. For example:

o-chord sl Selects a 12 hour clock.

All numbers used with chorded commands must be dropped or lower numbers. See the
section Braille Codes and Languages for more information on using dropped or lower
numbers.
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Help Command and Options

There is a help function available in the MB-LS that you can access at any time. The help
function provides further information about any commands and can be accessed by using:

hp

This will provide a summary of the help topics available.

If you are using recorded speech, the MB-LS will Braille this summary. In synthesised
speech, it will speak this summary.

hp [group]

Enter the command hp followed by the code for the group on which you
would like help. Choose one of the groups from the list below. Press Enter
to finish.

In recorded speech, the MB-LS will emboss the information it has about
the command you enter. In synthesised speech, it will speak this
description.

Help doesn't have an entry for every single Mountbatten command: the information is stored
in groups. The available groups are as follows:

General groups:

hp
hp
hp
hp
hp
hp
hp
hp
hp
hp
hp
hp
hp
hp
hp
hp
hp
hp
hp
hp
hp
hp
hp
hp
hp
hp

bec  gives a summary of the Braille code commands

cal gives a summary of the Calculator commands

chat gives a summary of the Chat Mode commands

dfln gives a summary of default language selection commands

em gives a summary of embossing output commands

emb gives a summary of commands for embossing from the memory

eta gives a summary of commands for adding Braille exception rules

fb  gives a summary of forward translation commands

grx gives a summary of Braille grade setting commands

ke  gives a summary of the Mountbatten keyboard setting commands

ku  gives a summary of the Unimanual (one-handed) mode commands

Im  gives a summary of the Left Margin commands

pp  gives a summary of the Parallel output commands

pr  gives a summary of the commands for printing (ink-print) from memory
ptrn gives a summary of the Braille Patterns commands

report gives a summary of command parameters for the report command

restore  gives a summary of command parameters for the restore command

rm
sl
s2
save
spk
std
tc
tm
tsh

gives a summary of the Right Margin commands

gives a summary of the first serial port output commands

gives a summary of the second serial port output commands

gives a summary of the command parameters for the save command
gives a summary of the speech status commands

gives a summary of the command parameters for the std command
gives a summary of the command for clearing tabs

gives a summary of the Top Margin commands

gives a summary of the tab setting commands

User Guide 20



hp usb gives a summary of the USB output commands

Back Translation groups

hp bck gives a summary of the back translation output port commands

hp bln gives a summary of back translation language selection commands
hp bfc gives a summary of international character selection commands
btp gives a summary of printer selection commands

bpn gives a summary of the page number selection commands

Forward Translation groups

hp fln gives a summary of the forward translation language selection commands
hp ffc gives a summary of the international character selection commands
hp fwd gives a summary of the forward translation port selection commands

In Learn Mode, your MB-LS is only able to emboss the output from the hp command,
because synthesised speech is not available; in Advanced Mode, you have the choice
between spoken or embossed output, with speech output as the default setting.

Spoken or Embossed Output for Reports
To change between spoken or embossed output in Advanced Mode, use these commands:

rec sp to have all reports from the MB-LS spoken.
rec em to have all reports from the MB-LS embossed.

The rec command affects the hp command. Other commands that will be affected by rec
sp and rec em are ver and free; see below for more information on these commands.

Miscellaneous Commands

The following commands are available in both Learn and Advanced Mode.

ver Embosses the software version in your MB-LS.

free Tells you how much free memory is available in your MB-LS.

alt [number] Enables your MB to accept ASCII characters above 128.
‘number’ can be any valid ASCII value.

save Saves all current settings. Use this to save your preferred settings, which
will then become the default until you use std.

std Restore your MB-LS back to factory default settings. This will remove all

of your settings; before using std, you should ensure that you have
saved any settings you would like to use again.

reportc Embosses the current settings, whether saved or not.
reports Embosses the saved settings.
reportd Embosses the default, or factory, settings.

See the section Saving and Restoring Settings for more information about save, std and
the report commands.

Commands in Files or from the PC Keyboard

On the MB-LS keyboard, a command begins with command and ends with enter; on the PC
keyboard a command begins with Esc and ends with End; and in a file, a command begins
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with { and ends with }. These beginnings and endings all perform the same function; they
tell the MB-LS that a command is coming, and that the command is complete and ready to
be acted on.

The ways to use commands on a PC keyboard are covered in the section Adding the
Mimic and a Keyboard. For more information on using commands inside a file, check the
section Forward Translation: Converting Print to Braille.
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Essential Extras

Writing Braille Files in Memory

The MB-LS has a memory in which you can save up to fifty files. This is intended for quick
saves of your Braille, for instance when you don't have time to edit as you take notes.

All the files you save this way can be edited later, using the Editor; see the section The
Editor for all the information on how that function works.

When you type Braille into the memory of the MB-LS, it is stored as Braille; no translation is
made. When you emboss the file you have saved, it will be exactly as you have Brailled it
into the memory.

Naming files in the MB-LS

An MB-LS file must have a name.

Each name needs to be different, so that you don't write over the top of a file you already
have; each name can be up to 22 characters long.

You should restrict the characters in your filename to letters and numbers, and you should
use uncontracted Braille, lower case letters and lower numbers. Shorter filenames are easier
to remember, and numerals which tell you the date or time of saving can be helpful.

It is advisable to use easily remembered, descriptive names for your files, and ones that will
sound different when you listen to the directory of stored files.
Start a File

begin [filename] Open a new file called £ilename.
Once you have entered this command, the MB-LS is recording your keystrokes, whether you
are typing on the Braille keyboard or an external PC keyboard. Everything you type will be
stored in memory until you close the file.
Close a File

end Close the open file.
If you turn the MB-LS off, the open file will be automatically saved.

Getting a list of the Files Stored in Memory

dir This command will read out a list of the files by name, and their sizes.

You can also examine the contents of the MB-LS memory from the PC. See the section
Connecting your MB-LS for all the information about how to do this.

free This command will tell you how much free space you have available.
The MB-LS has 400KB of memory, which will let you save around 600 Braille pages.

Change a File

append [filename] Add more information to the end of £filename.

The append command can be used to add information to any existing file, whether you have
made it in the Editor or using the begin command. The new data will begin at the end of the
existing data and continue from there.

rename [filenamel] [filename2] Rename filenamel to filename2.
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Delete Files

del [filename] Delete the file named "filename".
undel Restore the last deleted file.

undel only works if you use it before you switch the MB-LS off, in the same session as you
deleted the file.

del all Delete all saved files.
Once you have used the del all command, you will not be able to retrieve any files.

Emboss files stored in Memory

emb [filename] Emboss the file named £ilename.

memb [number] [filename] Emboss multiple copies of the file named £ilename,
where [number] is the number of copies.

Writing Braille on Heavy Card, Plastic film or Labels

In addition to using the impact adjustment described on the next page you can also select
the number of times each dot is hit by the embosser. If you are using a heavy card, or a
plastic label with adhesive backing, you might need to use the multi-strike setting to make
good Braille. You can choose from single strikes (default) up to 4 strikes on each dot.

ms [number] Turn on the Multi-strike feature.

This command sets the number of times the embossing head strikes each dot. This can help
to make readable Braille on heavy materials such as plastic label sheets. The default
number of strikes is 1; you can change this to any whole number up to 4.

Writing Braille on Small Paper

When you use a small piece of paper (like a birthday card) the MB might respond as if there
is no paper in the machine and refuse to emboss. To overcome this, press space and
newline together. This invokes “no paper operation” and means you can write Braille on a
very small page.

Using different weights of paper

Writing Braille onto paper makes noise. There is no way to avoid this completely with a
Braille writer, however there are strategies and procedures to help minimise noise.

The first strategy is to use lighter paper, because it requires less force to make the dots and
is therefore quieter. Braille properly produced on lighter paper lasts well and is very readable
with good-quality dots.

The MB-LS has been designed to work best and most quietly with regular office paper. This
paper is 80 gsm or 20Ib paper as sold for use in photocopiers and printers. The strike weight
set up in the factory is correct for this weight of paper, and we have included a starter pack
with your MB-LS.

It is possible to use heavier papers in the MB-LS, but you will find that the dots are not very
strong; in this case, you will need to adjust the impact force to make better dots, and then if
you change back to lighter paper, you will need to adjust the impact force back down to suit.

The impact force should be adjusted to the minimum level necessary, to ensure that the
minimum noise is produced on whatever paper you are using.
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Adjusting the Dot Impact for Different Types of Paper

This function is used to match the impact force of the dots to the paper used. For heavy
Braille paper, the impact force can be increased. For
lighter paper, the impact force can be decreased.

command + backtab Increase Impact

O ®
When you press command and backtab together, the O OOO @ OOO O
|G

impact force will increase by one step, and the MB-LS
will say “up”.

command + tab Decrease Impact
When you press tab with command, the impact

5 ODO ® OOOOO f(égivt\%m('i'.ecreases by one step, and the MB-LS says
(I —

You do not need to turn command on to use this
keystroke.

Embossing Speed

The MB-LS has two modes of embossing: Writing Mode and Embossing Mode. The default
is Writing Mode, which is half the speed of Embossing Mode, and therefore quieter.

If you wish to emboss several pages, you will find that the file embosses much faster if you
set the MB-LS to Embossing Mode.

The command to change between embossing speeds is:

m Change from Writing Speed to Embossing Speed and back.

The default setting is Writing Mode, or half speed. This command is a toggle, so use m again
to change back from Embossing Speed to Writing Speed.

In Writing Mode, your MB-LS embosses at around 3 characters per second, depending on
the complexity of the Braille; in Embossing Mode your MB-LS embosses at around 6
characters per second.
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Speech

The MB-LS has two kinds of speech built in: recorded speech and synthesised speech.
Recorded speech sounds clear and easily understood, because it is a human voice;
however, it is not as powerful or flexible as synthesised speech. Synthesised speech is not
as clear and easily understood as recorded speech, but it has greater flexibility and you can
do more with it.

Recorded speech is the default in Learn Mode and is also available in Advanced Mode. The
default speech in Advanced Mode is synthesised speech.

Recorded Speech

By default, when using recorded speech all keys, functions and commands will be spoken.
This is particularly useful for anyone who is learning Braille, or for family and friends who
want to familiarise themselves with a Braille writer.

The commands for controlling the speech options are:

spk r Select recorded speech.
This command is only available in Advanced Mode to deselect synthesised speech.

spk a Speak all MB-LS keyboard keys, functions and commands.

This setting is the default setting in Learn Mode. With every key stroke being spoken, the
user receives immediate feedback every step of the way. As less speech is required, one of
the following options can be selected:

spk c Speak errors and prompts only.
No Braille dot keys are spoken.

spk d Speak only Braille dot keys and the command key.
No function keys are spoken, and space, newline, backspace are silent.

Braille was initially created with six dots combinations providing 64 potential combinations.
For recorded speech the entire alphabet has been recorded, as well as some contractions.
However when a dot combination has two (or more) different meanings, the MB-LS will
speak the dot numbers only.

The settings for each of the two Modes are stored separately, so it is possible to have All
Keys spoken in Learn Mode, and set recorded speech to speak only the Braille keys and
command in Advanced Mode, and change from one to the other and use the two different
settings.

Settings will be lost when the MB-LS is switched off; each Mode will return to its default
speech settings unless the speech settings are saved.

No Speech
spk n No speech. This command puts your MB-LS into tones-only mode. For
information about the tones and what they mean, see the Reference
Section.

Synthesised Speech

spk s Select synthesised speech.

This is the default in Advanced Mode. It is not available in Learn Mode. It is automatically
turned on when you first enter Advanced mode.
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Controlling Synthesised Speech

You can change many things about synthesised speech in the MB-LS, including:

Volume;
Rate;
Pitch;
How much punctuation is spoken;

How numbers are spoken;
How keystrokes are spoken;

Whether capital letters are spoken; and

Whether spaces are spoken.

All the commands to control speech are collected together in the Speech Menu.

To enter the Speech Menu, press s + space + newline together.
To exit the Speech Menu, press e-chord.

Once you are in the Speech Menu, you are able to use the keyboard to find out the current
settings and make changes.

The first time you press a particular speech command keystroke, the current setting will be
spoken. If you press the same keys again, you will move to the next available option for that
command. The last spoken option when you exit the speech menu becomes the current

setting.

Pitch, Volume and Rate.

dot

dot

dot

dot

dot

dot

Speaking Mode

1

6

ASCII

Dot

Raise tone. The MB-LS will say "higher" at the new pitch, and "highest"
when you have reached the highest setting.

Faster speech. The MB-LS will say "faster" at the new rate, and "fastest"
when you have reached the highest setting.

Increase volume. The MB-LS will say "louder" at the new volume, and
"loudest" when you have reached the highest setting.

Lower tone. The MB-LS will say "lower" at the new pitch, and "lowest"
when you have reached the lowest setting.

Slower speech. The MB-LS will say "slower" at the new rate, and
"slowest" when you have reached the lowest setting.

Decrease volume. The MB-LS will say "softer" at the new volume, and
"softest" when you have reached the lowest setting.

The three options are "letters spoken as ASCII", "letters spoken as dots"
or "letters spoken as translated". The modes work like this:
All characters entered will be spoken as Computer Braille notation,
also known as Grade Zero.
Letters will be spoken as letters but all non-letters will have their
respective dots announced. For example: the number sign will be
spoken as "dots 3,4,5,6".

Translated This is the default setting. For example, in English Grade 2, ‘ab’

entered with a space before and after will be spoken as ‘about’.
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What to expect from the different speech modes

In the MB-LS, when you are in Advanced Mode and using Synthesised Speech, there are
three possible ways for the MB-LS to speak each keystroke. Words will still be spoken as
whole words.

If the speech has been set to ASCII mode, then the characters are spoken in North American
Computer Braille (NABCC) Notation.

For example dots 3 4 5, the AR contraction in English Grade 2 Braille, has an NABCC
computer Braille code of ">'. This means that:

In ASCII mode, "greater than" will be spoken when dots 345 is entered.
If in Dots mode then "dots 3 4 5" will be spoken.
If in Translated mode then it will say "a r".

Another example: the word "standard".

If it is entered in Grade 2 as "st and ar d" using contractions, or dots 3,4, dots
1,2,3,4,6,dots 3,4,5,dots 1,4,5, then, in ASCIl mode, it will say "slash
ampersand greater than d" as the MB internal coding for this is "/&>D".

If in Dots mode it will say "dots 3,4 dots 1,2,3,4,6 dots 3,4,5 4d".

If in translated mode it will say "st and ar d", with the contractions spelt out and a
slight pause between each contraction or letter.

Reports and Listings - how Speech Settings affect them

When you ask your MB-LS for a report on settings, or a Directory listing, how it is presented
to you will depend which type of speech you have active.

If you have Synthesised Speech active, the report or listing will be spoken.
If you have Recorded Speech active, the report or listing will be embossed.

So, if you are using Synthesised Speech but you would like an embossed copy of a report or
listing, use spk r to change briefly to Recorded Speech, enter the command for your report
or listing, and then use spk s to return to Synthesised Speech once the embossing is
complete.

You can also set reports to emboss even when Synthesised Speech is on; see the command
rec emin the section Using Commands.

Punctuation

The punctuation controls come into play when text is being spoken after it has been entered,
rather than as you press the keys.

The 3 modes are Most, Some or None. Press p repeatedly to move through the list; the first
setting spoken is the current setting, and the last setting spoken before you exit the speech
menu will be the new setting.

P "Most" punctuation will speak all punctuation except spaces.
"Some" punctuation speaks period (full stop), comma, colon and
semicolon

"None" means that no punctuation will be spoken.

Whenyoutype h e 1 1 o dots 2,5,6 space, the spoken responses from the MB-LS
will be:

User Guide 28



Most: hello period
Some: hello, spoken with a falling inflection.
None: the same as "Some".

When you type the word street-wise, the dash will be spoken only if the "Most" punctuation
setting has been chosen.

Number Format

n Numbers are announced as digits or as complete numbers.

As with Punctuation or Letters, the current setting is spoken when you first press n, and the
last setting spoken before you exit is the new setting.

Capital Letters

k Speak capital letters. This toggles between speaking capitals and not.
This setting applies only when you are in the Editor; the MB-LS says "cap"
before each upper-case letter.

Speak Commands as You Type Them
c This command toggles between speaking and not speaking commands as
they are typed.
The default setting is for commands to be spoken as you are typing them: pressing
command causes the MB-LS to say "command", and each character typed is spoken.

After you use this keystroke to toggle to "speak commands no", the MB-LS beeps when you
press command; the command keystrokes themselves will be silent. The MB-LS will beep
again when you press enter; a high-pitched short beep for a successful command, and a
longer, lower tone for a command error.

Speak Spaces

s Pressing the letter s will toggle between spaces being spoken as "space"
or not being spoken at all.

Keyboard Echo

This setting applies to the way the MB-LS speaks while you are actually typing at the
keyboard.
e Press the letter e to cycle through the 4 options:
Letters  When you are entering text, each character is echoed as it is entered.
Words When you are entering text, each word is spoken when space or
linefeed is pressed at the end of the word.

Both This setting combines the Letters setting and the Words setting; each
character is spoken as it is entered, and when space or newline is
pressed the whole word is spoken.

No When this setting is active, the MB-LS will not echo your typing
keystrokes at all. Commands will still be spoken as they are entered.

Nemeth Mode

Nemeth Mathematical Braille, used in the USA for calculations, shares characters with
literary Braille. To help students who are learning the Nemeth code, there is an Option,
accessible from the Options Menu, that will cause all Nemeth characters to be spoken as
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Nemeth Braille.
Nemeth Mode is only available in Advanced Mode.

Once you are in Nemeth Mode, all other Options Menu features become unavailable until
you exit this Mode.

o-chord n  Sets synthesised speech to speak all Nemeth operators and low numbers
as Nemeth Math Braille. Requires Advanced Mode. To exit press z-
chord.

International Characters

f Pressing the letter F toggles between international characters being
spoken or not.
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Learn and Advanced Mode

Your MB-LS has two modes: Learn Mode and Advanced Mode.
When your MB-LS arrives, it is in Learn Mode.

Switching between Learn and Advanced Mode
adv Change between Learn Mode and Advanced

Mode.

, . . ® o

Remember that when your MB-LS first arrives, if you press

command nothing happens, because the key is inactive. To turn O OOOQ DOO O
N N

command on, use this keystroke:

tab+space+newline+backtab
Once command is active, you will be able to use adv to change to Advanced Mode.

In Learn Mode:

The speech is Recorded Speech. See the Speech section for more explanation;
Graphics Mode is available - see the section Making Braille Graphics;

The Mimic is found automatically when it is connected and switched on. To find out
more about using the Mimic, see the section Adding the Mimic and a Keyboard,

Files can be saved into the memory - see Essential Extras;

An external PC keyboard will type ASCII in English; in some languages with non-
Roman alphabets, you will only hear a spoken response, but no Braille will result. In
European languages, when the letter keys are pressed, the Braille will be correct, but
numbers, capitals and punctuation will not produce correct Braille. See the section
Adding the Mimic and a Keyboard for more information;

Braille translation is not available. See the section Braille Translation for more
information.

In Advanced Mode:

The speech can be either Recorded Speech or Synthesised Speech. The first time
you enter Advanced Mode, the speech will be set to Synthesised Speech. See the
Speech section for information on how to adjust the speech in Advanced Mode;

All the functions available in Learn Mode, including Graphics, are also available in
Advanced Mode;

Braille Translation is available; see the section Braille Translation for more
information.

There is an Options Menu with several software functions available to you. Each of
these functions has its own section.
«  Music Fun Mode - Simple and Scientific Calculator
Music Play Mode « Clock, Calendar and Diary

The Editor is available for writing, editing, saving and retrieving files. See the section
The Editor for all the information about how to use this feature.
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The Music Editor lets Braille Music learners practice by writing, editing, playing back
and embossing simple Braille Music. See Braille Music on the MB-LS for more.
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Adding the Mimic and a Keyboard

As well as being a Braille Writer, your MB-LS can also be a communication tool, so you can
interact with people who don't know Braille.

P )

Mimic Mimic

The Mimic Display e

The Mimic is a small external display for the MB-LS. It
displays in text what has been typed on the MB-LS in
Braille.

The Mimic takes 4 AA batteries. When nothing has
happened for 15 minutes, the Mimic will go to sleep; this
conserves battery life. The batteries should last for several months.

nnnnnnnnn

0e O @ 4

The Mimic comes with its own cable to connect it to the 9-pin serial port on the right side of
the MB-LS, the Mimic or S1 port. To refresh your memory about which port this is, compare
your MB-LS to this diagram:

__Mimic port
% (serial port S1)

The Mimic port is the second port from the front, on the right-hand side of the MB-LS, and it
is the larger of the two ports. You can feel the pins. You can connect either end of the cable
to the MB-LS; it is reversible. The connector will only go in one way.

After you have connected the Mimic, turn it on and then turn the MB-LS on.

How the MB-LS and the Mimic talk to each other depends on which mode you have selected
on the MB-LS.

If you are in Learn Mode: Communication with the Mimic is on by default.

As you type information on the MB-LS, it is translated and sent to the Mimic every time you
press space.

If you want to turn communication to the Mimic off, and still remain in Learn Mode you can
use the command mimic. This is a toggle command, so you can use it to turn
communication with the Mimic back on.

If you are in Advanced Mode: Communication with the Mimic is off by default.

If you have Mimic connected and turned on, and change from Learn Mode to Advanced
Mode, Mimic will remain functioning. However, if you start the MB-LS in Advanced mode you
must turn the Mimic on using the command mimic.

The Mimic has a memory of 20 kilobytes, which is equivalent to around 10 pages of Braille. It
records and stores all the information sent from the MB-LS, so long as it stays on and the
batteries have charge; while it is asleep it doesn't record any information, but information
already recorded is not lost.

Because Mimic stores information, you can scroll back through work that has done
previously. However, the Mimic works just like a printer in the sense that once a character is
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displayed, it cannot be edited,

Tip: If a word is corrected before you press the space bar, the Mimic will display the
corrected word.

As you type Braille on the MB-LS, the Mimic displays the text for the current line of Braille,
scrolling the previous text up as new text is received. However, if you then press one of the
Mimic buttons to scroll back through the text, new words Brailled on the MB-LS will no longer
appear automatically on the display. You will have press the “scroll down” button to find the
most recent characters.

The Mimic can be connected to a computer and, using the MB-Comm software supplied with
your MB-LS, all the information in the Mimic can be sent to the computer for storage or
further analysis.

PC Keyboard

With the MB-LS turned off, you can connect a PC keyboard to the port on the rear of the MB-
LS. It must have a PS2 type connector, as shown in the illustration. If you don't have a spare
PS/2 keyboard available, contact us or your distributor for advice.

languages, this will produce Braille on the MB-LS

Turn the MB-LS on and type on the PC keyboard. For most
immediately. %

You will notice that if you type numbers or press the Shift

key for a capital letter, you won't get correct Braille;
numbers don't have a number sign as they should, and the /
Shift key doesn't have any effect.

For some languages, especially those using non-Roman
alphabets, typing on the PC keyboard without translation
turned on will not produce any Braille at all; you will only

hear the keystrokes spoken. lllustration 15: PC keyboard showing

For your PC keyboard to produce properly translated and the PS/2 connector

formatted Braille on the MB-LS, you need to turn Forward Translation on. This is described in
detail in the section Forward Translation: Converting Print to Braille.

Before you go deeply into Braille translation, however, there is a feature to let you use the
Mimic and Keyboard together, producing properly-translated Braille and text, with a single
command.

Read on to find out about Braille Chat Mode.
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Braille Chat

Conversations using Forward and Back Translation in Turn

Using Braille Chat, your MB-LS can be used between non-Brailling parents and Braillist
children, non-Brailling teacher and Braillist student, or between sighted students and the MB-
LS user.

This mode is also good for use to provide a simple communication tool between a sighted
person and a blind or deaf-blind person.

One person can type Braille on the MB-LS keyboard and produce properly-translated text
output, which is shown on the Mimic. The second person can type on the PC keyboard and
produce properly-translated Braille on the MB-LS.

To use Braille Chat Mode, both the Mimic and a PC keyboard must be connected and
switched on. Then enter the following command:

chat Turn Braille Chat Mode on.

Chat Mode is available in both Learn and Advanced Mode. This is a toggle command, so it is
used to turn Braille Chat Mode on and off; its default status is off.

Once Braille Chat Mode is active, tab and backtab change their functions: while you are in
Braille Chat Mode, use tab and backtab on the MB-LS keyboard and F1 and F2 on the
PC keyboard to alternate between Braille and text.

When you turn Braille Chat Mode on, the MB-LS will say ‘back on’. This means that the MB-
LS is waiting for the first message to be sent from the MB-LS to the Mimic.

When the person using the Braille keyboard wants to write a message, they must. press
backtab. The MB will say ‘back on’. Then they can write a message on the Braille keyboard
which will appear as text on the Mimic. Pressing tab will change to Forward Translation.

When the person using the PC keyboard wants to write
a message, they must press the F1 key on the PC
keyboard; the MB will now say ‘forward’. Then type the
message. Pressing F2 will change to Back Translation.

When the person using the MB-LS is typing at the
keyboard, the Braille is embossed immediately, and
each word is sent at the Mimic when space is
pressed.

-h

pe

R

SRS DT
EFNPRITE

When the person using the PC keyboard is typing,
their text will be embossed on the MB-LS each time
they press space, and the word will arrive on the
Mimic at the same time. The Braille will be Grade 1. If
you would like Grade 2 Braille, enter the command
fgr 2 while Chat Mode is active.

RIE X
BN ESE

In order to help you to explain this procedure to a deaf-
blind person, a finger-spelling alphabet is provided. y

c

Chat Mode is also available when using the MB-LS
with MB-Comm software on your PC.
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Braille Translation

Your MB-LS is able to handle both Braille and print.

You can have Braille translated into print, so that it can be displayed on the Mimic, or
transferred to a PC, or printed on an external printer; this is called Back Translation.

You can have print translated into Braille, so that you can use an external PC keyboard, or
so that text files on your PC can be sent to the MB-LS to be translated and embossed; this is
called Forward Translation.

You can use these features so that:

« In the classroom, a teacher or student who doesn't know Braille can write Braille for
the student using the MB-LS; they can see immediately on the Mimic what they
have written, while the Braillist using the MB-LS can read what they have written.

At home, families can do activities together using the MB-LS to write and emboss
stories, do puzzles and play games.

Teachers and classroom assistants can emboss worksheets, classroom material
and graphics for the student to use in class.

Very Important!

Braille translation is only available when your MB-LS is in Advanced Mode.

You can only translate in one direction at a time: Forward Translation cannot be on at the
same time as Back Translation. Even when using Braille Chat, the translation must be
changed over each time the two people conversing wish to change from MB-LS input to PC
keyboard input.

forward

<= N

Braille Print

\

back

lllustration 16: The two translation directions

Forward Translation
Converting regular text from any source into Braille.

Back Translation
Converting Braille you type on the MB keyboard into text.

Braille Code

The Braille code installed in your machine is the appropriate code for your country and
language. Your MB-LS can also contain the Braille codes for other languages; consult with
your distributor to find out what is available in your MB-LS.
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International Characters

Independent of the Braille code you are using, you can insert international characters in your
text or Braille.

Universal Braille Settings

The default Braille settings of the MB-LS will vary from country to country. However, you can
select a universal Braille setting that will apply to both back and forward translation.

grl Sets all translation to uncontracted Braille (Grade 1);
gr2 Sets all translation to contracted Braille (Grade 2), where it is available;

grO0 (zero) Sets all translation to ASCII Braille (Grade 0), also known as NABCC. See
the section Braille Codes and Languages for more information.
Once these commands have been entered, they will remain as the default setting even after
you have turned the MB-LS off.

You can also change the features of either forward or back translation using the commands
described in the following sections, to produce Braille that exactly meets your needs.
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Forward Translation: Converting Print to
Braille

Forward translation means that you can send regular text to the MB-LS and it will convert it
to Braille and emboss it on paper or store it as a Braille file in memory.

The text can be from a regular PC keyboard directly connected to the MB-LS, a portable
note-taker, or a computer.

Very Important!

The Forward Translation settings and commands apply only in Advanced Mode. In Learn
Mode, Translation is not available - so if you are having translation problems, make sure that
your MB-LS is in Advanced Mode before you try to translate.

There are two ways to do this:

From the MB keyboard or the PC keyboard, use the command adv to turn Advanced
Mode on and off;

Embed the {adv} command in the file you're sending to be translated and
embossed, before the command to translate and again after the translate command at
the end.

The first way to use Forward Translation on the MB-LS is to type the text from a PC
keyboard. You can write information on the PC keyboard and have it automatically translated
and converted to Braille, which is then embossed.

Using a PC Keyboard
To connect the keyboard and begin producing translated Braille, follow these steps :

Turn off the MB-LS;

Connect the PC keyboard to the keyboard port on the back of your MB-LS;

Turn the MB-LS on;

On the MB-LS keyboard, enter the command fe by typing command f e enter;
Start typing on the PC keyboard.

If you have followed these steps, including entering the fe command, you will only hear the
MB-LS speaking the keystrokes as you type — the Braille will begin to emboss in a little while.

Just at first, you won't get any Braille, because your MB-LS stores the text you are writing in
an eighty character buffer, to make sure all contractions and Braille rules are followed
correctly. When it has 80 characters, it will begin embossing. You can keep typing while the
MB-LS embosses; as soon as it has 80 characters built up, it will emboss again.

If you have finished typing, and not all the Braille has come out, this means that you still
have some untranslated text in the buffer, and it hasn't reached 80 characters yet.

To push out all the remaining Braille at any time, empty the buffer by pressing the Enter key
on the PC keyboard twice.

If you just keep typing the buffer will empty automatically every eighty characters.

Basic Forward Translation

Once Forward Translation has been turned on, using the fe command, you can select a
mode called Basic Forward Translation. This gives you Grade 1 Braille without any
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contractions, and sends each word out to be embossed as soon as you press Space on the
PC keyboard.

To activate Basic Forward Translation, use this command when you know that fe is active:

fb In Basic mode each word is embossed after the space key is pressed.
This function automatically switches to uncontracted Grade 1 Braille. £b is
a toggle command, and its default state is off.
Once you have entered the £b command, when you type on the PC keyboard, you will find
that your MB-LS embosses after every word, instead of waiting for 80 characters to build up.
You will also find that you are embossing uncontracted or Grade 1 Braille; Numeral and
Capital signs and punctuation are as they should be, but word-signs and contractions don't
appear.

Note: If £b is on, the MB-LS will ignore the "hyphens” setting, and many other Forward
Translation commands and settings, including formatting commands and the Patterns
commands.

Entering Commands Using a PC Keyboard

Many keys on the PC keyboard have the same function as keys on the MB, so if you are
using a PC keyboard to produce Braille, you don't have to change keyboards to enter a
command.

Things to remember:

You must enter the full command on one keyboard or the other — you can't begin a
command on the PC keyboard and finish it on the MB keyboard.

If command on the MB is deactivated, you can still enter commands from the PC

keyboard.
Keys on the PC Keyboard Keys on the MB Keyboard
Escape Command
End Enter
F1 Left Function
F2 Right Function
F3 Left and Right Function together
Enter New Line
Down Arrow Space and New Line together
Up Arrow Space and Backspace together
Left Arrow Backspace
Right Arrow Space
Space Space
Backspace Erase

So, to enter the command fe on the PC keyboard you press Esc, type £ e, then press the
End key. The MB-LS will say "On" just as it does when you enter the command from the
Braille keyboard.

Forward Translation of a file from the PC
When you have the MB-LS connected to the PC using MB-Comm, you can send files to be
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embossed, and the MB-LS will translate the file as it is being embossed. For information
about using MB-Comm, see the section Installing and Using MB-Comm.

Using Commands in a File

If you send a text file to the MB-LS for embossing, and you don't use any commands to turn
on Forward Translation, you will get Braille that hasn't been translated. This won't be correct
Braille. You need to add the commands to turn Forward Translation on.

You have the choice of entering the commands on the MB-LS keyboard, or on the PC
keyboard, or you can enter the commands in the file itself.

If you enter the commands inside the file, the MB-LS will act on them while the file is being
received. You can turn translation on and off, set and change formatting and Braille Grade -
in fact, everything you can do with commands from the keyboard you can do within a file.

On the MB-LS keyboard, a command begins with command and ends with enter; on the PC
keyboard a command begins with Esc and ends with End; and in a file, a command begins
with { and ends with }. These beginnings and endings all perform the same function; they
tell the MB-LS first that a command is coming, and once the command has been entered,
that the command is complete and ready to be acted on.

As you read through the instructions and examples, you will see commands beginning with {
and ending with }. You can use commands with { and } around them in a file; replace { with
command or Esc, and } with enter or End, and you can use the same commands from
either keyboard, in whichever way suits you best.

Sending a Text File to the MB-LS for embossing
First run MB-Comm and connect the MB-LS. Then:
In the File menu, select “Emboss File on Mountbatten”. A dialog box will open.

Select the text file you want to emboss on the computer. The file must be a Plain
Text file, with the extension .txt.

o If you use a MS Word document, make sure you save your file as type .txt before
you begin, using Save As from the File menu and choosing .txt from the File Type
list.

Once you have selected the file, right-click on it, and select Open from the menu.
The .txt file will open, in Notepad or a similar text editor.
To translate the text file into Braille, you must activate Forward Translation:

o Insert {£e} once on the first line, and again on the last line at the very end of the
file. This command turns Forward Translation on and off.

Save and close the file.

The dialog box from the first step will still be open; make sure you have selected the
correct file.

Click OK in MB-Comm to have your file translated and embossed.

Setting up a template for embossing

It can be useful to have a blank template on the PC, so that all the commands are in place
and you only need to copy and paste text from another program such as Word. Here are
some suggestions:

Start a new file in Notepad or a similar text editor. We recommend that you don't use
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Word or OpenOffice to set up a template file, since this file must be Plain Text only.

Put the following lines in your file, leaving at least one blank line between the two
commands:

{fe}

{fe}
Save the file to your desktop.

Now, each time you need to emboss something, you can open the template, copy and paste
the text you want to emboss between the two commands, and save the results to a new file
using Save As from Notepad's File menu. You can copy and paste text into your template
from any program - Word, OpenOffice or other software.

Very Important!

It is very important that you open your template in Notepad or a similar Text Editor, so that
nothing is introduced into the file that you don't know about; we advise that you don't use
Microsoft Word or OpenOffice for this.

If you normally use your MB in Learn Mode, your template should look like this:
{adv} {fe}

{adv}

In this template, the two commands {adv} turn Advanced Mode on at the start of the file,
and then off at the end. There is only one {fe}, at the beginning; because when the second
{adv} turns Advanced Mode off, Forward Translation is turned off automatically, since.
translation only works in Advanced Mode.

Remember to leave space between the commands to go the start of the file and the
commands to go at the end, so you have somewhere to paste your copied text.

If you need a little more than just a straight translate-and-emboss, there are other Forward
Translation commands that your MB-LS will honour when they are embedded in your file
using curly braces. Once the text is in your template and you have saved to a new file using
Save As, you can go through the file and add commands. There are some examples towards
the end of this section, following the commands.

Forward Translation Commands

Once fe is active, you can use a variety of commands to:
direct where the translated Braille will go, to a file or to the embosser;
set up the Braille Grade and language, including the use of accented characters;
format the Braille page.

You will see that all of the Forward Translation commands begin with £.

You might find it helpful to remember that any command beginning with £ has to do with
translating text to Braille, and that these commands will have an effect on the translated
Braille.

Turning on Forward translation

fe Forward translate and emboss. This is a toggle command, and its default
state is off.
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fm [filename] Forward translate the text input and send to a file in memory called
[filename]. This command turns embossing off. The saved file can be
embossed later using the emb command.

fm append [filename] Forward translate the text input, and append the translated
Braille at the end of an existing file with the name [filename]. The file
must already exist in the memory.

fm end This command closes the file in memory, and turns forward translation off;
this command also turns embossing back on.

Change the Braille Grade

fgr [grade] Select the Translation Grade, where [grade] may be 1 or 2. The default
Grade in English is Grade 2, fully contracted Braille; it may be different for
another language.

Use another language or accented characters

fln [language] Use this command to change the Braille translation rules
from the current language to another, where [language] is one of those
in the table below.
For instance, if your MB-LS is USA English, with Language Set A installed, and you would
like to translate the text using the Braille rules for German, you would enter £1n ger. To
change back, you simply turn translation off, as this setting isn't saved.

ffc [language] International character translation. This command lets you
insert an international character into your text, to be translated according
to a different translation language rule, without changing the main
translation rules. [language] is one of those in the table below.
For instance, if you are using an Australian English MB-LS, and you would like to insert a
French accented character, use the command £fc fr.

dfln [language] hange the default translation language to one of those from
the table below.

Which languages you can change between will depend on the language set installed on your
MB-LS. If you aren't sure which language set applies, contact your distributor.

Each language set has a letter designation. Braille rules for all languages within a language
set are available using the £1n or df1n command.

Language codes:

A B Cc D
Spanish spa Russian rus Portuguese por  Swedish swe
Italian itl Polish pol Greek grk Norwegia nor
n
French fr  Lithuanian 1it English oz Finnish fin
English oz German ger English uk English oz
English uk English oz English usa  English uk
English usa English uk Brazilian @ bra  English usa
Portuguese
English usa Dutch dut
Czech czc
E F G T
Thai tha Turkish tuk English oz English oz
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Taiwanes  twn English oz English uk English uk

e

Mandarin  chi English uk English usa English usa

Chinese

Korean kor English usa Belgian dut Argentinia spa
Dutch n Spanish

English oz Arabic arb

English uk
English usa

Formatting Your Braille - using Literal Mode
flit Literal Mode.

When £1it is on, each time you start a new line in print, you will start a new line in Braille,
and it preserves blank lines in the text being translated. The default state is off. This
command is a toggle; entering it again will turn it off.

When £1it is off, blank lines in the text are removed automatically, and a new line in print
does not start a new line in Braille.

The next two commands are accessories to Literal Mode. To use them, you must first make
flit active, and then use the accessory command. Turning £1it off by re-entering it will
also turn off the accessory command.

flit [n] This command creates a Hanging Indent in your Braille output, where the
first line of the paragraph starts closer to the left than all the other lines.
[n] gives the number of indented spaces and can be set to 0, 1, 2, 3, 4,
5.
flit s This command causes any blank lines in the text to be removed from the
translated Braille, as well as adding a two cell indent for new paragraphs.
To allow blank lines between paragraphs, and control the number of blank lines between
paragraphs in the Braille output, you can use the el command. This command is also an
accessory to Literal Mode; if £1it is not active it has no effect.

el n Allow only ‘n’ blank lines while embossing. Any lines greater than ‘n’ will
be discarded (avoids having large blank areas on the Braille page).

If, after turning on £1it, you set el to any value larger than zero, it will override £1it s
and force "n" blank lines after each paragraph. This setting will only apply while £1it is on;
once you use £1it again to turn Literal Mode off, el will return to its usual setting of zero.

More Formatting

The following commands are independent of Literal Mode; you can use them whether or not
you have £1it active, and turning £1it on or off doesn't affect them.

Italics
fit Use this command to italicise Braille. It should be used immediately
before and after the Braille to be italicised. £it is a toggle - use the same
command to turn italics on and off - and its default state is off.
Hyphens
fhyp This command will break Braille words, using a hyphen, at the end of a

line, so that the Braille comes all the way to the Right Margin. Use it if you
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need to make sure you fit the maximum amount of Braille per line. This is
a toggle command, and its default state is off.

Automatic Indent

fin When £in is turned on, the current Braille column (the position of the

embossing head, or your position in a file in the Editor) is stored, and
subsequent Braille lines are indented to begin at that column. The default
state is off - lines begin at the left margin - and this is a toggle command.

Multiple Space Removal

fsh This command replaces all multiple spaces and tabs in the text with single
spaces in the Braille. This is a toggle command, and its default state is on.

Fraction Mode

ffr This command causes text fractions to be translated to Braille fractions
using the lower numeral sign for the denominator. Use it once before the
fraction and once after, to turn Fraction Mode off when it isn't needed. The
default for this command is off, and it is a toggle.
For example, in English Grade 2 Braille, if you enter 1/2 for one-half, fraction mode will

cause the translator to emboss numeral sign, a, lower b. The MB-LS adds a mathematical
separation sign after the Braille fraction if it is immediately followed by punctuation.

Upper Case
fcl Use f£cl when you are translating upper-case text and don't want double
capital signs before every word in the Braille. The default for this
command is off, and it is a toggle.
New Page
np Forces a new Braille page. Use this in a text file to eject the paper from

the MB-LS so you can load a new sheet.

You will see that np doesn't have an £ at the start of the command - this means that you can
use it throughout the MB-LS, not just in Forward Translation.

New Paragraph

fpa Forces a new Braille paragraph. Use this to make sure that a new
paragraph starts where the text is at the top of a text page.

Lists and Tables

These commands simplify building lists or tables, such as spelling lists, and tables of
contents etc. Create two or three columns, using either default settings or user selected
settings. Each column is specified as a percentage of the Braille line length.

flist on or off Create simple lists or tables

If you enter £1ist on, it will produce a table of three columns, of 40%, 40% and 20% width.
For example: If your Braille page is 40 cells wide then the default will give three columns,
each of cell widths 16, 16 and 8

To return to normal formatting without columns, use flist off.

The default for this command is off.
flist nl n2

This command allows you to specify column widths, as a percentage of the line length. The
values allocated to n1 and n2 will determine if you want two or three columns. If the values
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of n1 and n2 add up to exactly 100% then you will get two columns with widths in the
proportions specified. If they do not add up to 100%, then you get three columns, of which
the third column is the remainder. For three columns, the third column cannot be greater
than 90% or less than 10%.

For example:

flist 3 7 is ok.; this gives you three columns, with widths of 3% 7% and 90% of the
page.

flist 50 50 is ok; this gives you two columns of equal width.

flist 33 33 is ok; this gives you three equal columns of 33%, 33% and 34% of the
page.

flist 5 4 gives an error, because nl+n2 is less than 10%.

flist 50 45 gives an error, because n1+n2 is greater than 90%.

Type the text you want, and separate entries for each column by putting 2 or more spaces
between each entry. If the entry for a column is too long it will be wrapped to the next line but
it will stay in the column. Press the Enter key on the PC keyboard to start a new line.

You cannot have blank columns, except for the first column, and columns two and three are
always right justified.

Some Forward Translation Examples

Example 1 - Formatting Your Braille into a list.
Enter the command £fe, or put {fe} at the top of the document.

Type the following list on the PC keyboard, or type it into your document. Press Enter after
each line in the list.

1. Cat

2. Sat

3. Hat
If you are using the PC keyboard, now press Enter twice on the PC keyboard. Remember to
enter the command fe to turn Forward Translation off again.

If you are practising this example in a document, put {£e} again at the foot of the document,
save the document and use MB-Comm to send the document to the MB-LS to be embossed.
Your document should look like this:

{fe}
1. Cat
2. Sat
3. Hat
{fe}
The first { £e} will turn Forward Translation on, and the second will turn it off again.

When you check the Braille, you will see that all three items which were on separate lines as
text are now on a single line in Braille.

The next example shows you how to keep listed items on separate lines using £1it.

Example 2 - Formatting Your Braille into a list

Begin a new document in Notepad or a similar text editing program.
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Put the command {fe} atthe top of the document as in the previous example.
Enter the command {£1it}
Type the following list.

1. Cat
2. Sat
3. Hat

Enter the command {£1it} again to turn it off;

Enter the command {£fe} again to turn Forward Translation off.

Your file should look like this:
{fe} {£f1lit}

1. Cat
2. Sat
3. Hat

{flit} {fe}
When you check the Braille output, you will find that the line breaks are now preserved; this
is how £11it works.

You can try this example from the PC keyboard also - instead of curly brackets, use the Esc
and End keys on the PC keyboard.

Example 3 - Columns separated by Tab

You can produce simple columns by making sure that any tabs or spaces that are in the
original text are preserved in the Braille.

Follow these steps on the PC keyboard, to see how it works:
Enter the command fe;
Enter the command £1it;
Enter the command £sh;
Type ¢ a t and press Tab twice; type d o g and press Enter;
Type r u g, press Tab twice; type b u g and press Enter;
Type m a t and press Tab twice; type b a t and press Enter twice.

Now enter the command £1it, and then the command £sh, and finish with the
command fe.

You will have two columns of Braille, with two words on each column; the tabs have been
changed into spaces, and the spaces have been preserved.

In a text file for embossing, the contents would look like this:
{fe}{£flit} {£fsh}

cat dog
bug rug
mat bat

{£f1lit} {fsh} {fe}
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Example 4 - Write a Letter on the PC ready for Braille

Write your file in Notepad or a similar text editor so that it appears on your computer screen
exactly as it is presented here, and then use MB-Comm to send it to the MB-LS for
embossing. You will have produced a Grade 2 Braille document.

Don't forget: you should be in Advanced Mode already, before sending the file. If your MB-LS
is in Learn Mode, you can enter the adv command from the keyboard before you begin, or
you can embed it in the file as the very first command.

{fe}{flit}Ms. Heather Wilson

10 Smith Street,

Frankston

Dear Ms. Wilson,

{flit}After recently visiting your display at the home show in
Melbourne, I was very impressed with both the quality and
variety of hand-crafted music boxes displayed.

We would like to order the following selection of music boxes:

{£f1it} {£fsh}

Fairies Gnomes
Pan's Pipes Elves
Gondolier Coaches

{£f1it}{£fsh}It would be greatly appreciated if you could ship an
assortment of boxes to each of our regional marketing
representatives by the last week in November. We look forward to
establishing a working relationship with you, and would be very
interested in any other items you feel might fit well with our
current expansion plans.

Saving Your Preferred Settings

If you have settings for your Braille output format that you would like to keep, you can - it's
possible to save them all as a group. You then have the option of choosing between the
default settings and your saved settings.

First, to save the settings use
save ft Saves all current Forward Translation settings, including Braille
Grade, language, and output settings.
If you would like then to return to the default settings, use

std ft Restores all default Forward Translation settings. Restoring the
defaults does not interfere with stored settings.
To return to your saved settings, use

restore ft Restores all stored Forward Translation settings.
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Back Translation: Converting Braille to Print

Very Important!

Back Translation settings and commands apply only in Advanced Mode. In Learn Mode,
Translation is not available - so if you are having problems, make sure that your MB-LS is in
Advanced Mode before you try to translate.

From the MB keyboard or the PC keyboard, use the command adv to turn Advanced
Mode on and off;

To produce a print copy at the same time as a Braille copy we have to perform a job called
back translation - going from Braille to print. The options for viewing the translated print
produced by the MB-LS are;

* View the print on the Mimic;

* View the print on a regular ink printer - see Selecting a Printer at the end of this
Section;

* Send it as a file to a PC or note-taker.

Special note about the Mimic

The Mimic is the exception to the rule about all translation requiring Advanced Mode. In
Learn Mode, Back Translation works for the Mimic. However, if you use the MB-LS in
Advanced Mode, you need to use the mimic command to tell the MB-LS to send text to it.

You do not need to use any Back Translation commands to send translated text out to the
Mimic in either Learn Mode or Advanced Mode.

Turning Back Translation On

Back translation involves sending translated Braille from the MB-LS to the Mimic, to a Printer
or to a PC. It's important to tell the MB-LS where the text has to go, which is why there are 4
commands:

bp Back translate to the Parallel Port on the back of your MB-LS. This
command is a toggle, and its default state is off.

Use this command to send translated text out to a printer connected to the parallel port on
the back of the MB-LS.

bsl Back translate to the Mimic port. This command is a toggle, and its default
state is off.
Note: You do not need to use this command to send text to the Mimic itself - use this

command only when you wish to connect a PC or note-taker to the Mimic port in order to
transfer a file.

bs2 Back translate to the S2 Serial port, which is the 9-pin serial port on the
back of your MB-LS. This command is a toggle, and its default state is off.
This command affects the serial port on the back of the MB-LS. Use it to send the translated
text to a PC or note-taker, or a serial printer, connected to this serial port.
busb Back translate to USB port. This command is a toggle, and its default
state is off.

Use this command when you want to send your translated file to a PC or note-taker
connected to the USB port. This command isn't suitable for sending translated text to a
printer.
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How Back Translation Operates

The MB-LS stores information to be printed in a memory buffer, and translates it and sends it
over to the printer every 80 characters. If you want to empty the buffer before 80 characters
are entered on the MB-LS keyboard, press newline on the MB-LS twice.

If you are using busb to send a Braille file to a PC using MB-Comm, the whole file will be
transferred without any need to press newline twice.

Formatting the Printed Output

Often there may be little need to learn any more commands, especially with younger
students where a simple print copy of what is being brailled is required. For more advanced
users there is a wide range of commands that enable you to set up the format and
appearance of the printed output.

You might find it helpful to remember that the Back Translation commands all begin with b.
These commands all have to do with converting Braille to text, and they affect the translation
and the print format of the output.

Changing the Braille Grade or Code Used

bgr [grade] Translation Grade, where [grade] may be 1 or 2. The default is Grade 2,
which means that the MB-LS is expecting the Braille to be Grade 2 or
fully-contracted Braille. In an English MB-LS, it is only necessary to use
this command if your original Braille is in Grade 1.

bfc [language] As with Forward Translation, the International character
selection command lets you insert a international character into the text; it
will translate the marked character according to the [language] code
you enter. [language] can be any one of the codes in the table below.

bln [language] This command changes the Back Translation rules to the
rules of the [language] code you enter. [language] can be any one
of the codes in the table below.
With either bfc or bln, your choice of codes will depend on the language set installed on
your MB-LS. If you aren't sure which language set applies, contact your distributor.

Each language set has a letter designation. Braille rules for all languages within a language
set are available using the bfc or bln command.

Language codes:

A B Cc D
Spanish spa Russian rus Portuguese por  Swedish swe
Italian itl Polish pol Greek grk Norwegia nor
n
French fr  Lithuanian 1it English oz Finnish fin
English oz German ger English uk English oz
English uk English oz English usa  English uk
English usa English uk Brazilian  bra  English usa
Portuguese
English usa Dutch dut
Czech czc
E F G T
Thai tha Turkish tuk English oz English oz
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Taiwanes  twn English oz English uk English uk

e
Mandarin  chi English uk English usa English usa
Chinese

Korean kor English usa Belgian dut Argentinia spa
Dutch n Spanish
English oz Arabic arb
English uk
English usa
Formatting Your Print Page
Automatic Indent
bin This command causes all subsequent lines to indent to the current cursor

position. The default status is off, and this command is a toggle.

The current cursor position is that position in the Braille where the command is entered; it
can correspond to the position of the embossing head on the MB-LS, or to the cursor
position in a Braille file in the Editor.

Centring

bce When bcee is on, it causes all the following text to be centred between the
left and right margins. Use bce again to turn centring off. This is a toggle
command, and its default status is off.

Columns and Tables

blit Literal Mode.

When Literal Mode is on, each new line in Braille will produce a new line in print. When it is
off, a new line in Braille is ignored in the print copy, to avoid the print being broken into short
lines. This is a toggle command, and its default status is off.

bsh This command removes hard spaces from the Braille; it causes multiple
spaces and tabs in your Braille to be converted to single spaces and tabs
in the print. This is a toggle command, and its default status is off.

Margins, Line Length and Paper Size

Left Margin
blm x This command sets the width of the left margin to x spaces from the left-
hand edge of the paperThe maximum value of x is 30. The default left
margin is 8 characters in from the left edge.
Right Margin
brm x This command sets the width of right margin to x spaces from the right-
hand edge of the paper. The maximum value of x is 30. The default right
margin is 8 spaces from the right edge.
Top Margin
btm x This command sets a margin of x blank lines at the top of the page before

printing beginsThe top margin may not exceed the form length (the total
number of lines on the page) minus the page length. The default top
margin is 3 lines from the top of the page.
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Line Length
bll x This command sets the width of the printed page, including margins, to x
characters, at 10 characters per inch. The maximum value of x is 132.
The default page width is 80 characters.
Note: When you are setting margins and line length, the line length minus the margins must

leave at least 10 printable characters across the page, otherwise the MB-LS will say
"command error".

Form Length
bfl x This command sets the total length of the page, including the top margin,
to x lines, at 6 lines to the vertical inch. The maximum number of lines to
the page is 100, for a page that is 16.6 inches long. The default number of
lines to the page is 66, for an 11-inch page.
Page Length
bpl x This command sets the number of printed lines on the body of the page,

after the top margin, to x lines. If you enter a page length that is longer
than the form length, your MB-LS will say "command error". The default
number of lines in the body of the page is 60.

The default settings for Form Length, Page Length and Top Margin leave a bottom margin of
3 lines.

Upper Case Lock

becl This command locks the output text into upper case when it is on, and
returns to the translating the Braille upper and lower case when it is off.
This is a toggle command, and its default status is off.

Fraction Mode

bfr This command causes Braille fractions to be translated to text fractions
using the slash character to separate numerator & denominator. It
requires that the Braille has a Mathematical Braille separation sign (Dot 6)
between the fraction and any subsequent punctuation. This is a toggle
command, and its default status is off.

Tabulation
These Tab Stop positions relate to the printed output. The default Tab Stops are:
9,17, 25, 33, 41, 49, 57, 65, 73 and 81.

btbc This command clears all the current tab stops.
btba x Sets an extra tab stop at position x.
Line Spacing
bls x This command sets the printer line spacing to x, which may be from 1 to

10. The default line spacing is 1.

Page Justification

bpj When this command is on, it causes the printed text to align with both
margins. This can cause extra spaces to be inserted into the printed text.
This is a toggle command, and the default status is off.
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Right Alignment

bra When this command is on, it causes printed text to be aligned to the right
margin. When it is off, text aligns to the left margin.

bra takes precedence over bpj, so if you have bpj on and then enter the command bra,
text will be right-aligned until you use bra again to turn right-align off.

Line length & horizontal margins may not be altered while bra is on, and tabs are converted
to single spaces. bra is a toggle command, and the default status is off.

Page Numbering

bpn x p Turns page numbering on or off at the desired position p with a value of x.
The maximum value of x is 1000, and accepted position codes are:
tl - Top left bc - Bottom centre
tc - Top centre br - Bottom right
tr - Top right of £ - Turn off page numbering
bl - Bottom left on - Turn on page numbering
bpnt [braille] Creates a text string to be printed with the page number,

where [braille] is the text to be printed.

Note: To position text and turn numbering on and off , use the bpn command, as given
above. The maximum length of text in a page number is 15 characters, and no punctuation is
allowed.

Selecting a Printer

The kind of printer that is suitable for connecting to your MB-LS is a line printer. This is
because the MB-LS sends out one line of back-translated text at a time.

Line printers include the Epson LX 300 or a similar dot-matrix printer. All dot-matrix printers
work well.

You need to make sure that the printer you select is able to connect via a parallel port or a
serial port; a USB printer cannot be connected to the MB-LS. If you are unsure, please
consult with your distributor.

Most currently-available ink-jet or laser printers are page printers, which are not suitable to
connect to the MB-LS. "Windows only printers” are unsuitable also, as are USB printers.

If in doubt please contact your distributor for clarification prior to purchasing a printer.

Embedding Commands in a File to be Back Translated

When you edit a Braille File in the MB-LS Editor, you can insert commands into the file as
you write it, so that it will be Back Translated into text when you transfer it to the PC using
MB-Comm.

To enter a command in a file in the Editor, go into the Editor's File Menu with newline+e
and press c. Enter the command and press e-chord to complete.

The first command to enter is the one to turn Back Translation on, for instance, use busb for
translation through the USB port to send a file to the PC using MB-Comm. This command
should be the first thing in your file, before any Braille. Other formatting commands can be
added into your file where they are needed. Since busb is a toggle command, you should

also add it as the last item in your file to turn it off again.

User Guide 52



Use the Receive and Save File item on the MB-Comm File Menu to transfer your file and
have it translated to text as it transfers.

See the section The Editor for more information about adding commands and searching for
them in your file.
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Braille Translation — Using APH Patterns

For users in English-speaking countries, Braille contractions can be organised into 15 groups
in accordance with the Braille Patterns curriculum developed by the American Printing House
for the Blind, in Kentucky USA.

These groupings represent an ordered introduction of contracted or Grade 2 Braille for
reading and writing instruction. Teachers can introduce contractions in small groups,
matching their introduction to a student’s individual abilities and needs. Students can even
have fun by ‘discovering’ Braille contractions themselves.

For instance, if a teacher activates Patterns 1, Alphabet and Letter words, a student can
Braille any letter, press the space key and listen to the synthesised speech answer.

b but

c can

d do
and so on.

Before using Patterns

Things to know and do

Because Patterns commands are to do with translation, they can only be entered in
Advanced mode. So you will need to put your MB-LS in Advanced Mode using the adv
command. See the section Learn and Advanced Mode for more information.

Patterns commands will automatically
change the Braille translation grade to Grade 1;
turn synthesised speech on;
be saved in memory.

Once you have selected Patterns to be turned on, those Patterns will be remembered unless
you turn the actual Pattern or Patterns off, or reset the MB-LS. Turning the Patterns Function
off only deactivates the currently selected Patterns.

Any combination of Patterns can be used together; if you wish to select Patterns 1, 7 and 15
together, you can.

Using a Single Pattern Group
The command to turn individual Patterns groups on is:

ptrn x on  xis the number of the Patterns group you want to turn on.
The command to turn individual Patterns groups off is:

ptrn x off xisthe number of the Patterns group you want to turn off.
You can also use
ptrn off to turn all Patterns off. Your MB-LS will say “Patterns all off”.

Using Multiple Pattern Groups

You can also use similar commands to activate multiple patterns on and off at the same time
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ptrn x y z on x, y and z refer to the numbers of the groups you want to
turn on. You are not restricted to three groups; you can turn on up to 15
Patterns in one command. Each number should be separated by a space.
After the last number, type a space and the word on. Any group number

that you included in this command will now be turned on.

ptrn x y z off Use this command to turn off individual or multiple groups.
Again, you are not restricted to three groups; you can turn off up to 15
Patterns in one command. Type a space between each of the numbers,
and put a space between the last number and the word of £ at the end of
the command.

More Patterns Options

ptrn Turn the Patterns function off or on.

If you have already turned on Patterns 1 and 2, when you enter the command ptrn your
MB-LS will say “Patterns off”, and the MB-LS will produce uncontracted or Grade 1 Braille.

Entering ptrn again will give the response “Patterns 1 2 on”.

If no Patterns have been turned on, when you enter ptrn, your MB-LS will say “Patterns not
selected”.

Patterns Curriculum for Reading and Writing Instruction

These are the different groups available in the Patterns series. For the full Patterns
Curriculum, including the content of each group, check the Reference Section.

1. Alphabet and Letter Words
Upper Cell Contractions

2. Whole or Part Words

3. Simulated Letter Words

4, Part Word Signs
Lower Cell Contractions

5. Simulated Letter Words

6. Whole Words

7. Middle Part Word Signs

8. Beginning Part Word Signs
Multi-cell Contractions

9. Dot 5 Whole & Part Words

10. Dot 4,5,6, Words

1. Dot 4,5, Words

12. Dot 4-6 Final Letter Contractions

13. Dot 5-6 Final Letter Contractions

14. Dot 6 Final Letter Contractions

15. Short Form Words
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Adding Braille Rules
Adding Extra Rules to the MB-LS with an Exception Table

Your MB has the flexibility to enable you to make exceptions to the standard braille rules you
are using, to use the shortcuts or abbreviations of your own choice, or to introduce groups of
contractions.

The Braille Exception table is active in both forward and back translation, and you can use
the commands and make additions to your Exception Table in either Learn or Advanced
mode.

You can add up to 128 entries to the Exception table.

Braille Exception Table Commands
eta text braille position
This is the main command to add an entry to the exception table.

text is the text to be changed;
braille is the braille which will be substituted;
position is any one or a combination of the five position indicators given below:
a - allowed anywhere
b - allowed only at the beginning of a word
e - allowed only at the end of a word
m - allowed only in the middle of a word
s - allowed only by itself (except adjacent to spaces and/or punctuation).
etc Clears the exception table.

etd [text] Deletes an entry from the exception table, where [text] is the text part
of the entry.

etu Turns the exception table off or on. This is a toggle command, and the
default status is on.

Exception Table Examples

eta hello hl s

This command would add a rule to cause the word "hello" to be translated to the
abbreviation "hl", but only if "hello" is by itself. It could be surrounded by spaces or by
punctuation, but could not be contained within a word.

As an another example if you wish "help" to be translated to "hp" at the beginning and end of
a word but not the middle, the command would look like this:

eta help hp be
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Connecting your MB-LS

Your MB-LS has four ports for connecting it to other devices:

USB Port

The MB-LS has a USB-B port on the right-hand side, towards the front. This port is the same
kind of USB port as you will find on a printer; it is a square port. Use this port when
connecting to a PC with MB-Comm. If your computer doesn't have a USB port free, but there
is a free COM port, see the Serial Port, below.

The settings for the MB-LS USB port are:

Data speed: 115200

Data bits: 8

Stop bits: 1

Handshake: Hardware (RTS/CTS)
Parity: None

The USB cable supplied with your MB-LS can be used to connect with a PC, so you can use
MB-Comm to transfer files or use the MB as an embosser.

Mimic Port

The Mimic Port is a 9-pin serial port, on the right side of the MB-LS. This port should always
be used when you are connecting the Mimic. If you need to connect to a PC using a serial or
COM port, use the serial port on the back of the MB-LS.

Serial Port

The second Serial Port is a 9-pin serial port on the back of the MB-LS. This port is available
to connect a serial printer, or to connect to the serial port on a PC if you don't have USB
available.

The settings for the MB-LS Serial Port are:

Data speed: 9600

Data bits: 8

Stop bits: 1

Handshake: Hardware (RTS/CTS)

Parity: None
If you are using a serial-to USB adapter, or connecting to a PC using a serial cable, you
need to make sure the COM port on the PC is set to the same settings as the MB-LS Serial
Port. If you need a cable to connect to your PC from the Serial Port, contact your distributor.
Parallel Port

The Parallel Port is on the back of the MB-LS. Use this port to connect to a parallel printer.
To find out more about the kind of printer you can use with the MB-LS, see the section on
Selecting a Printer at the end of the Back Translation section.

Installing MB-Comm

MB-Comm is a Windows PC application, for Microsoft Windows XP, Vista and Windows 7. It
enables the transfer of files between a PC and a MB-LS or MIMIC LCD display.
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For New MB-Comm Users:

Close any programs that may be running on your PC before installing.
Double-click the MBCommSetup file and the installation will begin.

The installation checks your computer for Windows NET components and loads them
if required. This may take several minutes.

For Existing MB-Comm Users

You must first uninstall the old MB-Comm. To uninstall the old version, follow these
instructions:

Go to the Control panel.

In XP, open Add/Remove Programs, or in Vista/Win7, open Programs and Features.

Scroll down the list until you find MB-Comm.

Highlight MB-Comm and then click the Add/Remove button.

If queried about Shared files, do not remove, leave them in place.

Make sure that the MB-Comm folder under Program Files has been removed.

Once the old version is removed then proceed as for New Users.

Installing the MB-USB Drivers

The MB-USB drivers are required for MB-Comm to connect to the MB-LS using the USB
port.

Important: Please DO NOT connect the USB to the MB-LS until after the drivers
have been installed.

Close any programs that may be running on your PC before running the install.

Insert the CD and follow the prompts. If the CD does not Autoplay, navigate to your
CD drive and run the Setup file on the CD by double-clicking. Follow the prompts.

The new driver will auto detect any older version and prompt to replace the files.
Accept the new one when asked.

During install you may be twice prompted to “Continue anyway”. Please accept this
and continue.

Under XP, when the installation finishes you will be prompted to re-boot your PC. The
driver install will not be complete until the PC is re-booted. Under Windows Vista and
Windows 7 this is not required.

Now connect your MB-LS to the PC. Under XP there may be extra driver installation
which will take place automatically; answer "yes" when prompted.
Using MB-Comm

MB-Comm can connect your MB-LS to the PC using either the USB port or either of the
Serial ports. A USB cable has been provided with your MB-LS; if you need a suitable serial
cable to connect to an older PC, please contact your distributor.

Make sure that the MB-LS has paper loaded and is switched on and connected to the PC.
Run MB-Comm.

Starting MB-Comm and Connecting the MB-LS

There are two methods;
Open the MB-Comm icon from the desktop, or
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Open the Start menu, go to Programs, and click MB-Comm.

From the start-up screen menu, select Device and then Connect (either Mountbatten or
Mimic). MB-Comm will then ask you to confirm the PC COM port.

If you are using USB, click on the arrow beside the list, and you should see Mountbatten
USB Port (COMn), where n is the number the PC has given the port. Choose this port from
the list.

If you are connecting with a serial cable, you should know which port on the PC you have
connected to; choose this port from the list.

Once you have chosen the port, click OK. There will be a brief wait, and then you should
hear your MB-LS making a series of connection beeps; two short high beeps and one short
mid-tone beep, repeated several times as communication is established.

If you don't hear any tones, make sure the MB-LS is on, connected and has paper loaded; if
all this is in place, and no connection is made, contact your distributor for assistance.

Once the beeps have completed, the red buttons on the MB-Comm screen will turn from red
to green, and the status bar will say MB Connected and Embosser Connected.

You can then use any feature of MB-Comm by selecting the Menu item of choice.
Instructions are available in the MB-Comm Help menu.

Embossing a file using MB-Comm

When you have the MB-LS connected and the red buttons on the MB-Comm status bar are
green, you have several choices from the File menu:

Receive and Save file from the Mountbatten

This feature lets you examine the contents of the MB-LS memory, and transfer any file from
the MB-LS to the PC. If you have already turned Back Translation on, the file will be
translated into text as it is transferred; otherwise, the untranslated Braille file will be
transferred. See the section Back Translation: Converting Braille to Print for more
information on how to set translation up for this feature.

Display file from Mountbatten

This feature also lets you examine the contents of the MB-LS memory, but instead of
transferring the file, you have the opportunity to display the contents of the file on the MB-
Comm screen. The file will be displayed in ASCII Braille; see the Reference Section for
more information on ASCI| Braille.

Send Text File to Mountbatten

If you would like to simply transfer a file to the MB-LS, so that you can emboss it later, use
this feature; if you have embedded Forward Translation commands in the file, they will be
activated when the file is embossed.

Emboss File on Mountbatten

This will send the file to the MB-LS to be embossed; any Forward Translation commands
embedded in the file will be activated as the file is transferred. See the section Forward
Translation: Converting Print to Braille for more information on setting your file up to use
this feature.

Chat Mode
Chat mode allows you to use the MB-LS and the PC as a communication device, since
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everything typed on the PC will be Brailled on the MB-LS and everything Brailled on the MB-
LS will be translated to text on the MB-Comm screen.

You can also use Chat Mode to display what a student is doing in the classroom, and save
the contents of the screen to a file for printing. This can be very helpful when a student is
working in more than one language, since the accented characters will be displayed on the
MB-Comm screen.

See the section Braille Chat for more information on how to use this feature.
Upgrade Mountbatten Software

This feature lets you update your MB-LS via the USB port, when a new software release is
issued. Your distributor will be able to advise you.

Save Display to File
This feature lets you save the MB-Comm display screen contents to a file on the PC.
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The MB-LS as a Personal Embosser

Using the MB-LS with Braille Translation Software

If you use Duxbury or another translation program, you will need to add the MB-LS as a
printer on your Windows system, so that the program can send the translated output to the
MB for embossing.

One way is to set up your MB-LS as a Generic/Text Only printer.
To do this, follow these steps:

1. Connect your MB-LS. You should already have installed the MB-USB drivers if you
are using the USB port.

2. Open the Add Printer dialog. In XP, this is Start, Settings, Printers and Faxes, Add
New Printer.

3. Click on Next.

4. Select "Local Printer attached to this computer" and make sure "Automatically
detect my Plug and Play printer" is NOT checked.

5. Click Next.
6. Select the correct port from the drop-down list.

a) If you are using USB on both the MB-LS and the PC, select the Mountbatten
USB port from the list. If you don't see this port, make sure the MB-LS is
connected and switched on.

b) If you are using the serial port on the back of the MB-LS, connected to the PC
with a USB-to-Serial adapter from a USB port on your PC, select the correct
COM port for the adapter.

c) If you are using the serial port on the back of the MB-LS, select a free COM
port from the list.

7. Click Next.

8. From the left side of the new dialog, select Generic.

9. Now from the right side of the dialog, select Generic / Text Only.
10. Click Next.

11. Windows might now ask if you want to keep the existing driver or replace it; it's fine
to keep the existing driver. Click Next.

12. Give the printer a name; we suggest MB-LS Embosser, so you can easily
recognise it.

13. Click on "No" to the question "Do you want to use this printer as the default
printer".

14.Click Next.

15. On the next dialog, you have the opportunity to share the printer over a network, so
it can be reached by other computers.

a) If your computer is on a network, and you will always leave it switched on, and
the MB-LS connected, loaded with paper and switched on, you can click on
Share Name and give the printer a Share Name; we suggest you use "MB-LS
Embosser" again, so that it's easily
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b) If none of the above things is true, click "no

16. To the final question, "Do you want to print a Test Page", click "No".

17.Click Next.

18. Click Finish.
You now have a Windows Printer called MB-LS Embosser, which you can use with Duxbury
or any other Braille translation software.
Testing the Setup
To test your new printer setup, make sure the MB-LS is connected, and has paper loaded.
Now open Notepad and type a few words.

Click on File, Print, and select the MB-LS Embosser from the list of installed printers. Click
OK.

Your MB-LS should immediately begin producing Braille.

This Braille will not be correct, since it hasn't been translated; at this point you are only
testing that the connection works, and the printer setup you have just done sends the output
to the right place.

You now need to go to your Braille software and complete any setup needed there, to make
sure your software sends its output to the MB-LS Embosser printer, and so to the MB-LS.
Troubleshooting

If you follow all the steps carefully, and you aren't getting any Braille on the MB, but your PC
doesn't come up with an error message:

You could have the wrong communication speed.
Make sure the MB-LS is connected and switched on.
1. Go to Start, Settings, Control Panel, System.
Open the Hardware tab.
Click the Device Manager button.
You will now see a list of the different devices on your system.
Click on the + sign beside Ports (COM & LPT).

Find the port you have assigned to the printer you have just set up. If the port isn't on
the list, go to the next section.

o g bk wN

™~

Once you have found the port, click on it once to select it.

o

Now you need to look at the properties of the port. You can do this in one of two
ways:

a) right-click on the port and choose Properties;
b) From the Action menu, choose Properties.

©

Click the Port Settings tab. These are the settings you should see:
a) For a connection to the Mountbatten USB port:

Bits per second 115200

Data bits 8

Parity none
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Stop bits 1
Flow control Hardware

b) For a connection to the Mountbatten Serial Port:
Bits per second 9600

Data bits 8

Parity none
Stop bits 1

Flow control Hardware

Make sure you use the settings that suit the port you are using on the MB-LS. The USB port
will not work at 9600 bits per second, and the serial port on the back of the MB-LS will not
work at 115200 bits per second.

If you are sure that these settings are correct for the MB-LS port, and you still have no
Braille, the chances are that your USB cable, serial cable or adapter is faulty. Contact your
distributor for assistance.

If the port you selected isn’t on the list:

If you try to print to a port that isn't there, the PC doesn't give an error message, but
nothing is printed. If the port you selected for the printer isn't in the device list, cancel out of
the Device Manager. Now look at the following steps, and pick the set which suits your
setup.

For a COM (serial) port, where you are not using any USB:

Make sure that you know which serial (COM) ports you have available on your PC, and
whether they are already being used. You might need some technical help for this; contact
your distributor if you do. You need to pick a COM port which is completely free; if Windows
has it set aside for some purpose, it will not work as a printer port.

Once you have that information:
1. Make sure the MB is connected and switched on.

2. Go to Start, Settings, Printers and Faxes, and select the MB-LS Embosser you just
set up.

3. When the printer dialog appears, from the Printer menu, select Properties.

4. When the Printer Properties dialog appears, select the Ports tab. Check the correct
COM port.

5. Click OK.

6. From the Printer menu, select Properties again, and click on the Ports tab. You should
now see the printer name showing beside the port you have just chosen,

7. Click on Properties to check that the port speeds and settings are correct as per the
previous section.
For the MB-LS USB port:

Make sure the MB-USB drivers have been installed and activated correctly. See the MB-
Comm installation information for how to make sure of this.

Make sure the MB-LS is connected, switched on and loaded with paper before trying to print
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from Notepad.
For the USB-serial adapter:

Make sure that the driver for the USB-Serial adapter has been installed according to the
instructions; if they say install first without the adapter plugged in, you might need to unplug
the adapter, uninstall the driver (using Add/Remove Programs or Programs and Devices
from the Control Panel) and do a fresh install.

If none of these tips helps, please contact your distributor for assistance.

Embossing from Word, OpenOffice or Notepad with MB-Comm
You can emboss directly from Notepad, using the Text Printer setup described above.

For documents created in Microsoft Word or OpenOffice or another word processing
program with formatting, you need to perform the following steps:

Embed any commands such as {fe}, {£1it} and so on;

Save the file as Text;

Send the file to be embossed using MB-Comm.

If the file is not very large, you can open it in Notepad to check it, and then emboss directly
from Notepad; however, Notepad has restrictions on the size of the file it can open, so if your
file is large it might not be able to open it.
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Making Braille Graphics

There are two ways to make graphics - tactile images - on your MB-LS: directly from the
keyboard, or by sending an image file from a computer to be embossed.

Graphics Mode

gf enter or leave Graphics Mode. This is a toggle.

In normal Braille, or non-graphics mode, your MB-LS allows the correct amount of space
between Braille characters and between lines of Braille for reading. In Graphics Mode, these
spaces are reduced, so that it is possible to make unbroken lines of dots.

The effect of reducing the spacing between characters and lines can be seen in this
graphical example. In the first picture of a flag, the line-spacing means that the picture has
gaps which will make it more difficult to identify. The second picture has had the gaps
reduced, and the line of the flagpole is now continuous, while the edges of the flag have
smaller gaps.

lllustration 17: Comparison of normal spacing and Graphics
Mode spacing

Graphics from the Keyboard

As soon as your MB-LS is in Graphics Mode, typing at the keyboard can produce an image.
The simplest example is a rectangle:

This rectangle can be made by typing the following three lines:
pPccccecec th
1l space space space space space space dots 4 5 6

v - - - - - - number sign

To make this graphic from the PC keyboard, you will have to type the corresponding ASCII or
Grade Zero characters. For more information on ASCII Braille, see the section Braille Grades
in the Reference Section.

For the rectangle, the PC keyboard keystrokes are:
pcccccc?

1 space space space space space space _
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Embossing Graphics from the Computer

Because your MB-LS can act as an embosser, or Braille Printer, when connected to your
computer, it can also act as a Graphical Embosser. You can use the MB-LS with a Tactile
Graphics program, or you can use MB-Comm to send already-prepared graphics for
embossing.

For information about compatible Tactile Graphics software, contact your distributor.
For a collection of ready-prepared graphics files, please visit us at
www.mountbattenbrailler.com.

When you want to emboss a ready-prepared graphic, don't forget to embed the command in
the file to turn graphics on:

{gf}
and again at the bottom of the file:

{gf}
to turn graphics off again.

Although you can enter these commands at the MB-LS or PC keyboard, it's a good idea to
embed the two commands in each and every graphic file you prepare or use, so they will
always be ready for use.
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Clock, Calendar and Diary

Your MB-LS has an internal clock, which you can use to tell the time and set alarms; you can
also use it as a stopwatch and a count-down timer.

The MB-LS internal clock includes a calendar, which lets you set and check the date.

The internal clock and calendar work together to let you keep an appointment diary, with
reminders when an appointment or task is due.

To use the Clock and Calendar and Diary, you must be in Advanced Mode. These features
are all accessed through the Options Menu using o-chord.

You must also be using Synthesised Speech; if you are in Advanced Mode with Recorded
Speech selected, pressing o-chord will cause your MB-LS to say "Error".

Setting the Time and Date

When you first receive your MB-LS, the time and date will not be correct, so you need to set
them before you start using the clock and calendar features.

Remember to use lower numbers when you are entering the time and date; see the section
Braille Codes and Languages for more information on using dropped or lower numbers

o-chord st Setthe time

After o-chord, write s followed immediately by t. There are no spaces in this command.
The MB-LS will then ask you to "Enter time hhmm" where h is hour and m is minutes.

If you make a mistake, you can backspace over it, or use a b-chord, and correct the error.
You must always write the time in four digits e.g. 7:00am is 0700.

Once a valid time is entered, the MB-LS will ask "Enter ‘a’ or ‘p’ for a.m. or p.m." It will then
speak the time.

o-chord sd Setthe date

After o-chord, write s followed immediately by 4, without any spaces. The MB-LS says
"enter date, mm/dd/yy." Write the date using two digits for month, two digits for day and two
digits for year, using only dropped or lower numbers and no spaces. Dates containing the
years numbered 89 to 99 are assumed to be from 1989 through 1999. Dates 00 to 88 are
assumed to be from 2000 through 2088.

Now that you have the time and date set correctly, you can check them at any time when you
are in Advanced Mode.

Checking the time

o-chord t  Speak Current Time

More Clock Settings

o-chord st Change the time
After o-chord write s followed immediately by t, without any spaces.

Answer the prompt with a plus or minus followed by a four-digit number that represents how
many hours and minutes backward or forward you want to go.

o-chord s1 Choose a twelve hour clock
o-chord s2 Choose a twenty-four hour clock
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After the o-chord write an s followed by the number 1 or 2 as a dropped or lower number,
without any spaces.

Hourly Time Announcements

The MB-LS can alert you by either speaking or playing a tune every hour, on the hour. First
go into the Status Menu:

space + dots 3,4 Enter status menu
Then go into the Hourly Announcement Options:

h-chord Hourly announcement mode options
Press space to cycle through the options for the hourly announcement:

- off
bell only
voice only
bell and voice
The last option spoken will be the one selected when you exit.

e-chord Accept any changes and exit the status menu.
z-chord Exit the status menu, without accepting changes.
Alarm

The alarm can be set for a date and time in the future. The alarm tune will play for
approximately one minute. You can stop it by pressing z-chord.
o-chord sa To setthe alarm

The MB-LS says “set” after ‘s’, then “enter alarm time hhmm?” after ‘a’ is entered. After you
enter the time, the MB-LS says “enter ‘a’ for am or ‘p’ for pm.” Once you have done that, the
MB-LS says “enter alarm date, mmddyy". When the alarm setting is complete, the MB-LS wiill
announce the time and date at which the alarm is set.

o-chord y  Check alarm settings

z-chord Silence an Alarm

Use z-chord while the alarm is ringing. It will stop and cancel the alarm and return you to
your operation.

Stopwatch and Countdown Timer

This part of the MB-LS Clock lets you count time down, for completing an activity in a set
amount of time, or let you count time up, to find out how long something takes to do.

The stopwatch and countdown timer are both accessed directly from the Options Menu using
the same chord command; once you are in the Stopwatch, you can choose to use the timer
or the stopwatch.

o-chord w Enter the Stopwatch. The MB-LS will announce: “Stopwatch ready’.
dots 3,4,5,6 Enterthe countdown timer.
z-chord Exit the Stopwatch or Countdown Timer.

Stopwatch

Once you have pressed o-chord w to enter the stopwatch, to start the stopwatch itself,
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press dot 6. Let a little time go by and then press space. Your MB-LS will speak the
elapsed time in seconds. Each time you press space, you will hear that some more time has
elapsed. Press dot 6 once more to stop the timer, and your MB-LS will speak the elapsed
time once more. To hear the elapsed time again, press space. To set the stopwatch back to
zero, press dot 3.

dot 6 Start or stop the stopwatch
space Read elapsed time
dot 3 Reset the timer

Countdown Timer

The countdown timer is also in the stopwatch. Press o-chord w to enter the stopwatch, and
use dots 3,4,5, 6 to begin the countdown timer.

Before you start the countdown timer, you will be asked to enter the number of minutes and
seconds you want to count down.

[minutes] e-chord Enter the number of minutes, using dropped numbers, and
press e-chord to complete.
[seconds] e-chord Enter the number of seconds, using dropped numbers, and

press e-chord to complete. If you don't want to add any seconds, press
e-chord without entering any seconds.

e-chord Exit the countdown timer, but keep the timer running in the background.

If you exit the timer, you can do other activities on the MB-LS while the timer is counting
down. When the desired countdown time is reached the MB-LS will indicate this by playing a
brief tune. This way, you can time activities where speed is a desired goal.

o-chord dots 3,4,5,6 Check the remaining time while the timer is running in the
background.
When there is 1 minute of the time remaining, the MB-LS will say "one minute".

z-chord Exit either the stopwatch or the countdown timer.
Calendar

Checking the Date

o-chord d  Speak the current date
If the date announced is not correct, you will need to set today’s date:

o-chord sd Setthe date

After o-chord, write s followed immediately by d, without any spaces. The MB-LS says
"enter date, mmddyy." Write the date using only dropped numbers and no spaces. Dates
containing the years numbered 89 to 99 are assumed to be from 1989 through 1999. Dates
00 to 88 are assumed to be from 2000 through 2088.

Using the Calendar

o-chord g Check a date

You will then be prompted to enter a number of days or a date in the format mmddyyyy,
where ‘m’ is a two-digit month, ‘d’ is a two-digit day, and ‘y’ is a 4-digit year. Enter the date in
dropped or lower numbers with no spaces.

If you enter a number of days, say 100, then press e-chord, the MB-LS will tell you what
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date is 100 days ahead of your current date. Use a negative number to check on a previous
date. If you enter a date, then press e-chord the MB-LS will tell you which day of the week
it falls on.

The Diary

The Diary lets you record, review and edit appointments. Once appointments are recorded,
they are saved in a permanent file in memory called ‘Diary’.

To access the diary feature, the MB-LS must be in Advanced mode with synthesised speech
activated. The diary feature is not available using Recorded Speech.

As with all the Clock-related functions on your MB-LS, when numbers are used in chorded
commands they must be dropped or lower numbers.

Creating Diary Entries

o-chord 4  Speak the current date
If the date announced is not correct, you will need to set today’s date:

o-chord sd Setthe date

After o-chord, write s followed immediately by d, without any spaces. The MB-LS says
"enter date, mmddyy." Write the date using only dropped numbers and no spaces. Dates
containing the years numbered 89 to 99 are assumed to be from 1989 through 1999. Dates
00 to 88 are assumed to be from 2000 through 2088.

Once your MB-LS is set to the correct date, you can go ahead and enter an appointment.

o-chord-e  Enter an appointment into the Diary.
This will open the diary and prompt you for appointment details.

The first prompt is “number of days or a date mm/dd/yyyy”.

Option 1: Enter a number of days

You can put in a number of days from today’s date that the appointment is away. For
instance, if today is Wednesday 24 February, and your appointment is for next Wednesday, it
might be easier to simply enter the number 7. The MB-LS will count ahead seven days and
use that date in which to insert your appointment.

Option 2: Enter a date

To enter a date for your appointment, type in the date just as you did when you set the date:
two digits for month, two digits for day and two digits for year, using dropped or lower
numbers and no spaces. Then press e-chord to complete.

You will then be prompted to enter a time as a 4 digit number, hhmm. Enter the time just as
you did when setting the time, using two digits for the hour and two digits for the minutes,
using only dropped or lower numbers and no spaces, then press e-chord to complete. You
will then be prompted to choose am or pm; type a for am or p for pm. Then press e-
chord to complete.

You will then be prompted to enter information about your appointment. Simply type the
description or any other information relevant to the appointment. Then press e-chord once
more to finalise the diary entry.

To check whether you have any appointments today, use the following command:

o-chord a  Check diary for today’s appointments
You can open the Diary file in the Editor using the command edit diary. The filename
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diary is all in lower case. Once the file is open in the Editor, you can use the following
special commands to work with the Diary file:

g-chord Find a date in the Diary File

newline+q  Exit the Editor

If you have made changes to the diary file while you are in the Editor, the MB-LS will prompt
you to save your file. Press y for yes or n for no. If you press y, the MB-LS will say “File
exists. Overwrite, yes or no”. Enter y to overwrite the existing Diary, or n to exit the Editor
without overwriting the existing Diary.

Setting a diary alarm

You have the option of setting an alarm for any of your appointments. You cannot do this
while you are editing the Diary file.

o-chord sa Seta diary alarm
o-chord y  Check the alarm setting.

Checking your Diary
To help you check your Diary each day, there is a setting in the Status Menu:

space + dots 3,4 Enter the Status Menu
J Turn the Diary check on

Once the Diary Check is turned on, when you turn the MB-LS on each day, it will check for
any Diary entries you have for that day. If you already have Diary entries the MB-LS will ask
if you want to open them so you can check the contents. The default status for Diary Check
is off.

e-chord Accept any changes and exit the status menu.
z-chord Exit the status menu, without accepting changes.

Clock, Calendar and Diary Status Menu

Use the Status Menu to change some Clock, Calendar and Diary settings. To enter the
Status Menu, press space+dots 3, 4. Your MB-LS will say "status menu".

Once you are in the Status Menu, you have the following options:

h-chord Hourly announcement mode options
Press space to cycle through the options for the hourly announcement:

off
bell only
« voice only
bell and voice
The last option spoken will be the one selected when you exit.

J Turn the Diary check on

Once the Diary Check is turned on, when you turn the MB-LS on each day, it will check for
any Diary entries you have for that day. If you already have Diary entries the MB-LS will ask
if you want to open them so you can check the contents. The default status for Diary Check
is off.

e—-chord Accept any changes and exit the status menu.
z-chord Exit the status menu, without accepting changes.
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The Calculator

You have two levels of calculator available to you: Simple and Scientific. The Scientific
Calculator includes all of the arithmetic and simple operations available in the Simple
Calculator, so you can choose which you would like to use.

To enter the calculator function in your MB-LS you need to go first to the Options Menu. To
reach the Options Menu the MB-LS must be in Advanced Mode, with Synthesised Speech
selected. If you try to enter the Options Menu from Learn Mode, your MB-LS will say "Error".

The Options Menu

Your MB-LS, in Advanced Mode, uses a menu called the Options Menu to give you access to
several features such as the Calculator, the Clock, Calendar and Diary and two of the three
functions of Braille Music.

Beside the commands to enter each of these features, there is a special command to help
new learners come to grips with the Nemeth mathematical code:

o-chord n Set Nemeth Mode. When this is set, all Nemeth numbers used will be

spoken as numbers instead of as "low a", "low b" and so on, and all Nemeth
operators will be spoken instead of their literary Braille equivalents. To switch
Nemeth Mode off and regain access the Options Menu, press z-chord.

Nemeth Mode is not a calculator; it is a Mode you can use to enter Mathematics in Nemeth
code and hear the correct spoken response. While you are in Nemeth Mode, the Options
Menu is unavailable; once you exit Nemeth Mode, you can use any of the Options in the
Menu.

To use the Scientific Calculator:

Enter o-chord, which is space + dots 1,3,5, and the MB-LS will say "options". Then
type ¢ and you will hear "Calculator ready".

To use the Simple Calculator:

Enter o-chord, space + dots 1,3,5, and the MB-LS will say "options". Then type m and
you will hear "Simple Maths Ready".

Once you are in either calculator function, you stay in there until you are finished. Then you
need to exit to return to normal Brailling or another function.

To exit either Calculator:

Exit either calculator by entering z-chord (dots 1, 3,5, 6 and space together).

Using the Calculator

Basic Operations

When you are entering equations into the calculator, it expects you to type the operators
(such as plus, minus and so on) in Nemeth Braille, except in the United Kingdom English-
language MB-LS, where British Mathematical Braille is used.

For numbers, you have the choice of using either standard Braille numbers (number sign
and letters from a to j), or the lower numbers with no number sign.
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The following table shows the Braille to be used for the operators:

Nemeth Braille

Function Operator

Addition + o dots 3,4,6

Subtraction - o dots 3,6

Multiplication * ° dots 1,6

Division / 2l Dots 4,6 dots 3,4

Percent % s dot 4 dots 3,5,6

Square root N, JERT dots 3,4,5 number dots 1,2,4,5,6

dots 1,4,5,6 number dots 3,4 number dots

. . 3,4,5,6
Simple fraction

:enumber.:number ¢ — with no spaces between elements.

dots 3,4,5,6 number dots 4,5,6 dots 1,4,5,6
number dots 3,4 number dots 4,5,6 dots 3,4,5,6
Mixed fraction

<snumber ¢ ¢ number ;- number :$ ;¢ — no space between
elements.
Decimal point X dots 46
Left parenthesis ( s dots 1,2,3,5,6
Right parenthesis ) s dots 2,3,4,5,6
Comma : . dot 6
British Beraille
Function Operator
Addition + e dots 5,6 dots 2,3,5
Subtraction - . . dots 5,6 dots 3,6
Multiplication * dots 5,6 dots 2,3,6
Division / : :: dots 5,6 dots 2,5,6
Decimal point . .fi . dot 2
Left parenthesis ( :; dots 1,2,6
Right parenthesis ) 3 dots 3,4,5
Comma o dot 3

Getting Started

Write a simple maths expression, including all appropriate operation symbols (like a plus
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sign, for example) and end the expression with an e-chord.
Never include spaces in a computation, as you might do when writing one out on a piece of
paper.

If you are using an MB-LS with Nemeth Braille, for instance in the USA or Canada, use only
the "dropped" numbers, or lower numbers, to calculate. If you are using a British English MB-
LS, standard numbering with the Number sign and the letters a to j can be used as well as
the lower numbers.

See Braille Codes and Languages for information on using dropped or lower numbers.
Example:
Write 242 followed by an e-chord. The MB-LS responds "4".

To do another calculation, you do not always have to clear the calculator. The MB-LS
assumes that you're starting a new computation when you enter a number after pressing an
e-chord for a result.

Note: If you are using negative numbers, clear the calculator between each calculation.
Example:

Write 375-157 followed by an e-chord.

The MB-LS responds, "218."

To be absolutely sure that the calculator is cleared for another calculation, press a 0-chord,
space + dots 3,5, 6, and the MB-LS will say "clear".

Example in Nemeth Braille:
To calculate one and a half plus two-thirds, 1%z + %3, enter

Setting the Precision level

The precision level refers to the number of significant digits past the decimal point used in a
calculation. The default precision level is 2, and it will return results with two decimal places.
If more than two decimal places are entered in the calculation, the result will be rounded and
the result will have the number of decimal places of the precision level, unless there are
zeroes at the end of the result, which aren't spoken.

p-chord Set the precision level

The MB-LS will prompt you to set the desired precision level, which must be a number from
0 to 6.

Setting the Number of Decimal Places

Press p-chord [number] e-chord, where [number] is the number of decimal places
you want. The least number is zero, for whole numbers only; the highest number is 6.
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Embossing Calculation Results

Enter t-chord to emboss the calculation and its result; see the table below for more
information.

Calculations in the Editor

If you are writing calculations in a file for which you need the results, you do not have to write
them over again from within calculator mode. Go to a new line in your currently open file with
a hard carriage return by pressing newline. Then write the calculation that you want in your
file and which you want the calculator to compute. Make sure you use the right expressions,
operators and number format for your Calculator; this will be different, for instance, between
a UK English MB-LS and a USA English MB-LS. And, by the way, here you can use spaces,
so that the final Braille will be readable.

Now press an o-chord followed by a k to hear the result of the computation. While the
answer is not automatically inserted into your file at the end of your written expression, you
can certainly add it to the end of the expression by writing an equals sign and then pressing
o-chord i to paste the calculator's answer into your file.

Performing Percentage Calculations

Enter the calculator with o-chord m or o-chord ¢, whichever you prefer. To determine
percentages, first write the value of the percentage, then write the percent sign, and finally,
the number whose percentage you want to calculate. Finish the computation with an e-
chord.

Example:
To find 50 percent of 26, write 50 $ 26 , remembering not to put spaces in between each
part of the expression. The Braille for this is

Finish with e-chord, and the MB-LS responds, “13.”

Calculating a Square Root

To extract the square root of a number, write the number whose square root you want, then
press dots 3,4,5-chord. This will evaluate and give you the answer - you don't need to
press anything else.

So to extract the square root of 25, write 25 followed by dots 3,4 ,5-chord. The MB-LS
responds "5."

Storing your results and using Memory Locations

The MB-LS calculator has 26 memory locations where you can store results of
computations. These memory locations are labelled from A through Z. One special memory
location, R, always stores your last result. All the others store and save the results, even
after you exit the calculator mode and turn off the MB-LS.

There are two ways to store a number in a memory location:

Write an arithmetic expression and press e-chord to compute its result. Then press
s-chord. The MB-LS will say “store.” Write the letter of the memory location where
you want to store it, for example, a. The MB-LS confirms, “Okay.”
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Start with a cleared calculator memory and simply write a number followed by an e-
chord. Then press an s-chord followed by the letter of the memory location where
you want it stored.

To read the contents of a memory location, simply write the letter of that location followed by
an e-chord. If you have stored a number in a memory location, you can use the number
within a calculation. Write the letter of the memory location where you stored the number as
part of the expression to be calculated.

Examples:

Write 3 - 2 followed by an e-chord. Your MB-LS will say "1". Now press s-chord a to
store the result in memory location a.

Now write 3 - 1 followed by an e-chord. When your MB-LS says "2", press an s-chord
b to store this result in memory location b.

Now there are numbers stored in memory locations a and b, and you can perform
calculations on these numbers by using their locations.

To test this, write a+b followed by an e-chord. The MB-LS looks up the number stored in
each memory location and does the calculation. You will hear the result "3".

r is a special memory location. The most recent result you got from pressing an e-chord is
always stored in r. You can use the number stored in r just as you use the other memory
locations labelled a to =z.

Error Messages and Tips

If you set the calculator an impossible task, such as dividing 17 by 0, the MB-LS rejects the
expression saying "Not valid math expression." You can use the backspace key to make
corrections.

If you use an incorrect chord for an e-chord, the MB-LS says “Error”, but your calculation
hasn't been lost; press e-chord correctly and you will get a result.

Calculator Commands

e-chord Execute the calculation or speak the current result. Use this
keystroke after you have entered your equation, to complete
the equation and hear the result spoken. You can press 3-
chord again to have the result spoken again, as many times as
you need, until the next calculation is entered or the calculator
is cleared.

c-chord Speak the current line. Use this before you evaluate the
calculation to check that you have entered it correctly, or after
evaluation to check what has been evaluated. This command
only speaks the keystrokes you have made; to hear the result,
use e-chord. You can repeat this command as many times as
you need, until the next calculation is entered or the calculator
is cleared.

t-chord Emboss the current equation. This command will emboss the
entire equation; what you have typed, the equals sign and the
result. The equation and the result stay in the memory, so after
embossing it's still possible to use e-chord or c-chord to hear
the result or the calculation.
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O0-chord Clear the Calculator. This command clears the Calculator
dots 3,5,6-chord memory, so all previous calculations will be completely gone.

also called This command also clears all stored variables, so it is useful to
zero-chord make sure no old variables are still in the memory.
f-chord Speak numbers as digits or words. This is a toggle. The default

setting is "say full numbers", which means that numbers will be
spoken as words. F-chord will change between this and "say

digits".
p-chord Set precision level. The precision level refers to the number of
followed by a digit significant digits past the decimal point used in a calculation.
from O - 6, then The default precision level is 2, and it will return results with
e-chord two decimal places. If more than two decimal places are

entered in the calculation, the result will be rounded.

s-chord Store the current result in memory at a location with the name

followed by any letter  of the letter chosen. The memory location r is reserved for

from a to z except r storing the current result; use any other letter of the alphabet
from a to z.

dots 3,4,6-chord Use this to change the sign of the result to positive.
also known as plus-

chord

dots 3,6-chord Use this to change the sign of the result to negative.

also known as minus-

chord

o-chord k Calculates the expression on the current line of the currently
open file in the Editor. Use this keystroke while you are in the
Editor to calculate an expression that is in the current line of
your open file.

o-chord i Insert the result of the current calculation into the Editor. After
you have used o-chord k, use o-chord i to insert the
result into your document at the cursor position.

d-chord Set the argument of commands as degrees

r-chord Set the argument of commands as radians

Complex Functions

In the Scientific Calculator (o-chord c to open) has many built-in functions, including
algebraic, trigonometric, and statistical functions.

Each function has an abbreviated name, for instance sin for the sine function. Arguments
are entered in parentheses, and separated by commas. In this discussion, we'll assume
you're familiar with the terms "function" and “argument”.

Function names are written in computer Braille, with their arguments enclosed in
parentheses and separated by commas.

Arguments in the US calculator must be entered in computer Braille, using dropped
numbers, and the computer Braille symbol for comma, dot 6. Arguments in the UK
calculator are entered according to British mathematical Braille, with dot 3 used as the
comma and a number sign before each new number which has been preceded by a comma.

The expressions "arg1 “, “arg2", etc. refer to the arguments, which can be numbers or other
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mathematical expressions, to be placed within the parentheses.
Examples

Find the average of three numbers.

From within calculator mode, write avg (3,5, 7) and press e-chord.

For the US or Australian calculator, remember to write in dropped number notation and to
write the parentheses in computer Braille:

For the UK calculator, write

The MB-LS will respond "5."

Calculate the sine of 90 degrees or pi/2 radians.

Write sin(90) followed by e-chord. You should hear the correct answer, "1."
For the US or Australian calculator:

For the UK calculator:

Since the calculator's angle setting default is degrees, this function will work as you expect.
To switch to radians, press r-chord. The MB-LS says, "Radians." Now write sin(pi/2) and
press e-chord. You also get a response of "1" since the calculator computed pi/2 and then its
sine in radians. To get back to degrees, press a d-chord.

or for the UK calculator:

Calculate the value of e?

First reset precision to something like 5 to get a better computation. Press p-chord and at the
prompt, "Set precision", write a 5 followed by an e-chord. Now write exp(1) followed by an e-
chord. MB-LS will say "2.71828."

or for the UK calculator:

Calculate the median of a group of numbers.
Write median(5,6,7,8) followed by e-chord. The MB-LS answers "6.5”.

or in the UK calculator
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abs(arg)

Scientific Calculator Command Summary

Absolute value of argument

avg(arg list)

Averages numbers in argument list

max(arg list)

Computes largest number within argument list

min(arg list)

Computes smallest number within argument list

mod(arg1, arg2)

Computes remainder of dividing argument 1 by
argument 2

sum(arg1, arg2,arg3...)

Totals number is argument list

sqrt(arg) Computes square root of argument.

, Constant - computes value of pi to precision level set
pi (e.g., 3.14159)
d-chord Degrees Mode
r-chord Radians Mode
tan(arg) tangent of argument
cot(arg) cotangent of argument
atan(arg) Arctangent of argument
sin(arg) Sine of argument
asin(arg) Arcsine of argument
cos(arg) Cosine of argument
acos(arg) Arc-cosine of argument
log(arg) Log to the base 10 of argument
alog(arg) Antilog base 10 of argument (i.e. 10arg) (where

glarg argument is exponent to which 10 is raised).
exp(arg) Computes e to the power specified by argument (e.g.
plarg exp(2) computes e squared).
In(arg) Log to the base e (natural log) or argument
Antilog base e of argument (i.e. earg).
aln(arg) The argument is the exponent to which e is raised; e.g.,
aln(1) computes to e itself.
round(arg) Integer part of argument (rounds up if decimal exceeds .
9 5, down if decimal is less than .5).

trunc(arg) Integer part of argument (regardless of decimal part)

div(arg1, arg2)

Integer division of argument 1 by argument 2.

stddev(arg list)

Standard deviation of argument list.

median(arg list)

Median number of numbers in argument list.

faren(arg) Converts argument to Fahrenheit temperature
centi(arg) Converts argument to Centigrade temperature
in(arg) Converts centimeters argument to inches
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cm(arg)

Converts inch argument to centimeters

I(arg) Converts gallon argument to liters.
gal(arg) Converts liter argument to gallons.
kg(arg) Converts pound argument to kilograms,
Ib(arg) Converts kilogram argument to pounds.
g(arg) Converts ounce argument to grams
oz(arg) Converts gram argument to ounces, ,

pow(arg1, arg2)

Raise argument 1 to the power argument 2

root(arg1, arg2)

Compute the argument 2 root of argument 1

recip(arg)

Reciprocal of argument

fact(arg)

Factorial of argument
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The Editor

The Editor in your MB-LS is a word processor for Braille, so that you can create and open a
file, type Braille into it, edit your Braille, and save the file so it can be embossed at any time.

You have 64 kilobytes of memory available to you for a file; this is equivalent to
approximately 180 pages of Braille.

Once you have opened a file in the Editor, you can enter, insert, and delete Braille within
your file. You can also search for and replace text, and you can copy, move and paste the
text you choose.

Getting Started

You open a file in the editor with the command edit. You can use this command in two
ways:

edit Open a new blank file in the Editor. This file will receive its name when
you save it.
edit [filename] Open a file in the Editor. [filename] can refer to the name

of a file you already have on the MB-LS, or it can refer to the name of a
new blank file you want to start.

If the filename is new, then the MB-LS will say "“file not found, creating new file" and then
speak the filename.

If no filename is given, then the editor is made active but the file will have no filenameYou will
be prompted for a flename when exiting or saving.

As soon as you have the file open you can begin typing. Braille some words into your newly
opened file, and then you can experiment with all the options available to you.

Some Things To Remember About Files and File Names

If you switch off without saving your work, you will lose it! So save early and save often.

An MB-LS filename can be up to 22 characters long.

An MB-LS filename cannot start with a number, and it cannot include any spaces or
punctuation.

The one exception to the no-punctuation rule for filenames is this: you can have one (1)
period, entered as dots 4, 6, in the file between the main name of the file and an optional
three-character extension. Some three-character extensions you will come across are .bmf
for a Braille Music File, and .br£ for a Braille file.

Although you can use Grade 2 Braille in a filename, we recommend that you use Grade 1
Braille, so that you don't have any trouble locating the correct file. A file called test has a 4-
character filename in Grade 1 and a 3-character filename in Grade 2, and so you can have
two files called test, which might cause difficulty when you come to re-edit the file.

Exiting the Editor

newline+q  Exit the editor and return to normal MB-LS operation.

When you exit, the MB-LS will say: "Save file first, yes or no?". Answering y will save your
work, and leave the Editor. Answering n will not save any data before you exit.

If you haven't given a filename when you opened the file, the Editor will ask for a filename
when you exit.
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Getting Help

newline+h

Activate the Editor Help Menu.

The MB will say "Entering Help mode", and you can now step through all the available

options using tab and backtab.

At each step the MB-LS will tell you the function and the key to press to activate that
function. When you first enter the Help Menu, if you press tab the first item spoken is "speak
previous character, chord-dot 3". This means that you use space + dot 3 to speak the
character to the left of your current position, without moving the cursor.

backtab steps through the Help Menu in the opposite direction, so that if you want to step
backward to an item you have already heard, you can do that quickly.

Use e-chord to leave the Help Menu.

Moving Around and Reading in A File

space + dot 3

move to previous character and speakK i

space + dot 2

move to previous word and speak it

space + dot 1

move to previous line and speak it

Moving to the lefi:
space plus the key for the distance you want to move

U '@'o 00@ 9

word

Moving to the right:
space plus the key for the distance you want to move

U UUUO ‘@‘ 3

lllustration 19: Moving right in the Editor

lllustration 18: Moving left in the Editor

space + dot 6

move to next character and speak it
space + dot 5

move to next word and speak it
space + dot 4

move to the next line and speak it

space + dots 13- move cursor to top of previous page

space + dots
space + dots

space + dots

space + dots

123 - move cursor to start of file
46 - move cursor to top of next page

456 - move cursor to end of file.
36

speak the current character

space + dots 25

speak the current word

space + dots 14

speak the current line

Speak current: space plus both directions

current character

U @UUO 00@ 3

lllustration 20: Speaking without moving in the Editor
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Editor Commands

While you are writing and editing, you will need commands to do everything besides the
actual writing.

First we cover the commands, and then we look at what's available in the Editor Menus.

t-chord Tab. If you press t-chord, you will insert a tab at the cursor position in
your music file.
p-chord Hard page break. Pressing p-chord forces a new page at the cursor

position in your file.
newline+i  Change between insert and overwrite mode.

When you are in insert mode, you can move the cursor to any place in your text position and
write, and the text will be inserted into any existing text, pushing the following text along to
make space. If you are in Overwrite mode, then any existing text will be written over by text
that you enter.

newline+c  Change the case of text.
Text can be stored in upper case, lower case, or with no case conversion. Letters entered via
the Braille keyboard are normally treated as upper case, unless changed by this option.

No case conversion, is useful if using a PC keyboard for input and you do not want case
conversion to be carried out by the MB-LS. In this instance the Shift or CapsLock key on the
PC keyboard would be used for entering upper and lower case.

newline+w Where Am 1?

When you press newline+w, your MB-LS will speak the name of the file and your current
position in the file, given as page number, line number and column number. If you are in a
menu then you will hear the name of the menu.

space + dots 1,2,3,4,5,6 Delete

Use this keystroke to delete the character immediately under the cursor. It can be used at
any time while writing in the Editor.

r-chord Speak the rest of the file, from the cursor position to the end, without
moving the cursor
z-chord Silence Command. This command can be used at any time to stop
speech.
Using the Keyboard

The following MB keys work a little differently in the Editor:
newline newline is treated as a hard carriage return.

backspace backspace is a destructive backspace; this means it will delete the
character immediately before the cursor.

command command Wwill cancel any operation currently in progress, such as a search
and replace.
enter enter has no meaning or function when using the Editor.

The Editor Menus

The Editor has a range of commands, grouped into 5 separate menus according to the kinds
of tasks. The Menus are:

File Menu for all the tasks to do with files; open, save, directory listing, renaming and
SO on.
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Search Menu for all search and replace tasks.
Block Menu for selecting, copying, moving, or deleting sections of text.
Delete Menu for deleting or restoring characters, words, lines or pages.
Edit Menu for extra editing functions.

You enter each menu by pressing newline plus the letter denoting that menu:
newline+f File Menu
newline+e  Edit Menu
newline+b Block Menu
newline+d Delete Menu
newline+s  Search Menu

Once you are in a menu, you can step through the available options with tab and backtab.
Each time you step through the menu, an item will be spoken, followed by the keystroke to
activate that item. Press the keystroke for the feature you want, or press e-chord to exit the
menu and return to your file.

Note: If you are asked for an answer to a Yes or No question then you only need to enter Y
or N - you don't need to write the whole word.
Leaving the Editor Menus
e-chord When you have finished using the Menus, e-chord is used to leave the
menu and return to your file.
File Menu

Use the File Menu for all the file operations.
newline+f  Entering the File Menu: The File menu has the following options:

o Open an existing file in the Editor. You will then be asked to enter the
filename. Type the filename and press e-chord to finish.

r Rename the file. This command changes the name of the file that is open
in the Editor.

c Clear work-space. This command empties the open document.

If the current Editor file has been changed and not saved then you will be asked if you wish
to save this file before clearing the work space.

d Directory listing.

The directory listing announces the names of files, and you can step through them one by
one. Once you have entered the d command you are placed at the top of the file listing with
the following supplementary commands available:

a Speak the previous filename in the file listing. Moves the file cursor up.

c Speak the current filename in the file listing.

dot 4  Speak the next filename in the file listing. Moves the file cursor down.
o Open afile, at the current "file cursor" position, into the editor.

If there is an existing file, still in the Editor, that has not yet been saved, then you
will be asked if you wish to save the existing file before reading in the next file.

d Delete the file at the current "file cursor” position in the directory listing.
f Speak the remaining space in the editor.
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P Protect or un-protect the file you have open in the Editor. This is a toggle
command, and the default status is off.

If you protect a file, if you then try to enter any characters in the document, either in insert or
overwrite mode, the MB-LS will say "File Protected" and your characters will not be added to
the file.

£ Re-format the file. This causes all line lengths to be evened up and the
contents of the file to be made to fit tidily between the margins.

Although this is done automatically when the file is saved or when text is moved around,
there may be a time when you would like the file to be reformatted (perhaps before listening
to a final version).

s Save the current Editor file.

When you use this command, the file you are working on is first reformatted to fit within the
current margins, and then saved. However, the following conditions apply:

If no filename has yet been assigned to this file, then you are asked to enter one.

If the file already exists then you are asked if you want to overwrite it or not. If you
answer N then you are returned to the Editor.

If there is not enough room in memory to save the whole file you will be asked if you
wish to save the file regardless, in which case it will be cut short to fit. Answering n will
return you to the Editor.

If necessary, to make more room, exit the Editor and use the normal MB commands
to clear out any old files. Then enter and re-save the Editor file.

e-chord Exit the Menu.

Edit Menu

The Edit Menu has commands for finding out how much space is left in the Editor, the size of
the file you are working on, or to find a page number in your file.

You can also use this menu to enter MB commands into your document, for things such as
formatting the Braille output, or changing the Braille Grade.

newline+e  Enter the Edit Menu:
Once you have entered the Edit Menu you can use tab and backtab to step through the
menu items:

s Gives the size of the file you are working on.

r Gives you the amount of remaining space available to your file.

The size of the file, s and the amount of remaining space, r, add up to 64 kilobytes; this is
the size limit for a single file. If you think your document will be larger than this, it could be a
good idea to split it into parts.

w Where Am 1? Your MB-LS will speak the current page number, then the
line number, and then the column number of the cursor position.
f Form New Paragraphs.

This command can be used to join broken lines, which can happen if a file sent from a
computer has different margin settings to the MB. All existing paragraph formatting is
maintained.

j Join Current And Next Paragraph. This command can only be entered on
the last line of the current paragraph.
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d Delete all the hard page breaks in the document.
g Go to a selected page number. Your MB-LS will say “Enter page number”.

Enter the page number in text or Braille format. The number must be followed by newline.
If the page number is valid, the editor cursor is moved to the first character of the page
number requestedIf the number entered is greater than the number of pages in the file, the
message “Invalid input” is given.

c Enter MB-LS Command.

If you want to enter a normal MB command (e.g. for formatting) in your file, you need to use
this command. When you press C, the MB will say “Enter MB Command”. Simply enter the
command as you would normally and then press the “Newline” key to terminate the
command. Do not press the “Enter” key as it has no meaning within the editor. After pressing
“‘Newline” the MB will say “Please Wait” and then “Finished” when the command has been
inserted.

t Take away MB-LS command.

To delete a command from your document, position the cursor on top of the command, enter
the Edit Menu and then press T . The MB will say “Please Wait” and then “Finished”, when
the command has been deleted. If the cursor is not on a command then the instruction is
ignored and the message “Command Not Found” is given.

space + e  Exit the Menu.

Block Menu
The block menu is used to move sections of text around the editor.

A block is any amount of text, from a single character to the entire file. To tell the Editor that a
piece of text is a block, you place a marker at the beginning and another marker at the end,
using this menu.

You can then copy, move or delete your block of text.

These features are also known as cutting, copying and pasting. Cutting and Pasting is the
same as moving a block of text; copying and pasting is the same as copying a block of text.

The maximum size of the block is 1200 characters if the block is to be copied or moved.
When deleting a block, size does not matter

newline+b  Enter the Block Menu: You have the following options:
b Place a "begin" marker at the start of a block of text.

Before using this marker, move your cursor to the first character to be included in the block.
Check that you have the right place by pressing the "speak current character" keystroke,
space + dots 3,6. Then press b. The MB-LS will say “Block Begin”.

e Place the "end" marker at the end of a block of text.

First move your cursor to the first character after the text to be included in the block, and
then press e. The MB-LS will say “Block End”.

Now that you have a block marked, you can use any of the following commands from the
Block Menu to manipulate the text:

c Copy the block to a new cursor position.

The block can be copied or moved to any cursor position, other than within the block area
itself, and will be inserted immediately before the current cursor position.

m Move the block to a new cursor position.
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The block markers are not deleted when a move command is given, so you can move the
block to another position if you realise you have moved it to the wrong position.

P Paste the block to a new cursor position.

Paste copies any information in the clipboard to the current cursor position, and the block
markers are retained so you can paste the block again if you wish.

s Speak the contents of the block of text.
d Delete the marked block of text.

After using any block option, you are automatically returned to the editor on completion of
the operation.

After any of the operations, apart from the setting of markers, the document is automatically
re-formatted. The MB says which operation is being carried out, for example: “Move Block”
followed by “Please Wait” and then “finished”.

e-chord Exit the Block Menu.

Delete Menu

The commands in the Delete Menu duplicate many of the chorded commands. This Menu is
helpful if you cannot remember the chorded command or if you have difficulty pressing both
keys at the same time.

newline+d  Enter the Delete Menu:

Once you have entered the Delete Menu you have the following options:
c Delete the current character.
w Delete the current word.

On deleting a word, any attached punctuation and following spaces up to the next word or
end of line will also be deleted.

1 Delete the current line.

On deleting a line, the following carriage return and/or linefeed will also be deleted. If a page
break terminates the line then this is not deleted.

P Delete the current page.

On deleting a page, any text between the previous page break and the next one is deleted.
The page break is also deleted.

dot 3 Delete the previous character.
dots 2,5,6 Delete from the cursor position to the end of the current word.
Dots 1,4,5 Delete from the cursor position to the end of the current line.
r Restore the last deletion.

This command is an "undo"; the text most recently deleted will be restored.

The document is not automatically re-formatted after a deletion. You must use the format
command in the File Menu to re-format.

e-chord Exit the Delete Menu.

Search and Replace Menu

The search and replace menu enables you to search for and, if desired, replace selected
text. You can choose the direction of the search, the case of the text you are searching for, or
whether it should match whole words or not.
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newline+s Enter the Search Menu.

Before a search or replace is initiated the proper operating selections must be set up. To do
that, select from these options:

d Decide the direction of the search. The options are:
Search from the beginning of the file to the cursor position;

Search from the cursor position to the end of the file;
Search the whole file from the beginning.
Each time you press d, an option is spoken. The last spoken option is the one selected.
c Set whether the search will be case sensitive or not. The options are:
Case sensitive
Case insensitive
Each time you press ¢, an option is spoken. The last spoken option is the one selected.
w Decide whether to match whole words or not. The options are:
Matches whole words only

Matches anywhere; the text you are searching for can be more than one
word, or part of a word.

Each time you press w, an option is spoken. The last spoken option is the one selected.

Once you have all your search parameters set up, you can use any of the remaining options:

s Search for text
r Search for and replace text
1 Redo the last search

Entering Search and Replace Strings

When you start a search, you are asked to enter the search string, the letters or words that
you are looking for.

Your search string can contain any letter or number, punctuation or spaces.

You can look for a string at the end of a line by entering newline after your search word, or
look for a string at the beginning of a line by entering newline as the first character of the
search string.

If you press backspace the last character entered is deleted, and the MB-LS will speak the
character just deleted. You cannot have an empty search string.

Note: If you start or end a search string with a space character such as newline or space,
the space character is treated as the end of a word.

When you have finished typing in your search string, press e-chord to finish.

If you have pressed r to search and replace, after the search string has been entered the
MB will say “Enter replace string”.

As with the search string, your replace string can contain any letter or number, punctuation
or spaces.

However, you can choose to have nothing as the replace string, so you can delete every
occurrence of your string in the document.

To do this enter e-chord when the MB-LS asks for the replace string.
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Keep in mind that there may be a space before or after the word you want to delete, so
incorporate that extra space at the end of your search string. Of course this will mean it will
not find a match if the word is followed by punctuation. You may have to try it with and
without the space to be sure you get all occurrences.

Press e-chord to complete your replace string.

Note: Remember which Braille Grade you are using to enter information. If your document
contains Grade 2 Braille, then you cannot search for a word in Grade 1 Braille, or vice versa.

The Search Sub-Menu

If your search string is found in the file and this is a search only command, then you have
available the following options:

w Speak the word that contains the search string.

1 Speak the line that contains search string.

n Ignore this occurrence and find the next one.

command Stop the search and return to the main search menu.
e-chord Stop the search and return to your document in the Editor

The Search and Replace Sub-Menu
If the search string is found and you have chosen to replace it, in addition to the Search Sub-
Menu options you can choose from the following:

r Replace this occurrence. Your MB-LS will say “Replaced this occurrence.
Please wait. String search found” and the cursor will be on the next
occurrence of the search string in the file.

a Replace all occurrences
When you exit the main Search Menu after a replace has occurred, the document will be
reformatted before you are returned to your document in the Editor.

Abandoning Search

A search can be abandoned, at any time, even during the setting up of the search or replace
strings, by pressing command.

If the search string is not found, you are returned to the Search menu, so that you can
change the search string or change one of the conditions of the search.

e-chord Exit the Search Menu.

Editor Definitions and Concepts

The Editor is a word processor for Braille. This means that your MB-LS uses the concepts
you will find in a word processor, and it can be useful to understand these concepts and how
they will affect the way the MB-LS works.

Hard and Soft Carriage Returns

A soft carriage return usually marks the end of a line within a paragraph. It is automatically
inserted by the Editor at the end of each line; it is what happens in the memory when the
Editor does a "word wrap".

A hard carriage return is something you enter into text yourself by pressing newline, at the
end of a paragraph or to insert a blank line.

When you re-format a paragraph, after deleting or adding to your text, the Editor is allowed
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to move or delete or add soft carriage returns to re-format the paragraph. However, if you re-
format a group of paragraphs, the Editor is not allowed to add or remove hard carriage
returns.

Hard and Soft Page Breaks

Normally the editor uses soft page breaks to distinguish the end of a page and the start of a
new one, in the same way as it uses soft carriage returns at the end of lines. If subsequent
text is inserted or deleted, by whatever means, and the document is reformatted, then the
position of the page break changes accordingly.

Hard page breaks, however, do not move. They will always force the start of a new page.
Just as with hard carriage returns, hard page breaks can only be entered by you, and the
Editor does not move or delete them.

If you wish to insert a hard page break, enter the "New Page" or "Form Feed" command from
the MB keyboard or Control-L from an attached PC keyboard. This will insert a hard page
break at the current cursor position.

Making a Paper Copy of your Files

Files can only be printed or embossed after leaving the Editor. You cannot print or emboss
files from within the Editor. Print your files using the pr command or use MB-Comm and
Back Translation to send them to the PC; emboss using the emb command.

Speaking Commands

If the “Speak Commands” option in the Speech Menu is set on, then when a command is
found, the word “Command” is spoken and the command following is spelt. As the
commands are intermingled with the text, it may sound strange, but it allows you to locate
any embedded commands easily and edit them.

This means that you can embed commands for formatting your Braille or print page in your
Editor document, and when you print or emboss, the commands will be activated.
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Braille Music on the MB-LS

Your MB-LS has three levels of Music available, to take a Braille Music student from the very
basics through to writing and editing simple Braille musical scores.

Step 1: Music Fun Mode

In this mode, the MB-LS keyboard becomes a tiny musical keyboard, where you can play
notes and chords, and experiment with pitch, octave and duration as well as sharps and
flats.

Music Fun Mode is entered through the Options Menu. This means the MB-LS must be in
Advanced Mode before you begin. The option letter is u.

Entering Music Fun Mode

o-chord u enter Music Fun Mode

Once you are in this mode, try the Braille dot keys and the command key, from left to right,
one at a time. You can play a scale, from the lowest note at the left to the highest note at the
right.

To change from one octave to the next, use backspace and enter; backspace lowers the
notes one octave, and enter raises the notes one octave.

The Braille keyboard is now a music keyboard, for play and to learn the basic musical
concepts.

. ®
O 88ge 9988

Change Pitch @  Notes of the Scale

@ sharpen orFlatten @ change buration
lllustration 21: The MB-LS keyboard in Music Fun Mode

The six dot keys and the command key play 7 notes of the C major scale. Press each key in
sequence to move higher up the scale:

dot 3 dot 2 dot 1 command dot 4 dot 5 dot 6
Press the same keys again, beginning with dot 3, to hear the scale in a higher octave.
To raise or lower the pitch of the scale, use these keys before pressing the note keys:

backspace Move down an octave
enter Move up an octave

To change the duration of a note from the default eighth-note (quaver )’), press these keys
together with the note key:

space Double the duration of the note to a quarter-note (crotchet) .
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newline Quadruple the duration to a half-note (minim) A

newline + space Extend the duration by eight to a full note (semibreve) o
To change the pitch of a note by a semitone, press these keys with the note key:

tab Flatten the note (half a tone lower)

backtab Sharpen the note (half a tone higher)
Press multiple note keys together to hear a chord.
Press the following sequence of keys to play Twinkle Twinkle Little Star:

3, 3, 4, 4, 5, 5, 4+space, command, command, 1, 1, 2, 2, 3+space

To exit Music Fun Mode
z-chord exit Music Fun Mode

Step 2: Music Play Mode

In this mode, students can type Braille music characters and hear them being played at the
same time.

Music Play Mode is entered through the Options Menu. This means the MB-LS must be in
Advanced Mode before you begin. The option letter is u-chord.

When you begin Braille music, it can be difficult to distinguish between literary Braille and
musical Braille. Music Play Mode helps to associate the keystrokes and the Braille
characters with their musical sounds and meanings.

To help you begin experimenting with Music Play, here is a table of the basics in Braille
music:

Table 1: Notes Rests Type
C D E F G A B

g o o o s o s = Wholes or
A O S I O I R

e s : : s : e * Halves or
Sl e s e s 32nds

i3 K .. e o o .t :: Quarters or
Wt s s e e 5 | b4ths

°e ‘e o° o HS o° - :: 8ths or

o umwm @ n 12sths

For more examples and information about Braille Music, see the Tables, Usage and
Examples section following the Music Editor section.

To Exit Music Play Mode
z-chord Exit Music Play Mode
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Step 3: The Music Editor

In the Music editor, you can compose simple, single-voice tunes using Braille Music
Notation. Once the tune is written, it can be played back, edited, saved and embossed.

Music can be written in four octaves - from second octave C to sixth octave C. Only one
voice of music can be composed; the Music Editor doesn't have provision for chords or
harmonies. You can use accidentals, dotted notes and note values up to 32nds. For those
note values that use the same dot combinations, such as C semiquaver and C semibreve,
the MB-LS can calculate the bar value and play these back correctly.

Getting Started

If you are familiar with the Editor, you will find many similarities between the Editor and the
Music Editor - except that, instead of hearing your text read back or spoken, you will hear
music played.

Entering the Editor

command edit enter u-chord

Enter the Editor by pressing command, typing edit, and then pressing enter. The MB-LS
announces "editor ready". You must then press u-chord to enter the Music Editor.

The MB-LS will then ask you for some information about the music file you wish to create:
Title Enter the title you wish to use, then press e-chord to complete. If you
simply press e-chord, the music will have a blank title.

Key Signature Enter the key signature you wish to use, then press e-chord to
complete. If you simply press e-chord without a key signature, the
default key signature, C Major, no sharps or flats, will be used.

Time signature Enter the time signature you wish to use, then type e-chord to complete.
If you simply press e-chord without a time signature, the default time
signature of 4/4 or Common Time will be used.

The MB-LS will then say "Start"; you are now able to go ahead and enter your music.

You can then begin to write your music file. It is important to remember that the top two lines
of your music file have been reserved for the title, key signature and time signature. The
Editor will always treat these first two lines as text only.

To Leave the Music Editor and save your file

Special note:

Music files MUST have the extension .bmf - meaning Braille Music File - to tell your MB-LS
that the file is a music file.

This is so that when you load this file in to the editor, the MB-LS will know to play this file as
music rather than read it as text.

To enter the file extension .omf, use: dots 4,6 b m £
Leaving the Editor
newline+q Quit the editor.

You will be prompted: "Save File First — Yes/No?” If you press Y for yes, you will be asked to
enter a filename. Type the filename, remembering to use the .bmf extension at the end,
followed by e-chord to complete. Answering N will not save any data and will quit the editor.
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Opening an Existing Music File
To open a music file you have previously created use the command:
edit [filename.bmf]

filename.bmf is the name you gave the file when you saved it. Don't forget to add the file
extension .bmf! This lets the Music Editor know that it is a Braille music file rather than a
literary Braille file.

Navigating Through Your Music File

The music editor uses the same protocols for navigating through your music file as the Editor
uses for navigating through your text file.

space + dot 3
Moving to the left:

space plus the key for the distance you want to move

move to previous note and speak it

space + dot 2 D "@Q OOO O

move to previous bar and play it

space + dot 1

move to previous line and p|ay it lllustration 22: Moving left in the Music Editor

Moving to the right: space + dot 6

space plus the key for the distance you want to mnove

move to next note and speak it

g 000 888 0| e

move to next bar and play it

space + dot 4

lllustration 23: Moving right in the Music Editor . .
move to next line and play it

space + dots 13- move cursor to top of previous page
space + dots 123 - move cursor to start of music
space + dots 46 - move cursor to top of next page
space + dots 456 - move cursor to end of file.

space + dots 36

Play current: space plus both directions
- speak the name of the current note

Current note

space + dots 25 D @OUQ OO@ 0

- play the current bar

space + dots 14

- play the current line Hlustration 24: Speaking without moving in the Music Editor

As with the Editor, if you are already at the start or end of the file and press the key-
combination to move further, then the MB will say "top of file" or "end of file".
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Music Editor Commands

The Music Editor uses chord commands - the keystrokes where a letter is combined with
space. So, for a t-chord you press space plus t.

t-chord Tab. If you press t-chord, you will insert a tab at the cursor position in
your music file.
p-chord Hard page break. Pressing p-chord forces a new page at the cursor

position in your file.

newline+w  Where Am I? When you press newline+w, your MB-LS will speak the
name of the file and your current position in the file, given as page
number, line number and column number. If you are in a menu then you
will hear the name of the menu.

space + dots 1,2,3,4,5,6
Use this keystroke to delete the character immediately under the cursor. It
can be used at any time while writing in the editor

r-chord Play the rest of the file, from the cursor position to the end, without
moving the cursor
z-chord Silence Command. This command can be used at any time to stop

speech or music.

Using the Keyboard
The MB-LS keys behave a little differently in the Music Editor:

newline newline key is treated as a hard carriage return, and will put you onto
the next line of Braille music.

backspace backspace will delete the character immediately before the cursor,
whether it is a note or a rest.

enter enter has no meaning or function when using the editor.
tab Move down one item in any music editor menu.
backtab Move up one item in any music editor menu.

Once you have used tab or backtab to navigate to the item you want in a menu, you then
need to press the keystroke to activate this menu item. For instance, to enter the File Menu
you press newline+£. If you press backtab, you will begin at the "exit" command, and if
you press backtab once more you will be at "Save File, S". To actually save the file, you
must now press S.

Using the Music Editor Menus

All the menus in the Music Editor are the same as the menus in the Editor; for a full
explanation of each of the menu items, see the section The Editor.

You enter each menu by pressing newline plus the letter denoting that menu:
newline+f File Menu
newline+te Edit Menu
newline+b Block Menu
newline+d Delete Menu
newline+s  Search Menu

Once you are in a menu, you can step through the available options with tab and backtab,
press the command for the feature you want, or press e-chord to exit the menu and return
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to your music file.

Embossing Your Music File

You cannot emboss your Music file from within the Editor; you will see that there is no
provision to do so, on any of the menus. You must first save your file by going to the File
Menu and pressing s, and then exit the Music Editor with newline+q. Then you can use the
emb command:

emb [filename] .bmf Emboss the file named [filename]. Remember that you
must use the .bmf extension at the end of the filename.

The file will be embossed with the Title on the first line and the Key Signature and the Time
Signature on the second line.

Remember: you must first save the file and quit the music editor before it can be embossed.

To view all files that you have stored in the MB-LS, you can use the dir command. This is
handy to check for spelling, or contractions that may have been used in the filename. The
dir command is also explained in the section Essential Extras.

dir Lists all MB-LS filenames and their sizes

Music Mode — Tables, Usage and Examples

The information in this section is very basic; for teaching Braille Music, we recommend
"Focus on Braille Music" by Lisette Wesseling.

The illustrations in this section are not labelled, because they are visual score-based
representations of the Braille music in the text.

Octave Signs and Rules

Octave marks

An Octave Mark is included before a note symbol to specify the octave of the note. Octave
symbols are only specified when needed.

Table 1 - Octave Marks

NABCC Braille Octave
@ :® (dot 4) First octave C
A 3 (dots 4,5) Second octave C

_ :3 (dots 4,5,6) Third octave C
" Fourth Octave C

¢ (dot 5)
e (dots 4,6) Fifth octave C
; ‘. (dots 5,6) Sixth octave C
’ i (dot 6) Seventh octave C

The octave sign is placed immediately before the note to which it belongs, and no other sign
may come between themThe octave is always marked at the beginning of a paragraph or
piece and at various other points as follows.

In a melodic progression, the octave is not marked for the second of two consecutive notes if
it is less than the interval of a fourth from the first. For instance, a melody proceeding upward
from the first octave can, if moving by step, proceed to the second, third, and fourth octaves
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without requiring additional octave signs.

The rule is that, in the absence of an octave mark specifying otherwise, notes always move
by a unison, 2nd, or 3rd rather than a 6th, 7th, or octave. For instance, the following
sequence moves upward continuously ending in octave 5:

Octave2ccdefgabcdefgabcdefgabbcc

The rule for 4ths and 5ths is different, however: in the absence of an octave sign specifying
otherwise, a melodic leap of a 4th or a 5th will always stay within the same octave as the
previous note. For instance, the following always stays within Octave 2:

Octave2cgdaebfcgdae

Example:
I
| b '.':E'l" .
SR mam et TP P H
R - ' — _J... ! i

The octave is always marked in a skip of a sixth or seventh, even when the second note is in
the same octave as the first.

Example:
o o0 - -
9 ® - O -
e - - 00
o0 00 o X J [ X J [ ] o0 o [ ] [ X J K] (X ) [ ] [ ] e @
e -0 o0 e® - -0 -0 -0 O e -0 o o 60 -0 -0 -0 O e -0 -0 O e - - O
.. .. Y . o - e o
(® ’ - P E
o & - - - -

The octave is only marked in a skip of a fourth or fifth when the second note is in a different
octave from the first. Compare the two items in the following example:

Example:
[}
7 |
s
SV
o @ - -+ -

Notes and Note-values

In this User Guide, the following terms are interchangeable:
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whole note or rest = semibreve

half note or rest = minim

quarter note or rest = crochet

8th note or rest = quaver

16th note or rest = semi-quaver (etc.)

Table 2: Notes Rests | Type

Cc D E F G A B

o lu % # %o & i Wholesor

Bou 0 H B B s @ et

It oo : : s o i ° Halves or

R R T I A T

°s % : : & o o : Quarters or

N H ks @4 edtns

° * : @ % o o ° 8ths or

oot s s 2sths
Example:

Dotted notes are shown by adding dot 3 after the note, according to the number of dots
given in the printNo other sign may come between the note and the dot.

Example:
dotted quarter: % .:
double-dotted quarter: % ¢

Accidentals, Key and Time Signatures

Accidentals
X Sharp
e Double sharp
¥ Flat
IR Double flat
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‘. Natural

‘e e OF 4 . Accidental above or below the note

Key & Time Signatures

e C or "common" time

Barred C or "cut" time

“tor & i Time Signatures with two numbers

4 (or other number) Time signature with single number

S Time signature: 4 over quarter note
S Time signature: 3 over 8th note
X RTINS it & % Key signatures

Example:

The space between is mandatory in some countries; check with your local Braille Authority to
find out which is the convention used where you are.

hoordt e Two sharps, six-eight time
R TR I I X Three flats, three-eight time
R A Fr S Four flats, twelve-eight time
A Five sharps, common time

Accidentals are placed immediately before the note or interval to which they belong, and
must not be separated from it by anything but octave signs. In general, accidentals should
always be marked where they occur in print. Where it is necessary to add accidentals in the
Braille text, they are subject to the same considerations given for added rests. Each
transcriber-added accidental should be preceded by dot 5.

As in print, accidentals remain in force during a complete measure, but only for the same
note at the same pitch.

Example:
|
T % r— .: i ] TE —~ I
| [} IH_‘ ‘ I 1 1% | I t H-
—J—l"""l'.]i B ‘_"’L‘E[‘ I
*® 00 00 -0 00 - -
@ @ co <@ 0 00
®® - 000 -- -0
[ ] L 3 ® . 000+ 006 0-0-0" [ ] -0 0 ® 0 00000
e -0 -0 -0 v <@ o0 00 006 - - -0 -0 [ ] e @ ® 00 - 00 O - -
[ ] - 0O . ‘o <0 -0 -0 -0 -0 00 -0 0 o @ -0 -0 -0 -0 0 -0 -0 O
Key Signatures

Key signatures are written between blank spaces (unless followed immediately by meter
signatures) at the point at which they appear in the print, except that the signature at the
beginning of each staff is omitted after its first appearance in a piece. Changes of key are, of
course, placed wherever they occur.
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Y J :. -® 00
0 - ® 00 - -0
@+ 0 - -® X J « @ ® 00 ® 00 O - [ [ [ J [ 1) [ JCIK BB Y
o 00 00 * @ o0 * @ o 0 . ® 0 0 [ X J [ (1] @ [ ] (3K
@ 00 .. o0 00 o0 - - o 00 - -® [ ] [ X J o0 [ 1] ® 0
iﬂ 1 i Y 3 Hl EH lr) E I h
i dl » —3 P ipv - n k
v - v -
it il < 1 L

Changes of key should always be marked in each part in keyboard music (or in vocal or
orchestral scores) when they occur in a piece or movement, but at the commencement of a
composition or movement it is only necessary to mark the signature once, usually in
conjunction with the time signature.

The first note following a key signature must always have its proper octave mark.

Music symbols, such as accidentals, generally should not be combined with regular letters.
In a title, such as “Prelude in C Sharp Minor”, or a phrase like “Music for B flat Clarinet”, the
sharp and flat symbols should not be used. However, in some theoretical and analytical
situations, hybrid signs may be permitted for convenience and expediency.

Bar Lines and Repeats

Bar Lines
(space)Bar line

*es: Double bar at end of composition

i Double bar at end of bar or section
Print Repeats

s Double bar followed by dots; beginning of repeat

s Double bar with dots preceding; end of repeat
Braille Repeats

s Full- or part-measure repeat

ssar e Repeat four (or other number) times

BRI Repeat the last four (or other number) measures

Repeat the last four (or other number) measures

Rests

The signs should be used for all rests which occur in the print; but it frequently happens that
the Braille text can only be made clear to the reader by the inclusion of rests which do not
appear in the print. Each transcriber-added rest must be preceded by dot 5.

Example:
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»
L

L]
s
10

N

<

fal
r: '_F
& =

Fa]

A measure of silence is indicated in the print by a whole rest, whatever the time signature
may be, except that in 4/2 time the double whole rest may sometimes be found.

When a silence is prolonged for two or three measures, the rests are written separately;
when it extends for four or more measures, the rests are grouped.

Three measures' rest: ¢ ¢: o

Four measures' rest: ¢8 °.:
Dotted rests are written like this:
Dotted quarter rest: . .

Double-dotted quarter rest: 8¢ ¢«
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Braille Codes and Languages

How to change between languages

In order to switch from the default Braille language to a different Braille language, the user
needs to enter the following set of commands.

f£1n (or bln) language Change the Translation Rules.
[language] can be one of the following codes:

Which languages you can change between will depend on the language set installed on your
MB-LS. If you aren't sure which language set applies, contact your distributor.

Each language set has a letter designation. Braille rules for all languages within a language
set are available using the £1n or df1n command.

Language codes:

A B C D
Spanish spa Russian rus Portuguese por  Swedish swe
Italian itl Polish pol Greek grk Norwegia nor
n
French fr Lithuanian 1it English oz Finnish fin

English oz German ger English uk English oz
English uk English oz English usa  English uk

English usa English uk Brazilian  bra English usa
Portuguese
English usa Dutch dut
Czech czc
E F G T
Thai tha Turkish tuk English oz English oz
Taiwanes  twn English oz English uk English uk
e
Mandarin  chi English uk English usa English usa
Chinese
Korean kor English usa Belgian dut Argentinia spa
Dutch n Spanish
English oz Arabic arb

English uk
English usa

Changing the default language

Depending on which languages are installed on your MB-LS, you can also change which is
the default language which will be active when you turn your MB-LS on.

In order to change the default language to a new default code, use the command;

dfln [language] Change the default Translation Rules to the new language.
Check with your distributor to find out what is possible for your MB-LS.
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How to Insert International Characters into Your Text

There will be occasions where you need to use an international character but do not want to
change the default Braille language being used. For example, a student in the US is learning
Spanish and they want to use regular US Braille rules, but insert a Spanish character into the
text they are writing.

ffc (or bfc) language

International character selection. This enables insertion of international character
into your text, without changing the translation rules

Using Dropped or Lower Numbers

All through this User Guide, you will see mention of using "dropped" or "lower" numbers
when entering commands and calculations.

The standard literary Braille method of entering numbers is to use a number sign, dots
3,4,5, 6 followed by any combination of letters from a through j:

Number 1 2 3 4 5 6 7 8 9 0

Sign 2R

Dropped or lower numbers use no number sign prefix, and are written in the lower half of the
Braille cell. Thus, 1 is represented by dot 2, also known as "lower a" or "dropped a":

Number 1 2 3 4 5 6 7 8 9 0
Sign < g . °2 ¥ : 2 ¥ . .

Using ASCII or Computer Braille
This table shows the correspondence between ASCII characters and Braille characters.
ASCII Braille, or Computer Braille, is also known as Grade Zero or the NABCC code.

If you send a file from the MB-LS to a PC without translating, you will see that the Braille in
the file is displayed as ASCII characters; this table can help you make sense of those files.

Braille Braille Braille
ASCII Dots Braille ASCII Dots Braille ASCII Dots Braille

A 1 % W 2456 it / 34 >
B 12 : X 1346 B > 345 :
C 14 * Y 13456 o # 3456 3
D 145 K Z 1356 o + 346 ¥
E 15 e $ 1246 X ; 36 i
F 124 < ' 3 . A 45 2
G 1245 & @ 4 ¥ _ 456 g
H 125 ‘e " 5 . . 46 X
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Braille Braille Braille
ASCII Dots Braille ASCII Dots Braille ASCII Dots Braille

| 24 . , 6 . : 56 S
J 245 «t = 123456 0 356 3
K 13 : & 12346 i 1 2 .
L 123 . ( 12356 s 2 23 s
M 134 : ] 12456 * 3 25 =
N 1345 - \ 1256 * 4 256 s
0 135 - < 126 ¥ 5 26 ¥
P 1234 : 2 1456 g 6 235 5
Q 12345 3 % 146 % 7 2356 ¥
R 1235 5 : 156 i 8 236 ¥
S 234 : * 16 . 9 35 i
T 2345 5 ) 23456 2 (space)

U 136 3 ! 2346 ¥
Vv 1236 i [ 246 “
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Modifying and Adapting the MB-LS Keyboard
One-Handed Braille Writing

ku Turns on One-Handed operation.
The ku command is a toggle. Once it is active, to use ku again, you must press command k
space u space enter, in that order.

When ku is on, press space after the you have entered the dots for each character. For
example:

To type the letter u, you do not have to press dots 1, 3, 6, together. You can press
the dot keys separately in any order. For example, using one finger press dot 3, then dot
1 then dot 6. Then press space to emboss the character.

When the MB-LS is in unimanual mode there are alternatives to chorded commands
available The following commands are available in one-handed mode only.

bt backtab

cr newline

in Indent

1f Linefeed

np New Page

rl Reverse Linefeed
tb tab

To exit unimanual Mode, to return to standard keyboard use, remember to press command k
space u space enter.

Changing the Dot Key Layout
The six dot keys are normally configured in the following dot pattern:

The left-hand group of dot keys is configured from the centre outwards as dot 1, dot 2
and dot 3; the right-hand group is configured from the centre outwards as dot 4, dot 5
and dot 6.

It is possible to change the layout of these six keys at any time, using the following
command:

kbd [key 1] [key 2] [key 3] [key 4] [key 5] [key 6]
This is done by pressing command, typing kbd, space, and then pressing and releasing the

dot keys in the new order, one at a time. [key 1] will be the new dot 1, [key 2] will be
the new dot 2 and so on.

After pressing the six keys for the new order, press enter to make the new layout available.

To return to the standard dot layout, use the same method, or, if the setting has not been
saved, switch the MB-LS off and the standard dot layout will be restored when you switch on
again.

If you find that the keyboard has been rendered unusable by the kbd command, and the

setting has been saved, you can reset the MB-LS to return to the proper keyboard layout.
See the section Care and Troubleshooting for information on how to do this.
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Changing the Control Key Layout
The Control key layout can also be changed.

As before, Control Key layout settings can be saved as part of the Keyboard group, along
with Dot Key layout settings, using the command SAVE KB.

The standard layout of Control keys from left to right is as follows:

Control Key 1 backspace b
Control key 2  newline n
Control Key 3  space s

Control Key4 enter ormargin release m
To change the layout of the control keys, enter this command:
kbc

and press space. Now Braille the four letters, b, n, m and s, representing each control
function, in the order of your new layout.

For instance, if you want the new layout from left to right to be newline, space,
backspace and enter, your command would be:

kbc nsbm

Complete the command by pressing enter, remembering that you must use the existing
enter, not the new one, since the new enter will not be changed until after the command
has been entered.

Left Function Key
The command to change the left function key (which is usually tab) looks like this:

kblf [command]

[command] is the function you wish to assign to the function key, and can be any command
you would normally type at the keyboard.

For instance, you might like to have the left function key turn Forward Translation on in
Advanced Mode. To do this, enter the command:

kblf fe

You will now find that if, when you are in Advanced Mode, you press the left function key,
nothing will seem to happen. If you type on the external keyboard, however, you will find that
you have to press Return twice to have your input embossed, and that it has now been
translated properly.

If you don't want to use Forward Translation very often, there might be another command
which you enter a lot. You can assign it to this function key to save a lot of time. It might be a
page formatting command - for instance, you might want to change the left margin back and
forth. To put your secondary Left Margin setting into the Left Function key, enter

kblf 1m 15
for a secondary left margin of 15 spaces.

Right Function Key

The right function key (which is usually backtab) can be redefined in exactly the same way,
except that the command now looks like this:

kbrf [command]
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For example, to complete the pair, you might like to enter the command
kbrf fe or kbrf 1m 10

Combined Function Keys

It is also possible to have a third command available, for when you press both function keys
together. The command looks like this:

kblrf [command]

For instance, you might like to use the combined function keys to turn the Multi-Strike feature
on for those times when you want to use heavy paper. To do this, enter

kblrf ms 2

So that, when you press both Function keys together, the Braille embossed after that will be
double-strike.

Multiple Commands on a Function Key
The Function keys can be assigned to perform multiple commands, one after the other, in a
group.

The same procedure and codes for redefining the Function buttons still applies; however, for
multiple commands, each command required within the definition is separated by a
newline.

For example: to assign a multiple command to the Left Function Key, such as turning off
Back Translation and turning on Forward translation with the one keypress, use the following
sequence:

kblf fb newline fe

where newline is the usual key for that purpose. Note that there are NO spaces between
the commands and the newline key.

Warning: When assigning commands to the Function keys, do not use the following
commands unless they are the LAST command in the definition. These commands are
usually involved in automatically printing or embossing from memory. See the User Guide for
an explanation of Print control mode and the keys involved.

Commands to be avoided are:
pPr append dir rename report

help copy ver

Special Keyboards

For some users, even the light touch and ergonomic design of the MB-LS keyboard are
unsuitable. Your distributor will be happy to help with advice about and design of external
keyboards, as well as helping with the connection information needed.

The extra port on the front of the MB-LS is designed to be used for connecting specially-
adapted keyboards.

Please ask your distributor if you would like more information.
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Saving and Restoring Settings

Every command used by the MB-LS has a default, or factory, setting. However, toggle
commands can be turned on and off, and other commands can be set to suit your
requirements, including keyboard layout, communication parameters and page format.

Settings that are not saved are temporary and will be lost at switch-off. If your changes are
meant to be temporary, then all is well. However, if you want permanent changes, to avoid
having to re-enter settings every time you turn the MB-LS off and on, the settings can be
saved so that they will be available at the next switch-on.

Note: The commands em and the commands to turn USB or Serial ports on cannot be
saved. When the MB is switched off and back on again, embossing will be on, and the Serial
and USB ports will be turned off. This is to prevent confusion at turn on.

Groups

Settings are saved in groups, where the name of the group indicates the type of setting. A
group has a two-letter identification code which is used to save, report and restore the
settings. You might have already used the save pf command as mentioned in the User
Guide; this is but one group of many available. The different Groups are given below.

The Save Command

The SAVE command stores and saves current settings. This is normally done by group. If no
group names are given, all current settings will be saved. The general command is:

save [group] where [group] is optional. If [group] is not given, you will save
every current setting from every group, so we advise you to use this
command with care.
As well as an individual group, combinations of groups can also be saved. There should be a
space between the save command and the first group name, and a space between each
two-letter group name.

For example: to save Forward Translation settings and Page Format settings at the same
time, use the command: save ft pf.

Defaults

Although you might have settings saved for every available group, the default (factory)
settings are still available. At any time, you can restore the original defaults without changing
the settings you have saved, by using the std command. You can specify the group name of
the settings you wish to return to their default. For instance, to return Forward Translation
and Page Format settings to their defaults, enter:

std pf ft

Using the command std without specifying any groups will return all the settings on your
MB-LS back to their default values. However, your saved settings are still saved and
accessible to you until you use save again to save a new value to a setting.

Restoring

Having saved settings and then returned to the defaults for a particular group, you can use
the restore command to restore the saved settings. Following on from the previous
example, you would use the command:

restore pf ft

It is not necessary to keep the group names in any particular order.
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If the MB-LS has been switched off, the default settings will be replaced by your saved
settings after the next switch-on. restore is only necessary if you wish to restore saved

settings during the same session.
Reporting

If you need a list of the saved settings, or if you have forgotten what you are currently using,
then you can have the MB-LS emboss or speak a report on the settings.

If you have synthesised speech active, then you will hear the report spoken; if you have
recorded speech active, the report will be embossed.

The categories for reporting are for Current, Saved and Default settings as follows;

reportc [group] reports current settings
reports [group] reports saved settings
reportd [group] reports default settings

For [group], use the two-letter code for the group or groups required. If no group is given,
then all settings are embossed or spoken.

When you ask your MB-LS for a report on settings, how it is presented to you will depend
which type of speech you have active.

If you have Synthesised Speech active, the report or listing will be spoken.
If you have Recorded Speech active, the report or listing will be embossed.

So, if you are using Synthesised Speech but you would like an embossed copy of a report or
listing, use spk r to change briefly to Recorded Speech, enter the command for your report
or listing, and then use spk s to return to Synthesised Speech once the embossing is
complete.

You can also set reports to emboss even when Synthesised Speech is on; see the command
rec emin the section Using Commands.

Group Names
A group can have a single setting, or it can cover several related settings.

Advanced Commands and Formatting Groups
kb stores the keyboard layout which includes:
Braille keyboard settings - if no changes have been made, this will report "standard".
External keyboard setting
Eight Dot Braille setting

pf stores all Braille page format settings:
Left margin Right Margin Line Length Top Margin
Form Length Page Length Tabs Word Wrap status
Line Spacing Right Margin Bell status Page Bell status

Back Translation Groups

bf All Back Translation print page format settings are stored in this group.
These are the settings for page layout for an ink-printed page when you
connect an ink-printer to the MB-LS. The settings are:

Form Length Page Length Top Margin Line Length
Left Margin Right Margin Line Spacing Tab Stops
bt Back Translation settings are stored in this group, including:
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Braille Grade Braille Language Exception Table

Forward Translation Groups
ft Forward Translation settings, which include:
Braille Grade Braille Language  Output Format settings
Forward Exception Table
Data Transfer Groups

bec This group stores the Computer Braille Code setting. The default is
NABCC.
sl first serial port (Mimic port) settings, which relate to data transfer through

the serial port on the side of the MB-LS where the Mimic is connected.
Settings include:

Bit rate Data Bits Stop Bits Parity Handshaking
Newline mapping
s2 second serial port settings relating to data transfer through the serial port on the

back of the MB-LS. Settings include:

Bit rate Data bits Stop bits Parity Handshaking
Newline mapping
pp - stores the information about parallel interface newline mapping.

Other Settings

Some other settings which are not stored or retrieved as part of groups are reported on when
you use any of the report commands:

the Multi-strike setting;
the status of the spk setting; and
the status of unimanual mode.
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Care and Troubleshooting Guide

If you experience problems with the operation of your MB-LS, assistance is available to help
you or your support person diagnose the problem.

Power

The MB-LS has an internal battery which is re-chargeable. A universal power supply is
provided which, when plugged into the mains, will re-charge the battery at the same time it
provides power to the whole unit. It connects to the MB-LS through the round connector on
the left-hand side of the MB-LS.

Try and ensure the battery is kept charged. You cannot over-charge the battery, and leaving
the unit permanently charging will not damage it in any way. For regular classroom use, you
will typically get a full days use out of the battery. When you do this please ensure to re-
charge the MB-LS overnight so it is ready for the next days work.

How to Check the Battery

space+newline+b

O O
Use this command to check the MB-LS battery O O" O OOO O
N

status. Press all 4 keys together.

The MB-LS will respond with either "Battery OK"
or "Battery Flat". The MB-LS will also tell you if lllustration 25: The battery-check keystroke
power is connected or not by saying "Charging" or

"Not Charging". If the battery is flat, embossing will stop.

The causes of a flat battery are:
- The battery hasn’t been charged. Connect the MB-LS to the power for 24 to 48
hours.

- The wrong power supply is being used. Your MB-LS is supplied with a universal
power supply, and this is what you should be using.

- The power cable could be faulty.
There could be no power coming through the wall outlet.

- The battery is faulty and needs to be replaced. The expected life of your main
battery is 5 years.

If you suspect the wall outlet, the power cord or the charger is faulty, the simple way to check
is to unplug and re-plug the power supply; if there is power coming to your MB-LS, it will say
"not charging" when the power supply is unplugged, and "charging" when the power supply
is plugged back in, even when the MB-LS is switched off . If you don't hear either of these
messages, try using a different wall outlet, or a different power cord. If this doesn't help,
contact your distributor.

Status and Operation Error Messages

The following messages will be spoken using Recorded Speech no matter whether
Recorded or Synthesised speech is in use. A continuous status or error message can only
be cancelled by turning your MB-LS off.

Status messages tell you what condition your MB-LS is in. Most of these do not represent
problems that require your MB-LS to be returned for service. Error messages advise you
about problems that could be more serious and require some expert assistance to resolve.

User Guide 112



Status Message
Charging

Not Charging
Battery OK

Battery Low

Battery Flat. Recharge

Error Form length

Input Buffer Full

Keyboard Buffer Full

Serial Buffer Full

Memory full

Duplicate file. Error

Printer not ready or
Printer not found

Backup Battery Low

Error Message

Braille Head Jammed

Braille Head moved. Error

Serial Interface Error

System Error

Description
Your MB-LS battery is charging

Your MB-LS is not connected to an external power source
The battery is 2/3 charged or more.

The battery is low. You need to recharge the battery.
Connect to power as soon as possible.

The battery is flat. Recharge for 24 hours. If this does not
work, first check that you are using the right power
adaptor, and then make sure that the power adaptor is
working and that you have power coming from the wall
outlet.

The actual form length of paper being used does not
match the form length selected

Either typing speed on PC keyboard is too fast, or the MB-
LS is waiting to clear the input buffer. Please wait until the
buffer is cleared.

Either typing speed on the Braille keyboard is too fast, or
the MB-LS is waiting to clear the input buffer. Please wait
until the buffer is cleared.

The MB-LS cannot receive any further information through
the serial port (usually from a PC or Braille note-taker).
Please restart your MB-LS.

You must delete some files from memory to free up some
space.

File name exists. Use a different filename.
Printer not connected or switched on or on-line.

The internal backup battery is low. Report this message to
your distributor and send the MB-LS in for service.

The normal life of the internal backup battery is 3-5 years.

Description

The MB-LS cannot find the margin. Possible paper jam or
other obstruction. Switch off and then on again.

Head has jammed momentarily or user has interfered with
its movement. Switch off and then on again. If the
message still occurs after this, you need to call your
distributor.

Incorrect bit rate, parity or number of bits. Check the
settings on your PC.

Operating system fault or failure in Main board circuits. Try
turning off and then on after a short wait.
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Temperature fault. Battery temperature has exceeded <00
Battery Temperature Error or >600C. Switch off for ten minutes. If the problem
persists, please contact your distributor.

Procedure to Reset the MB-LS

Sometimes you will need to reset the MB-LS to the factory defaults - your distributor will tell
you if this is needed.

There are two reset methods.
If you have files saved in memory:

Turn the MB off. Please disconnect all cables (You can leave the power supply on if
you want to)
Press New Line+ Command + dot 2 + Backspace
Turn the MB on
- Release the keys once the head starts moving.
This will reset all the commands to the Factory default.

If you have no files saved in memory (or if the first method does not work):

Turn the MB off
+ Press Space + Command + dot 5 + Enter key
Turn the MB on
- Release the keys once the head is moving.
This will reset all the commands and the memory to the Factory default.

What happens now?
The MB-LS should say: “Good day. Not charging. Learn Mode, Mimic not found”
The embossing head should also move.
When you do a hard reset, the command key is deactivated. You need to reactivate
it.

If you have to return your MB-LS for service:

Make sure you have already spoken with your distributor before sending the MB. Do not
send an MB-LS for service unless it is expected at the receiving end, as it could be lost in
transit.

Pack your MB-LS correctly according to the following instructions.

Packing the MB-LS for Shipping

You MUST pack the MB-LS in its original packaging to ship it anywhere. Your warranty does
not cover damage caused in transit by insufficient packaging, and there will be an extra
charge for supplying the correct packaging to return your MB-LS after repair.

What you need:
+  The MB-LS;
- The paper bail and shipping lock;
The bubble wrap and inner carton;
The cut foam and the outer carton.

If you are sending the MB-LS for service, ask your distributor whether you need to include
the following items:
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- The AC Mains Power adaptor;
The Power cord;

+ The USB or Serial Cable;
The Mimic.

Insert the shipping lock and paper bail
To prepare the MB-LS for travel, you must insert the shipping lock.
Turn the MB off, and disconnect any cables and the power supply. Lift the Paper Lever up

and move the right margin all the way to the right. With your fingers, gently move the block
under the Braille head to a position about one-third of the way across from the left.

Now take the sheet that says REMOVE THIS INSERT. Fit the legs of the card back of this
insert across the block you have just moved. Let the sheet of paper at the front fall naturally
across the keyboard.

Now replace the paper bail; fit the end without the spring into the hole in the right margin,
then push the spring back and fit the spring end into the hole in the left margin.

Replace the top cover by fitting the two front corners into the slots at either side of the front
embossed ruler. Now press the cover down gently until it clicks.

Packing the MB-LS:

Wrap the MB-LS in Bubble-wrap; put the MB-LS in the inner carton. Close and tape the inner
carton.

Putting the cut foam in place

The hollow square goes around the inner carton. The end-piece with the extra cut-out can be
used to house the Mimic if it is travelling also; the other end-piece goes on the other end. If
the Mimic is not travelling, use another piece of foam or bubble-wrap in the space, tightly
packed and taped in place, to make sure that the foam-packed inner carton fits snugly into
the outer box.

If you are packing extra items, place them in the box at the end with the foam cut-out that
has no extra space. Cables can be stowed down the sides, between the inner and outer
cartons. When everything is snugly packed, close and tape the outer carton.

If you are sending your MB for service

Please make sure you include:

Your name and address and a contact phone number;
- Anote telling the service people about the fault, and
Your RMA number if you have been given one.

Battery Care

The MB-LS needs power! It uses a lot of power when embossing and has a specially
designed battery.

The battery will operate the MB-LS for up to 8-hours, or a day in class. After this it must be
recharged!

If possible connect the power adapter provided, at all times. Otherwise, use the power
adapter overnight to recharge the batteries.

It is important to remember the following battery care tips:
Each time you switch the MB-LS on, it will tell you the battery status. It will tell you to charge
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the battery if it is low.

- Itis a good idea to charge the battery overnight.
If the battery is not re-charged when completely run down, permanent damage can
result. Replacing a battery is expensive and often inconvenient.
It is a good idea to leave the MB-LS plugged in wherever possible to ensure the
battery is kept charged.

+ You need to charge your battery for at least 24 hours prior to storing it over period of
up to 6 weeks.

- To maintain battery charge when the MB-LS is disconnected for longer periods, call
your supplier and have them disconnect the battery or tell you how to do this.

« You can check the battery status by pressing: newline+space+b. The MB-LS will
tell you either "Battery OK" or "Battery Low". If the battery is low, you must plug it
into the power as soon as possible.

IMPORTANT: The battery is not covered by the warranty. Please take good care of it!
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Resources for Users, Parents and Teachers

Graham Cook of SET-BC in Vancouver has written some wonderful support documents and
curriculum materials for the MB-LS. These are available online at

http://www.setbc.org/setbc/vision/mbpro/default.html.

Posture and Seating
Brailling posture and body alignment are very important.

* The student's feet should be touching the ground or resting on a custom made foot
stool.

* Their back needs to be supported by the chair.

* The table surface needs to be at a comfortable height for brailling. It is helpful if the
young student has a specially designed Braille desk with adjustable legs so that it can
grow with the student.

 Where possible have an occupational therapist assess the learning environment.
They will often point out things that we might overlook.

Other Resources

Online at www .mountbattenbrailler.com you will find many resources for teachers and
parents including tutorials, resources for using the MB-LS in Braille lessons and much more.

Updates to this User Guide

The most current version of this User Guide can be found online at

www.mountbattenbrailler.com/userguides
From time to time we will use the online guide to issue a new print revision; there will be a
notification on the website of the most recent print version available. If you would like to
obtain a print copy of the latest version, please contact your distributor.
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MB-LS Commands

Keyboard layout
backtab teb

From the top left of the keyboard, clockwise,

edges first: command

tab - top left, small round smooth key.

backtab -top right, small round smooth key. @@@ &) @@@
enter - right, oval ridged key below backtab.

space - bottom centre, right side, long key.

newline - bottom centre, left side, long key. newl:Lne space
backspace - left, oval ridged key below tab backspace enter
command - small round key in the centre lllustration 26: The MB-LS keyboard, labelled

between dot 1 and dot 4 of the braille keys.
The 6 braille dot keys have the Perkins layout: dot 3 2 1, 4 5 6 from the left. Braille
keys are on either side of command, and are oval with smooth centres and ridged edges.

Turn Commands On and Off

newline + space + tab + backtab - usedto

® ®
activate and deactivate the command key. D DOO O OOO O
N

Press all 4 keys together to turn command on.

Press all 4 keys together again to turn command off. llustration 27 Command activation
keystroke
Regular commands

All regular commands begin with the Command key and finish with the Enter key. Follow this
sequence to use any regular command.

1. Press command key.

2. Type the command.

3. Press enter.
If there is a space indicated in the command, press space when entering the command. If
there is a + in the command, it means that the keys must be pressed and released together.

Where numbers are needed in a command, they can be entered either as the number sign
plus character or as a ‘dropped’ or ‘lower’ character. See the section Braille Grades for more
information on using dropped or lower numbers.

If there is a part of the command enclosed in square brackets, [ 1, replace the square
brackets and their content by the proper parameter.

Chorded commands

Chorded commands use space pressed with the designated letter. For users with small
hands, they can be easier than some of the main keyboard combinations, particularly Page
Eject.

There are only a few chorded commands. They can be used at any time after the command
key has been activated.

b-chord Backtab f-chord Line feed
c-chord Carriage return h-chord Help
e-chord End i-chord Indent
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o-chord enter Options Menu t-chord Tab

(Advanced Mode only) z-chord Stops the speech (while
p-chord Page eject speaking).

r-chord Reverse Line

Changing between Learn Mode and Advanced Mode

The factory default setting is Learn Mode. Enter the command adv to change between Learn
and Advanced Mode. The MB-LS will respond by speaking the name of the Mode you have

just activated.
Speech Control

Speech control has little or no effect in Learn Mode, where the speech available is recorded
speech only. The following commands are used in Advanced Mode.

Recorded Speech

spk r Selects recorded speech.

spk a Speaks all keyboard keys, functions and commands.
spk c Speaks errors and prompts only (no braille dot keys).
spk d Speaks only braille dot keys (no function keys).

Synthesised Speech

spk s Turns on synthesised speech in Advanced Mode.
No Speech
spk n No speech - tones only.

Speech Menu
These commands are only available in Advanced Mode.

newline + space + s - Speech Menu

space + e - Exit Speech Menu.
From within the Speech Menu, the following keys alter the speech as indicated. The first time
you press each character, the current setting is announced. If you press the same character
again, you will scroll through the options available. The last spoken setting then becomes the
current setting.
Pitch, Volume and Rate

dot 6 - Raise tone. It will say ‘higher’ at the new pitch.

dot 5 - Faster speech. It will say ‘faster’ at the new rate.

dot 4 - Increase volume. It will say ‘louder’ at the new volume.

dot 3 - Lower tone. It will say ‘lower’ at the new pitch.

dot 2 - Slower speech. It will say ‘slower’ at the new rate.

dot 1 - Decrease volume. It will say ‘softer’ at the new volume.

Speaking Mode
1 - letter speech mode. Options available are:

ASCII (grade 0). Computer braille notation.
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Dot format - letters spoken, non - letters spoken as dots.
Translated format (default setting).
p - Punctuation. The 3 modes are Most, Some and None.
n - Number Format: digits or complete numbers.
k - Speak capital letters (toggle).
c - Speak commands as you type them - on or off.
Keyboard Echo
Press the letter e to cycle through the 4 options:

Letters  Each letter is echoed as it is typed

Word The last word entered is spoken when space or newline is pressed

Both speaks letters as they are typed and words when space or newline is
pressed

No No speech. This can be overriden by the punctuation settings - if you

really want no speech, turn speech off altogether with spk n

International Characters

f Toggles between international characters being spoken or not.
Speak Spaces
s Toggles between spaces being spoken as ‘space’ or ignored.

Nemeth Mode
o-chord n  Sets synthesised speech to speak all Nemeth operators and low numbers
as Nemeth Math Braille. Requires Advanced Mode. Exit with z-chord.

Handy Things to Know
Adjusting Dot Height for Different Types of Paper

This function is used to match the impact force on the dots to the type of paper used. For
heavy braille paper, the impact force can be increased. For lighter paper, the impact force
can be decreased. The factory default setting is for regular photocopy paper: 80gsm weight.

command + backtab Increase impact (speech prompt ‘Up’).
command + tab Decrease impact (speech prompt ‘Down’).

Writing Braille on Cards or Small Paper

No Paper Operation

For use with small paper sizes (like a birthday card). Press space and newline together
during a margin search.

Using Heavy Card or Labels

You can choose from single strikes (default) up to 4 strikes on each dot.

ms [n] Multi - strike feature (sets strikes per dot to n). n is a whole number from 1
to 4 (default is 1). Useful for brailling on heavy materials such as plastic
labels.
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One-Handed Mode

ku

Toggles Unimanual Mode on and off (default off). When one-handed
mode is on, press Space after each character.

Note: To turn one-handed mode off, remember to press k space u space.

Alternatives to Chorded Commands for One-handed Mode

These alternatives are regular commands using command to begin and enter to finish.
bt Backtab

cr New line

end Close an open file

in Indent
1f Linefeed

np New page

rl Reverse linefeed

tb Tab

Braille Writing

Braille Formatting Commands

The following formatting commands apply in both Learning and Advanced modes.

Position of Braille on the Paper

ce

ra

Margins
1lm
lmh
1lm [n]
rm
rmh
rm [n]
tm [n]
bm [n]
Tab Settings
tsh
tc
Line Spacing
ls [n.m]

Centre text. Embossing starts after the New Line key is pressed. Default =
off (toggle).

Right adjust braille. The braille will be printed from the right hand margin.
Default = off (toggle).

Set left hand margin to 0, the left - most position.

Set left margin to embossing head position.

Set left margin to column ‘n’.

Set right margin to 0, the right - most position.

Set right margin to embossing head position.

Set right margin to column ‘n’.

Set braille page top margin (n = number of lines).

Set bottom margin of braille page (n = number of lines for bottom margin).

Set tab at the position of the embossing head.
Clear all tab settings.

Line spacing. Default = 1. If you want line spacing of 1.5 lines, the
command would be Is 1.5. Only use the decimal point if necessary.
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Braille Writing Commands

The following formatting commands apply in both Learn and Advanced Mode.

cor
em

man

np

pn [n]
pbell [n]
rmbell

show

Correction Mode. Default = on (toggle).

Turn embossing off and on. Default = on (toggle).

Choose between Manual new line and Auto new line. Default = Auto
(toggle).

Force a new (braille) page. Page eject.

Begin page numbering starting at value of n.

set page bottom warning bell to ring n lines before the end of the page.
Right margin bell. The bell rings 5 positions from the right margin. Default
= on (toggle).

Emboss commands as they are entered (can be helpful for tracking
mistakes). Default = off (toggle).

Word Wrap. When Word Wrap is on, the word is not embossed until the
Space Key is pressed. Default = off (toggle).

Braille Files in Memory

The following

formatting commands apply in both Learn and Advanced mode. In the

following commands, 'filename' means any name up to 16 characters long.

Start a File

begin [filename] Opens a new file, called ‘filename’.

Close a File
end

Close an open file. Alternatively, simply turn the MB off and the open file
will be saved.

Find Out Which Files You have Stored in Memory

dir

free

Embosses all file names and their sizes.
Embosses the remaining free memory space.

Change the File
append [filename] Append more information to ‘filename’.
rename [filenamel filename2] Rename ‘filename1’ to ‘filename?2'.

Delete Files

del [filename] Delete the file named ‘filename’.

del all
undel

Delete all files.
Retrieve deleted file - only works if used before turning MB-LS off.

Emboss files that are stored in Memory
emb [filename] Printthe file named ‘filename’ (uses current settings).

memb [n]

[filename] Print n number of copies of the file named ‘filename’.

Extra Commands

ver

hp

Embosses braille software version.
Help. Prints command summary.
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save Saves all current settings. Use to save your preferred settings (will then
become the default).
std Restore back to factory default settings.
alt [n] Enables your MB to accept ASCII characters above 128 (n can be any
proper ASCII value). This is only useful in the Editor function.
Getting Help

hp emboss or speak a complete summary of the Help groups outlined below.
hp [group] emboss or speak the help for any of the groups outlined below.

General Help groups

hp
hp
hp
hp
hp
hp
hp
hp
hp
hp
hp
hp
hp
hp
hp
hp
hp
hp
hp
hp
hp
hp
hp
hp
hp
hp
hp

bc  gives a summary of the Braille code commands

cal gives a summary of the Calculator commands

chat gives a summary of the Chat Mode commands

dfln gives a summary of default language selection commands

em  gives a summary of embossing output commands

emb gives a summary of commands for embossing from the memory

eta gives a summary of commands for adding Braille exception rules

fb  gives a summary of forward translation commands

grx gives a summary of Braille grade setting commands

ke  gives a summary of the Mountbatten keyboard setting commands

ku  gives a summary of the Unimanual (one-handed) mode commands

Im  gives a summary of the Left Margin commands

pp  gives a summary of the Parallel output commands

pr  gives a summary of the commands for printing (ink-print) from memory
ptrn gives a summary of the Braille Patterns commands

report gives a summary of command parameters for the report command

restore  gives a summary of command parameters for the restore command

rm
sl
s2
save
spk
std
tc
tm
tsh
usb

gives a summary of the Right Margin commands

gives a summary of the first serial port output commands

gives a summary of the second serial port output commands

gives a summary of the command parameters for the save command
gives a summary of the speech status commands

gives a summary of the command parameters for the std command
gives a summary of the command for clearing tabs

gives a summary of the Top Margin commands

gives a summary of the tab setting commands

gives a summary of the USB output commands

Back Translation groups

hp bck gives a summary of the back translation output port commands
hp bln gives a summary of back translation language selection commands
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hp bfc gives a summary of international character selection commands
btp gives a summary of printer selection commands
bpn gives a summary of the page number selection commands

Forward Translation groups

hp £ln gives a summary of the forward translation language selection commands
hp f£fc gives a summary of the international character selection commands
hp fwd gives a summary of the forward translation port selection commands

Braille Graphics

gf Graphics mode. The space between the dots and lines is reduced. Default
= off (toggle).

Braille Exception Table

Your MB has the flexibility to enable you to make exceptions to the standard braille rules you
are using, to use the shortcuts or abbreviations of your own choice, or to introduce groups of
contractions.

Braille Exception Table Commands

The following commands apply in both Learn and Advanced mode. Up to 128 entries are
allowed. The Braille Exception table is active in both forward and back translation. The
commands for creating exceptions to the braille rules are as follows.

eta [text braille position] Adds an entry to the exception table. text = the
text to be changed, braille = the braille which will be substituted, position =
one or a combination of the five position indicators given below:

allowed anywhere

allowed only at the beginning of a word

allowed only at the end of a word

allowed only in the middle of a word

allowed only by itself (except adjacent to spaces and/or

punctuation).

etc Clears the exception table.

etd [text] Deletes an entry from the exception table, where text is the text part of the
entry.

etu Turns the exception table off or on. Default = on (toggle).

n 8 0 o o

Braille Exception Table - Patterns Series
The following commands apply in both Learn and Advanced mode.

ptrn n on  activates one (and only one) of the patterns series groups (n is a number
from 1 to 15).
ptrn x y z on activates several of the patterns series groups, where x, y and z are
the numbers of the groups activated.
When one or more of the patterns series is invoked, the MB will automatically revert to
Grade 1, and change to synthesised speech. Up to 15 groups can be activated
simultaneously.
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The Patterns groups are:

1.

Alphabet and letter words, multi-cell contractions, upper cell contractions.

Whole or part words.
Simulated letter words.

Part word signs.

Simulated letter words.
Whole words.

Middle part word signs.
Beginning part word signs.
Dot 5 whole and part words.
Dot 4,5,6 words.

Dot 4,5 words.

12. Dot 4,6 final letter contractions, lower cell contractions.
13. Dot 5,6 final letter contractions.
14. Dot 6 final letter contractions.
15. Short form words.

Grade 2 Braille Ordered for Reading and Writing Instruction

Alphabet and Letter Words Patterns 3

(Phonics - consonant and

short vowel sounds)
Patterns 1

a

but
can

do
every
from
go
have

I

just
knowledge
like
more
not

O
people
quite
rather
o]

that

us
very
will

it

you

as

NS Xs<c™ 0w -T0O0TOS3 -~ xT7TJ5Q™T0DQa0OOT®

Upper Cell Contractions

Patterns 2

Whole and Part Words
and

for

of

the

with

Simulated Letter Words

ch child

sh shall

th this

wh which

st still

ou out

(Phonics - Vowel Sounds)
Patterns 4

Part Word Signs

ar

ing

ed

er

ow

gh

ble

Lower Cell Contractions
Patterns 5

Simulated Letter Words
en enough

in in

Patterns 6

Whole Words

his

was

were

be

to

into

by

(Phonics - multi-syllabic
words)

Patterns 7

Middle Part Word Signs
bb

cc

dd
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ea

ff

e[¢]

Patterns 8

Beginning Part Word Signs
be

con

dis

com

(PHONICS - Grade 1 and Grade 2
spelling)

Multi-cell Contractions
Patterns 9

Dot 5 Whole & Part Words
day

ever

father

here

know

lord

mother

name

one

part

question

right

some

time

under

work

young

character

ought

there

through

where

Patterns 10

Dot 4.5.6. Words
cannot

had




many across him

spirit after himself
their afternoon immediate
world afterward its
Patterns 11 again itself

Dot 4,5 Words against letter
these almost little

those already much
upon also must
whose although myself
word altogether necessary
Patterns 12 always neither
Dot 4-6 Final Letter Contractions because o’clock
ance before oneself
less behind ourselves
ound below paid

ount beneath perceive
sion beside perceiving
Patterns 13 between perhaps
Dot 5-6 Final Letter Contractions beyond quick
ence blind receive
ful Braille receiving
ity children rejoice
ment conceive rejoicing
ness conceiving said

ong could should such
tion deceive themselves
Patterns 14 deceiving thyself
Dot 6 Final Letter Contractions declare today

ally declaring together
ation either tomorrow
Patterns 15 first tonight
Short Form Words friend would
about good your
above great yourself
according herself yourselves

Using the PC Keyboard

Connect the PC keyboard before switching the MB on. The keyboard lights should flash on
switch-on.

PC Keyboard to MB Keyboard keystroke correspondence:

Esc = command

End = enter

F1 = tab (or other macro assigned to the Left Function Key)

F2 = backtab (or other macro assigned to the Right Function Key)
F3 = tab and backtab together (for using macro assigned to this keypress)
Enter = newline

Down Arrow = space and newline together

Up Arrow = space and backspace together

Left Arrow = backspace

Right Arrow = space

Space = space

Backspace = backspace and space together
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Braille from the PC Keyboard
Typing at the PC keyboard with no translation activated will produce Grade 0 (ASCII) braille.

Forward Translation
fe Turn on Forward Translation.

The MB-LS stores the text you are writing in an eighty character buffer, (to make sure all
contractions and Braille rules are followed correctly). At any time you can empty the buffer by
pressing the Enter key twice. If you keep typing the buffer will empty automatically every
eighty characters.

See the section on Forward Translation for full information about Forward Translation
commands.

Basic Forward Translation

After Forward Translation has been turned on using fe a mode called Basic Forward
Translation becomes available.

fb Each word is embossed after the space key is pressed. Automatically
switches to uncontracted Braille (Grade 1). Default = off (toggle).

If Forward Basic is on, the MB-LS will ignore "hyphens” and many other Forward translation
commands and settings, including formatting commands and the Patterns Commands

Braille Embossing

Using Your MB-LS as an Embosser
The MB-LS can be used as a regular Braille embosser for note-takers and PCs.

It can use single sheet or continuous sheet paper. Continuous embossing is most reliable if
you use a lightweight 80 gram continuous paper - regular printer paper.

The MB-LS must be in Advanced Mode in order to use the USB or serial ports for connecting
to the PC.

Using Continuous Paper

cp Continuous paper feed. Default = off (toggle).
cpa [+n]
or
cpa [-n] Add or subtract increment n to form length when using continuous paper.
Paper Size
fl [n.m] Form Length. Sets physical length of page in inches or centimetres. If the
length is a whole number do not add the decimal point.
Page Numbering
pn [n] Begin page numbering, starting at value of n.
Control of Braille Output
el n Allow only ‘n’ blank lines while embossing. Any lines greater than ‘n’ will
be discarded (avoids having large blank areas on the braille page).
cap Caps lock. Default = off (toggle).

The MB-LS has only one port which has been designed to use with the Mimic. If you want to
use it as a port to connect to a PC or a note-taker, you must first turn the Mimic function off,
using the mimic command (see the Mimic section in the User Guide).
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Braille Translation

The following commands apply in Advanced Mode only.

Forward Translation

Turn Forward Translation On and Off
fe Forward translate and emboss (toggle).
fm [filename] Forward translate and send to 'filename' in memory (turns
embosser off).

fm append Forward translate and append to previously stored file with the name
‘filename’.

fm end Closes file, turns forward translation off and embossing back on.

Change Braille Grade or Code
fgr [grade] Select the Translation Grade; grade can be 1 or 2. Default = 2.

Change the Translation Rules

fln [language] Change the translation rules language where language is one of those
in the table below.

ffc [language] International character selection. Enables insertion of an international
character into your text without changing the translation rules, where
language can be one of those in the table below.

dfln [language] change the default translation language to one of those from the
table below.

Which languages you can change between will depend on the language set installed on your
MB-LS. If you aren't sure which language set applies, contact your distributor.

Language codes:

A B Cc D
Spanish spa Russian rus Portuguese por Swedish swe
Italian itl Polish pol Greek grk Norwegian nor
French fr Lithuanian 1it English oz Finnish fin

English oz German ger English uk English oz
English uk English oz English usa English uk

English usa English uk Brazilian  bra English usa
Portuguese
English usa Dutch dut
Czech czc
E F G T
Thai tha Turkish tuk English oz English oz
Taiwanese twn English oz English uk English uk
Mandarin  chi English uk English usa English usa
Chinese
Korean kor English usa Belgian dut Argentinian spa
Dutch Spanish
English oz Arabic arb

English uk
English usa
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Formatting Your Braille

flit Literal Mode. Used for making columns and tables in braille. Default = off
(toggle).
flit [n] Creates a Hanging Indent. The variable n gives the number of indented

spaces and can be 0, 1, 2, 3, 4, 5. Can be turned off using £1it 0 or by
using £1it s. Only works when £1it is active. Default = off.

flit s Suppresses blank lines as well as adding a 2 cell indent for paragraphs.
Only works when £1it is active. Default = off (toggle).

el [n] Allows n blank lines between paragraphs. Only works when £1lit is
active.

fit Italics. When on, causes the subsequent text to be italicised in braille.
Default = off (toggle).

fhyp Hyphens. When on, will break braille words at the end of a line. Default =
off (toggle).

fin Automatic indent. When turned on, the current braille column is stored
and subsequent braille lines are indented to that column. Default = off
(toggle).

fm Multiple space removal. Replaces all multiple spaces and tabs in the text
with single spaces in the braille. Default = on (toggle).

np New Page. Forces a new braille page.

fpa Forces a new braille paragraph. Used for flagging a new paragraph that is

coincident with the top of a text page.

Fraction Mode

ffr Fraction mode. Causes fractions to be translated to braille using lower
numeral sign for the denominator. A mathematical separation sign is used
after the braille fraction if it is followed by punctuation. Default = off

(toggle).
Upper Case
fcl Upper case. Used when translating capitalised or upper case text. When
on, prevents double capital sign before words all in upper case. Default =
off (toggle).

Lists and Tables

flist Allows creation of simple lists or tables. Will produce a table of 3 columns,
with 40%, 40% and 20% width.

If your braille page is 40 cells wide, then the default will give 3 columns, of percentages from
the left of the page of 16, 16 and 8. Default = off (toggle).

flist [nl n2] Allows you to specify your own column widths, as a percentage of the
line length.

If the values of n1 and n2 add up to exactly 100% of the page width, you will get 2 columns
with widths of n1 and n2 from the left. If they add up to less than 100%, then you will get 3
columns, with the third column being the remainder. A third column cannot be greater than
90% or less than 10%. flist 3 7 is ok: 3 columns, 3%, 7%, 90%). flist 50 50 is ok: 2 equal
columns. flist 33 33 is ok: gives 3 equal columns. flist 5 4 gives an error: n1 + n2 is less than
10%. flist 50 45 gives an error: n1 + n2 is greater than 90%.
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Saving Your Preferred Settings

save ft Saves all current Forward Translation settings, including braille grade,
language and output settings.
std ft Restores all default Forward Translation settings. Does not interfere with

stored settings.
restore ft Restores all stored Forward Translation settings.

Back Translation

Turning Back Translation On

busb - Back translate to USB Port (toggle). This allows back translated text to be sent to
the PC via MB-Comm.

bp - Back translate to Parallel Port (toggle). Use this command when you have a regular
printer connected to the parallel/printer port.

bs1 - Back translate to the S1 serial port (toggle).
bs2 - Back translate to the S2 serial port (toggle).

Changing the Braille Grade or Code Used

bgr [grade] - Translation grade. Can be 1 or 2 (default 2).

bfc [language] - International character selection, where [language[ can be one of
the following codes as laid out in the previous section on Forward
Translation.

Formatting Your Print Page

bin - Automatic Indent. Causes all subsequent lines to indent to the current cursor
position. Default = off (toggle).

bece - Centring. When on, causes text to be centred between left and right margins.
Default off (toggle).

blit - Literal Mode. When on, each new line in braille will produce a new line in print.
When off, a new line in braille is ignored in the print copy (to avoid the
print being broken). Default = off (toggle).

bsh - Remove hard spaces. Causes multiple spaces and tabs in your braille to be
converted to single spaces and tabs in the print. Default = off (toggle).

Margins, Line Length, Paper Size

blm [n] - Sets width of left margin to n blank spaces from the left hand edge of the
paper. Maximum value of n is 30. Default = 8.

brm [n] - Sets width of right margin to n blank spaces from the right hand edge of the
paper. Maximum value of n is 30. Default = 8.

btm [n] - Sets a margin of n blank lines at the top of the page before printing begins.
The top margin cannot exceed the form length less the page length.
Default = 3.

bll [n] - Sets the width of the print line, including margins, to n characters, at 10
characters per inch. Maximum value of n is 132. Default = 80.

bfl [n] - Form Length. Sets the length of the page in n lines, at 6 lines to the vertical
inch. The maximum value of n is 100. Default = 66.
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bpl [n] - Page Length. Sets the number of printed lines on the page to n lines. The
page length cannot exceed the form length. Default = 60.
Other commands

bel - Upper Case Lock. Locks output text into upper case when on and returns to normal
echo of keystrokes when off. Default = off (toggle).

bfr - Fraction Mode. Causes braille fractions to be translated to text fractions using the

slash character to separate numerator and denominator. Requires use of
mathematical braille separation sign (dot 6) between the fraction and any
subsequent punctuation. Default = off (toggle).

Tabulation
Tab Stop positions in Back Translation relate to the printed output.

Default settings are 9, 17, 25, 33, 41, 49, 57, 65, 73 and 81.

btbc - Clears all current tab stops.
btba [n] - Sets an extra tab stop at position n.

Line Spacing and Alignment
11s [n] - Sets the printer line spacing to n, which can be from 1 to 10. Default = 1.
bpj - Page Justification. When on, caused printed text to align with both margins which
might cause extra spaces to be inserted into text. Default = off (toggle).
bra - Right Alignment. When on, causes printed text to align to the right margin. When
off, text aligns to the left margin. Default = off (toggle).
Page Numbering

bpn [n] [p] - Turns page numbering on or off at the desired position p with a value of
n. Maximum value of ‘n’is 1000, and accepted position codes are:

tl - top left be - bottom centre

tc - top centre br - bottom right

tr - top right of £ - Turn off page numbering
bl - bottom left on - Turn on page numbering

bpnt [braille] - Creates a text string to be printed with the page number, where
[braille] is the text to be printed.

Note: To position text and turn numbering on and off, use the bpn command as given above.
Maximum length of text is 15 characters, no punctuation allowed.

The Editor

edit [filename] where 'filename' is the name of the file you have stored in memory
(or the name of the new file if you are starting a new one).

newline + g - Exit the editor.

newline + h - Help Menu. Default off (toggle). The MB-LS will say “Entering help

mode”. Press the left function key to scroll through the options. Press the
right function key to scroll back through the menu options.
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Moving Around Within A File
space + dot 3 - Move to previous character

and speak it.
space + dot 2 - Move to previous word and

8950 008 |
O ' O 0 space + dot 1 - Move to previous line and

Moving to the left:
space plus the key for the distance yvou want to move

speak it.
space + dot 6 - Move to next character and
speakK it.
Hllustration 28: Moving left in the Editor space + dot 5- Move to next word and speak
it.
space + dot 4 - Move to next line and speak e ———
|t space plus the key for the distance you want to move

space + dots 13 - Move cursor to top or
previous page. D DOO O ‘@‘ O

space + dot 46 - Move cursor to top of next
page.
space + dots 456 - Move cursor to end of

file.
space + dots 123 - Move cursor to start of file.

lllustration 29: Moving right in the Editor

Speak current: space plus both directions

current character space + dots 36 - Speak current character.
@O 0@@ Press twice for phonetic or dot equivalent.
D O O O space + dots 25 - Speak current word.

space + dots 14 - Speak current line.

lllustration 30: Speaking text in the Editor

Chorded Commands

space t-Tab. newline w-Where am I?
space p - Hard page break. space r - Speak rest of file.
newline i - Insert/overwrite. space z - Silence command.

newline c - changes the case of text.

Other Keyboard Commands

newline - New line key. Treated as a hard carriage return.

backspace - Backspace key. Same as the Read Last Character command (space +
dot 3), except when you are entering text in response to a prompt, e.g.
when asked for a filename, in which case it will act as a destructive
backspace.

command - Command key. Will cancel any operation currently in progress.

enter - Enter key. Has no function when using the editor.

space + backspace - substitutes a space for the character to the left of the cursor
(deletion as for braille on paper).

backspace + character - corrects the character to the left of the cursor to the new
character (correction as for braille on paper).
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File menu
Enables file operations such as reading, saving, reformatting, copy and paste.

newline + f£ - Enter the File Menu.
The File Menu has the following options.
d - Give directory listing. Places cursor at top of file listing; supplementary commands
available:
a - Speak the previous filename in the file listing.
c - Speak the current filename in the file listing.
dot 4 - Speak the next filename in the file listing.

o - Open a file and move it to the editor. d - Delete the file at the current file cursor

r - Rename the file. position.

c - Clear the editor work space. £ - Give remaining space in the editor buffer.
o - Open a file, at the current file cursor p - Protect or unprotect the file (toggle).
position, into the editor. £ - Reformat the file.

s - Save the current editor file.
space + e - Exitthe menu.

Edit menu
newline + e - Enter the Edit Menu. Options are:
s - Size of current file. d - Delete hard page breaks in file.
r - Remaining work space. g - Go to a selected page number.
w - Where am 1? Page, line, cursor. c - Enter MB-LS command.
£ - Form new paragraphs. t - Take away MB-LS command
j - Join current and next paragraph. space + e - Exit the menu.
Block menu

newline + b - Enter the block menu. Options are:

b - Begin block marker. p - Paste block.

e - End block marker. s - Speak block. Speak contents of block.
c - Copy block to cursor position. d - Delete block.

m - Move block to cursor position. space + e - Exitthe menu.

Delete menu

newline + d - Enter the Delete Menu. Options are:

c - Delete current character. dots 256 - Delete to end of word.
w - Delete current word. d - delete to end of line

1 - Delete current line. r - Restore last deletion.

p - Delete current page. space + e - Exitthe menu.

dot 2 - Delete previous character.

Search menu

newline + s - Enterthe Search Menu. Options are:

d - Direction of search. Each press of d moves to the next option, last spoken is active.

c - Case sensitivity of search. Each press of ¢ moves to next option, last spoken is active.
w - Word match. Each press of w moves to the next option. Last spoken is active.

s - Search for text.
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r - Search and replace text.
1 - Restart last search.

Entering Search and Replace Strings

After selecting options you are asked to enter the search string. You may use any
alphanumeric or space character. If the search string begins or ends with newline, the MB-
LS will search for a word at the beginning or end of a line. If you have selected r upon
entering Search, you will also be asked for the replace stringSearch and replace strings are
terminated by space + e.

The Search Sub-menu

If your search string is found in the file and this is a search only, the following options are
available:

w - Speak word that contains search string. command - Stop search, return to menu.
1 - Speak line that contains search string. space + e - Stop search, return to editor.
n - Ignore this one and find next.

The Search and Replace Sub - menu

If the search string is found and this is search and replace, the following options are
available:

w - Speak word that contains search string. a - Replace all occurrences.

1 - Speak line that contains search string. command - Stop search, return to menu.

n - Ignore this one and find next. space + e - Stop search, return to editor.
r - Replace this occurrence.

A search can be abandoned at any time by pressing command.

The NATO Phonetic Alphabet

This alphabet is more formally called the International Radio Telephony Spelling Alphabet.
A Alpha
Bravo
Charlie
Delta
Echo
Foxtrot
Golf
Hotel
India
Juliet
Kilo
Lima
Mike
November
Oscar
Papa
Quebec

O v oZZIrN X« " IOGmTMMOO®
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Romeo

Sierra

Tango

Uniform

Victor

Whiskey

X-ray

Yankee

Zulu

For more information on this spelling alphabet and its history, go to:

N<Xs<c-Homx

http://en.wikipedia.org/wiki/NATO phonetic_alphabet

The Braille Blackboard

With the MB-LS you can create a ‘Braille blackboard’ or MB-LS network. A teacher can write
information on either a computer or a MB-LS and have the information distributed to a group
of students at the same time.

Instructions for setting up this application are contained within the following diagram.

The commands that need to be entered on each MB-LS are listed underneath the MB-LS
boxes in the diagram. These are regular commands using the Command key to start them
and the Enter Key to finish them. Spaces indicated in print need to be also entered into the
command.

General setup

1- Connect all the cables. Ports are denoted as S1 and S2

2- Ensure that all connected MB's are in advanced mode

3- Enter the command NW ON on each machine. This stops them from going to sleep.

Creating a 'Braille Blackboard' using a PC with MBCOMM

PC &
MBCOMM |« > <> — — — —>
USB port  USB port| MB1 S2  S1 |MB2 S2 S1|MBn
S1TNS1ON S1T NS1ON S1TNS1ON
S2TC S10N S2TC S10ON
EMT NS2 ON EMTNS2ON

Creating a 'Braille Blackboard' using a series of MB's

<—> - — — —>
MB1 S2  S1 |[MB2 S2 S$1|MBn
S2 T NS2 ON S1T NS1ON S1TNS1ON
S2TC S1ON
EMTNS2ON

lllustration 31: The Braille Blackboard or Mountbatten Network
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Changing the Keyboard Layout
The following formatting commands apply in both Learn and Advanced Mode.

kbc bnse Re-defines control key functions. b, n, s, eisthe
order required of the 4 control keys (backspace,
newline, space, enter). For example if you wanted
to reverse the positions of the backspace and enter
keys, the command would be kbc ensb

kbd keyl key2 key3 key4 key5 key6

Re-define dot key layout. The default dot key layout is the
same as the Perkins layout.
After entering the command kbd, press the dot keys in the sequence you want them.
For example, to set the keyboard up to emulate the Stainsby Brailler layout, you would press
the Braille key on the far left for key1, making it dot 1; then you would press the middle
Braille key on the left, to make it dot 2; then you would press the key immediately to the left
of command, making it dot 3; then the key to the far right for dot 4, the middle right key for

dot 5 and the inner right key for dot 6.

Assigning Commands to the Function Keys

If you have a particular command or set of commands that you use frequently you can create
a macro or ‘hot key’ to store them on. This is done by changing the function of the tab and
backtab keys.

The following three commands enable the two function keys to be used as macro keys by
substituting the command of your choice.

kblf Re-defines the left function key. Follow kblf with the new command. If
you want to assign multiple commands to this key, press newline
between each command.

kbrf Re-defines the right function key. Follow kbrf with the new command. If
you want to assign multiple commands to this key, press newline
between each command.

kblrf Re-defines a third function for when the left and right keys are pressed
together. If you want to assign multiple commands to the double keypress,
press newline between each command.

Braille Graphics
Turn graphics mode on by using the command

gf Graphics mode.

In Graphics Mode the space between the dots is reduced, giving the appearance and feel of
lines instead of dots. There is much scope for creativity and learning about Braille graphics
really reinforces the Braille code for the Braille learner. Default = off. Toggle

To try these drawings, check the Braille Grades table in this section for the keys you need to
press. We have shown you how the Heart will look to get you started.

Heart

1.s,e,i,wh
2. gh, space twice, ar
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3. space once, €, i

Teddy Bear

1space once, ow, 0, two colons, ow, 0

2space once, S, oW, 0, ow, 0, wh,

3space once, gh, space once, e, |, space once, ar
4ow, s, space 4 times, wh, o

5in, gh, space 4 times, ar, en

6e, |, e, 2 colons, |, e, i

Sailboat
1space once, 4-5-6, ch
2space once, 4-5-6, space once, ch
3space once, 4-5-6, space twice, ch
4er, full cell, full cell, full cell, full cell, n

For anyone interested in making tactile graphics on their Braille writer, Marie Porter's
wonderful resource book called - So What About Drawing? Instructions for Drawing Using a
Braille Writer is available. Contact your distributor for details.

Braille Languages and Codes

How to change between languages.

In order to switch from the default Braille language to a different Braille language, the user
needs to enter the following set of commands.

f1n (or bln) language Change the Translation Rules where [language] can be one
of the following codes, depending on the Language Set installed:
A B C D
Spanish spa Russian rus Portuguese por  Swedish swe
Italian itl Polish pol Greek grk Norwegia nor
n
French fr  Lithuanian 1it English oz Finnish fin

English oz German ger English uk English oz
English uk English oz English usa | English uk

English usa English uk Brazilian @ bra English usa
Portuguese
English usa Dutch dut
Czech czc
E F G T
Thai tha Turkish tuk English oz English oz
Taiwanes  twn English oz English uk English uk
e
Mandarin  chi English uk English usa English usa
Chinese
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Korean kor English usa Belgian dut Argentinia spa
Dutch n Spanish

English oz Arabic arb

English uk

English usa

In order to change the default code to a new default code, use the command
dfln language
Change the default Translation Rules to the new language.

How to Insert International Characters into Your Text

There will be occasions where you need to use an international character but do not want to
change the default Braille language being used. For example, a student in the US is learning
Spanish and they want to use regular US Braille rules, but insert a Spanish character into the
text they are writing.

ffc (or bfc) language

International character selection. This enables insertion of international character
into your text, without changing the translation rules

Braille Grades

Braille Dots Grade 1 Grade 2 ?Xas%ﬁl?
word sign begin middle end

space space space
° 1 a a a
: 12 b but b
* 14 c can c
e 245 d do d
B 15 e every e
: 124 f from £
e 1245 g g0 g
o 125 h have h
. 2 4 i i i
o 245 j just j
. 13 k knowledge K
:: 123 ! like |
: 134 m more m
: 1345 n not n
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Braille

Dots

Grade 1

Grade 2

Grade 0

(ASCII)
word sign  begin middle end

. 135 0 0 o
:* 12314 P people P
Tt 12345 q quite q
e 1235 r rather r
s 2 34 s SO s
o 2345 t that t
. 136 u us u
:. 1236 v very v
ot 2456 w will w
B 1346 X it X
‘e 13456 y you y
s 1356 z as z
& 12346 and and &
33 123456 for for -
s 12356 of of (
o 2346 the the !
. 23456 with with )
* 16 child ch *
: 126 gh <
° 146 sh %
* 1456 this th ?
% 156 which wh

@ 1246 ed $
: 12456 er ]
s 1256 out ou \
: 246 ow [
5 3 ' -
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Grade 0

Braille Dots Grade 1 Grade 2 (ASCII)
word sign  begin middle end
: 34 still st /
> 345 are ar >
i3 3456 Numeral Numeral ble #
o 346 ing +
Iy 36 - com - - -
: 4 @
i I orefi :
: 456 B
16 grzlfii
: ° orefi "
'3 56 Letter p?r(()elfi?( ;
= 6 Capital Capital ;C):rcc)elfii ,
o 356 " was by " 0
. E , ea : 1
s 23 ; be be bb ; 2
o 25 ; con cc 3
° 256 : dis dd 4
¥ 2 6 enough en 5
. 2 35 ! to to ff ! 6
ss 2356 were ( ag ) 7
s 2 36 ? his " ? 8
o 35 in in 9

Check Battery Status

newline + dots 1,2 - Press all 4 keys together to hear battery status.
Check the Care and Troubleshooting Guide section for more information.
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Audio Tones

When your MB-LS is in Tones-Only Mode, following the command spk n, it replaces speech
while you type with tones. There are three tones:

Acknowledge a short high frequency beep

Bell a longer mid-frequency beep

Error a long, low frequency tone.

When the Tones will happen

You will hear two Acknowledge beeps when you press command, just like when a command
is sent through by MB-Comm. You will hear a single Bell tone when your command has been
correctly entered and is being activated, and a single Error tone if you have entered the
command wrongly or entered an invalid command.

You will hear an Error tone if you try to move left when you are at the Left Margin, either with
backspace or backtab.

You will hear a single Acknowledge beep when Page Eject is complete.
A single Bell beep indicates:

A command has been accepted correctly.
«  You have reached the margin zone when Brailling; you have 5 cells remaining.
The Paper Lever has been lowered, and the margin search begins in 2 seconds.
You will hear two Bell beeps when you lift the Paper Lever, and when you reach the last line
on the page.

You will hear a single Error tone when you would normally hear the word "Error" spoken, or
when you would normally hear another error message, such as:
- when there is no paper in the MB-LS and you try to type;

if you press keys while the paper grip lever is up;

if you press enter if there is no command to complete, or no margin to release.

if you press an invalid combination of keys;

there is a command error.
You won't hear any tones during switch-on; these messages are still given with speech.
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